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1 Introduction

This guide will help you configure and customize the components of DDM InventoryTM to your
own specifications.

Topics in this guide include:

e Accounts for access to the web interface (administration, reports device managers, etc.)
e How devices are added to and deleted from the DDM Inventory database

e Device and Port Properties

¢ Agent Communication and Configuration

¢ Scan File Configuration

e Scanner Generator for creating Scanners

e XML Enricher for adding data to scan files

e How to get your data into AssetCenter
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2 Setting up Accounts

All DDM Inventory system configurations can support up to 250 accounts (including at least
one Administrator account).

An Administrator can create and maintain all other user accounts. IT Employee and IT
Manager accounts can change their own account properties using the Administration > My
Account Administration menu.

) These user accounts are completely distinct from the MySQL Accounts. For more information
on those, see the Installation and Initial Setup Guide

About Accounts

There are six types of account:
¢ Demo

e IT Employee

e IT Manager

¢ Administrator

e Scanner

e Aggregator

By default, DDM Inventory has one of each type of account installed (except for Scanner and
Aggregator, which are both used for specific cases). If there are to be any other accounts, the
owner of an Administrator account must create them.

@ In DDM Inventory, all IT Manager and Administrator accounts have access to some powerful
features. If you have an IT Manager or Administrator account, be careful not to overwrite the
work of other IT Manager or Administrator accounts. In particular, it is recommended that
there be only one DDM Inventory Administrator.

Table 1 Default Accounts

Account type Account name Password
Demo demo password
IT Employee itemployee password
IT Manager itmanager password
Administrator admin password
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Table 2 Account Access to DDM Inventory

Demo IT Employee IT Manager Administrator

Network Map

Initial map configuration file Copy of Copy of Prime Copy of Prime Copy of Prime
Prime

Default map configuration file Copy of last saved or last saved or last saved or
Prime used used used

Open any saved map configuration o o o o

Save any number of map configurations o o o o

Save a map configuration as Prime — — o o

Change a device icon — — o o

Change a package icon o o o o

Change a device’s priority — — o o

Change a device’s title or tag — — o o

Purge a device — — o o

Disconnect other accounts’ map sessions | — — — o

Managers (for example, Device Manager)

View read and write community strings | — — o o

for device

View and use set link to MIB Browser — — o o

SNMP query default string “public” “public” from DDM from DDM

Inventory Inventory

Update Model — — o o

Configure connections — — o o

Break and force connections — — o o

Agent and Scan logs — — o o

14
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Table 2 Account Access to DDM Inventory

Demo IT Employee IT Manager Administrator
Express Teaching Tool
Teach unrecognized files — — o »
MIB Browser
Set SNMP variables — — o o

Read community string

view + edit

view + edit

view + edit

Write community string

view + edit

view + edit

Status

View read and write community strings

for network

%

Administration

Change own password

4

4

Configure own account

4

4

Configure other accounts

Manage own map configurations

Copy map configurations from other
accounts

Specify pager e-mail address

€ €] <

€ €] <

Configure event filters

Configure DDM Inventory server

Configure network operations

€1 €€ 4] €€ 9|49«

Setting up Accounts
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Demo Accounts

Initially, there is one Demo account. The name for this account is “demo” and the password is
“password” (account names must be lowercase and passwords are case-sensitive). Demo
account owners cannot change this password. An Administrator account owner can create
more Demo accounts if needed.

Demo accounts are designed for training and practice. Demo is the least powerful type of
account on DDM Inventory. The restrictions on this account make it impossible for the Demo
account owner to damage the network.

A Demo account can:

e View the Network Map, with the restriction that each map session will begin with a
configuration named “Copy of Prime.” The Prime configuration is maintained by an
Administrator or IT Manager account.

e Open any saved map configuration
e Save any number of map configurations

e View reports and server status

IT Employee Accounts

An IT Employee account can:
¢ Do everything a Demo account can do

e View the Network Map; with every map session after the first session automatically
loading their default configuration (which is normally the configuration used most
recently)

e Manage their own configurations (delete, duplicate, and rename them, and set a default
configuration without opening the Network Map)

¢ Change their own password and account profile

IT Manager Accounts

The owner of an I'T Manager account has the power to make changes that affect what other
people see in DDM Inventory.

With respect to the Administration menu, an IT Manager account has capabilities similar to
an IT Employee account. With respect to the Network Map an IT Manager account is similar
to an Administrator account.

An IT Manager account can:

e Do everything an IT Employee account can do

e Set server system variables such as system name, system contact, system location
e Save a copy of the Network Map as Prime

e Change device properties (title, tag, priority, and icon of a device)

e Change port properties

e See a device’s read and write community strings (if known) in the Device Manager
Configuration panel
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e Purge a device or port
e Update the model for a device

¢ Change how DDM Inventory sees connections between objects, and break existing
connections and create custom connections

¢ Perform express teaching of unrecognized files

e Set SNMP variables in the MIB Browser

Administrator Accounts

There should be one Administrator account owner designated as the DDM Inventory
Administrator, whose account cannot be deleted. The default Administrator account name is
“admin” and the default password is “password”. This is the most powerful type of account.
Administrator accounts can access all components of the DDM Inventory server.

An Administrator account can:

e Do everything that IT Manager accounts can do

e Perform initial configuration of the DDM Inventory server

e  Configure the DDM Inventory server operations on the network
¢ Administer the IT Manager, IT Employee and Demo accounts

The default Administrator account must set up the initial DDM Inventory server parameters
and create the other accounts (see the Installation and Initial Setup Guide).

0 If you forget the Administrator password, you will not be able to access the Administrator
account without intervention from Customer Support.

Scanner Accounts

The Scanner account is used only for the purpose of allowing scanners to save scan files on to
the server. This can be used in cases where automatic scan deployment is not used.

) The Scanner account type does not have access privileges to the web and applet components
of the DDM Inventory GUI.

Aggregator Accounts

The Aggregator account is used only to send data to an Aggregator server. Typically, an
Aggregator server holds the data for multiple “remote” servers that are deployed throughout a
large network. In order for an Aggregator server to obtain the data from the remote servers, it
must have access to that server through an “Aggregator” user account. For more details, see
the Installation and Initial Setup Guide.

) The Aggregator account type does not have access privileges to the web and applet
components of the DDM Inventory GUI.

Seftting up Accounts 17
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Setting up Accounts

This section is for the DDM Inventory Administrator only.
All of these commands are available when you click Administration > Account Administration.

These procedures allow you to create, delete, and configure user accounts.

Generating a List of Accounts

This page provides an alphabetical list of currently registered users, complete with their full
name and e-mail address. The user names in the list are hyperlinked, so that you can click on
the name and see all the options you can perform on that account.

To generate a list of all accounts:

1 Click Administration > Account Administration > List accounts.

A list of all the accounts appears. To modify an account, you can click on the Account name, or
go back up a level to the Account Administration page and click Account properties.

Account Account Hame E-mail Last Last Login Login

Name Type Address Succesful Failed Failure Enabled
Login Time Login Count

Time

admin Administrator | Administrator | nia 2008-10- 2008-10- 0 Yes
10 13:16 06 12:26

aggregator aggregator n/a 2003-08- n/a 0 Yes
26 13:29

demo T Manager Demo n/a 2008-08- 2008-08- o No

Account 20 18:30 18 18:56

temployee IT Employee IT Employee n/a 2008-08- n'a o Yes
26 1329

tmanager T Manager IT Manager n/a 2008-08- n/a 0 Yes
26 1329

SCAnner Scanner n/a 2008-08- n'a 0 Yes
26 13:29

Adding an Account

o

There can be as many as 250 accounts, including yours.

In DDM Inventory, all IT Manager and Administrator accounts have access to some powerful
features. If you have an IT Manager or Administrator account, be careful not to overwrite the
work of other IT Manager or Administrator accounts. In particular, it is recommended that
there be only one DDM Inventory Administrator.

The account name must be 3—16 characters long. Acceptable characters are:

e athrough z (must be lower case)

e 0 through9

e hyphen (-) (the hyphen cannot be the first character in the account name)

e underscore () (the underscore cannot be the first character in the account name)

To add an account:

1 Click Administration > Account Administration > Add an account.
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2 Enter a login name.

3 Click Add Account.

>»

Account name!

&dd Account

Customizing Account Properties

The account is created, but you must still create a password for the account. If you do not
create a password, no one will not be able to log in with it.

You can change any of the account properties listed in the following table:

Table 3 Account Properties
Property Explanation
Account type Determines the account’s level of access to DDM
Inventory.
Login enabled Determines if the account can use DDM Inventory.

Password expiry

The number of days an account can be used before
the password expires.

Name

The name of the account owner.

Allow others to copy map
configurations

Determines whether or not other users can copy
map configuration files from this account.

Append IP Address to device titles?

Determines if device titles are followed by device
IP addresses (when available). If chosen, an IP
Address column will appear in the Alarm Viewer,
Events Browser, and Service Analyzer.

Make URLs visible

Determines if hyperlinks are followed by the
associated URL (for easy cut and paste).

Alternate colors in table rows

Tables are easier to read with alternating colors,
but they take more space on your screen.

Highlight table rows on mouse over

Lets you highlight a row you want to look at.

Time before marking statistic as
stale

Applies to Device Manager, Port Manager, Line
Manager, Attribute Manager, Alarms Viewer,
Health Panel, and Service Analyzer. When a
statistic has not been updated for this set amount
of time, the data will appear with a grey
background.

Setting up Accounts
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Table 3 Account Properties

Property

Explanation

Long date format

Determines how the date appears at the bottom of
most panels and pages.

Short date format

Determines how the date appears at the bottom of
the Statistics panel's Table view and in Reports,
Event Browser and Health Panel.

Default Home Page

Determines the first page you will see when you
log in to DDM Inventory: the default home page, or
the Asset Questionnaire.

Device Manager scan file viewer

Determines whether you will see a Windows®
based viewer or a Java™ based viewer when you
press the View Scan Data button in the Device
Manager.

Default Device Manager panel

Determines which panel will appear when you
open a Device Manager session.

Default Port Manager panel

Determines which panel will appear when you
open a Port Manager session.

Default Attribute panel

Determines which panel will appear when you
open an Attribute Manager session.

Default Device Manager Ports
panel selection

Determines which configuration will appear when
you open a Ports panel in the Device Manager.

Default Device Manager Ports
panel increment

Determines how many rows of data the Ports panel
displays at a time. Default: 24

Default Device Manager statistic

Statistic selected in the Device Manager Statistics
panel.

Default Port Manager statistic

Statistic selected in the Port Manager Statistics
panel.

Default Statistic interval

Interval selected for your Statistic panels in the
Device Manager and Port Manager.

Default Statistic maximum

Statistic maximum selected for your Statistic
panels in the Device Manager and Port Manager.

Default Statistic granularity

Statistic granularity selected for your Statistic
panels in the Device Manager and Port Manager

To select an account for customizing:

1 Click Administration > Account Administration > Account properties.

IT Manager and IT Employee accounts can modify their own account properties by
clicking Administration > My Account Administration > Account properties.

2 Select an account from the list box.

3 Click Modify Properties.
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To modify an account:
1 Select an account type.

) You cannot change the account type, web/applet access, or password expiry period for the
account you are currently using.

2 Select whether or not this user will have access to the web and applet components of the
user interface.

Select a time for the user’s password to expire.
(optional) Enter a descriptive name in the Name field.

Assign the other appropriate properties.

o U A W

Click Modify Properties.

Account type: Admin

Login enabled: es

Pag=word expiny: does not expire

Name: :-Administrﬁtur

Allew others to copy map configurations?: O‘r’es @ No

Append IP Address to device titles ?: Oves ®ho

Make URLS visile?: Oes Otio

Alternate colers in table rowa?: @ ez O Mo

Highlight tablz rows on mouse over?. Oves @no

Time befere marking statistic as stale: Days: iEI Hours: 52 Minutes: iIJ Secands: D |
Long date format: :%A, %B %e, %Y %T %z EcIefaurt: %A, %B %e, WY T %Z
Short date format: [ev-%m %4 %R %:Iefﬂurt: %N -%m-%d %R

Defautt Home Page: | Defaut |

Device Manager =can file viewer: | Win32 v -:

Device Manager ports panel increment: |24

Defaut Devics Manager statistic [ 1o Setection] [ |
Defaut Port Hanager statistic [NoSelection] ||
Defaut statistc interyat [Past2hours v

Defaut statistc maximun | Toreshok Hax.

Default statistic granularity; :Defaurt gra n;{l_a_ rrt:.r -\;

Modify Properties
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Modifying Account Contact Information

You can change any of the following properties:

e e-mail address (optional, but required if the user is to receive any e-mail about the DDM
Inventory server or the network)

e Pager e-mail address

To modify an account’s contact information

1 Click Administration > Account Administration > Account contact data.

IT Manager and IT Employee accounts can modify their own account properties by
clicking Administration > My Account Administration > Account contact data.

Select an account name from the pull-down list.
Click Modify Properties.
You can now modify any of the contact information.

Check to make sure the changes are correct.

o O A WN

Click Modify Contact Data.

To enable e-mail notification

1 Enter an e-mail address in the E-mail address field.

If the e-mail address is blank, the user will not receive any e-mail.
To enable pager notification through an e-mail gateway

1 Enter a pager address in the Pager e-mail address field.

E-rmail addrass:

[ Modify Contact Data

Modifying an Account Password

An Administrator account must create an account password while creating a new account, or
can modify the password at any other time.

Passwords can be up to 20 characters long (the minimum length depends on the setting at
Administration > System Configuration > Server passwords). Acceptable characters are:

e A through Z
e athroughz
e 0 through 9
e underscore (_)

e at(@)
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e period (.)
e  hyphen (-)

To modify an account password:

1 Click Administration > Account Administration > Account password.
IT Manager and IT Employee accounts can modify their own account properties by
clicking Administration > My Account Administration > Account password.

To select an account:

1 Select an account from the list box.

2  Click Modify Account.

To modity or create a password:

1 Enter the new password in the first field.
Do not enter the current password (if any).
2 Enter the same new password in the second field.
Entering the same password twice helps guard against typing errors.
3 Click Modify Password.
Modifying the password resets the Password Expiry and Failed Login Attempts features.

If the Administrator has set up the Password History feature, you cannot re-use passwords.
You must have a new password each time you perform this procedure.

vy

Password:

_P-éss.le\;or.d -(ég.aii.'l) :

[ Modify Passwaord ]

Deleting an Account

This page allows the Administrator account to delete an account from the list of current
accounts.

) The account you are using to delete accounts, or the “active” account, cannot be deleted.

To select an account:

1 Click Administration > Account Administration > Delete an account.
2 Select an account from the list box.

3 Click Delete Account.

4 Click Confirm.

Seftting up Accounts 23



24

Account name: 1
Select Account v

Delete Account

Troubleshooting

Why do | see “Account hame ‘delme’ does not exist.” when | try to delete an account?
Two possibilities:
¢ Another Administrator account deleted the account just before you did.

¢ You deleted the account yourself, but the account login name still appears in the list box

because the list has not been updated. To get an updated list of accounts, click your web
browser’s Reload or Refresh button.
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Maintaining Your Account

This section is intended for Administrator, IT Manager, and IT Employee accounts.

) The Demo account cannot perform any administration functions.

You can maintain your own account by setting your own preferences, contact information, and
even your password. An Administrator account can also do these tasks as part of setting up
accounts.

¢ Changing your account properties (see Customizing Account Properties on page 19)
e Changing your password (see Modifying an Account Password on page 22)

e Testing Your E-mail Address on page 25

e Testing Your Pager Address on page 25

Testing Your E-mail Address

Testing your e-mail address will send an e-mail message to your account so that you can:
e Test that you have entered your e-mail address correctly.

e Test that the DDM Inventory server has been configured to send e-mail.

To test your e-mail address:

1 Click Administration > My Account Administration > Test e-mail address.

2 To send an e-mail message to your account, click Confirm.

If you do not receive the message, it could be because:

e No e-mail address is specified.

e An incorrect e-mail address is specified.

e A mail server has not been specified for use with DDM Inventory

¢ The receiving mail server is not working.

Testing Your Pager Address

Testing your pager address will send an e-mail message to your pager so that you can:
e Test that you have entered your pager address correctly.

e Test that the DDM Inventory server has been configured to send e-mail.

To fest your pager address:

1 Click Administration > My Account Administration > Test pager address.

2 To send an e-mail message to your pager, click Confirm.
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If you do not receive the page, it could be because:

e No pager e-mail address is specified in your account profile.

¢ The incorrect pager e-mail address is specified in your account profile.
¢  Your pager service provider is having problems.

*  Your pager is turned off.
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3  Working with SNMP Traps

HP DDM Inventory determines network events and places them in an internal events
database. Typically an operator can browse these events within the Events Browser, but there
are circumstances where the events can be exported to a third party system using Event
Filters (see Chapter 4, Setting up Event Filters). DDM Inventory may export SNMP V2C trap
event notifications.

To see the full contents of the hpov-ed-trap.my file, go to the following directory on your DDM
Inventory server (this is the default install location):

C:\Program Files\Hewlett-Packard\DDMI\7.60\events\mibs

Installing SNMP Package on DDM Inventory Server

You must install the open source SNMP package on your server in order for DDM Inventory to
use SNMP traps. The net-snmp-5.3.0.1-1.win32.exe file is available on the DDM Inventory
installation CD.

To install this software:

1 Double-click on the net-snmp-5.3.0.1-1.win32.exe file, available on the DDM Inventory
installation CD.

2  Go through the install wizard, selecting all default options.

DDM Inventory Notifications

DDM Inventory issues traps using SNMPv2c¢ messages. SNMPv2c notifications are the
successor to SNMPv1 traps. An SNMPv2c¢ notification can contain several objects, which are
then parsed by the collector to interpret the event contents. The interpreted contents are then
written to a database or forwarded to the notification engine of another NMS system. ¢

There are two notifications, deviceEvent and portEvent. Each carries a set of SNMP OIDs.
These variables cannot be retrieved by an SNMP get request. They are only available as
SNMPv2c¢ notification messages.

deviceEvent Notification

The deviceEvent notification is sent for events that correspond to a device, rather than a line.
For a detailed description of events that correspond to a device versus those that correspond
to a line, see the Reference Guide.

27



The deviceEvent event (OID: .1.3.6.1.4.1.11.2.17.18.0.2.1) contains the following members:

Table 1 deviceEvent Notification
Order |Object Type Description
1 serverlD Integer ServerID is an integer that has been
.1.3.6.1.4.1.11.2.17.18.0.1.1 configured by the administrator of the DDM
Inventory server; it is 1 by default. The
ServerID makes it easier for consumers of
the inventory to correlate devices managed
by different DDM Inventory servers.
2 eventID Unsigned32 Increasing sequence number associated
.1.3.6.1.4.1.11.2.17.18.0.1.2 with this event. This object is present for
1 compatibility only. It is always blank.
3 datetime Octet String | Date and time when event occurred
.1.3.6.1.4.1.11.2.17.18.0.1.2 (YYYYMMDD HH:MM:SS).
2
4 category Integer For a complete list of possible events, see
.1.3.6.1.4.1.11.2.17.18.0.1.2 Help > Classifications > Supported Device/Port
3 Attributes, and select the appropriate
Internal Name. For example, for “Bytes In”,
select in_bytes
5 deviceNMID Unsigned32 Network Manager Identification
.1.3.6.1.4.1.11.2.17.18.0.1.2
5.1
6 deviceType Unsigned32 The device type (Icon).
.1.3.6.1.4.1.11.2.17.18.0.1.2
5.2
7 deviceTag Octet String | The name of the device.
.1.3.6.1.4.1.11.2.17.18.0.1.2
5.3
8 macAddress Physical The MAC address associated with the
.1.3.6.1.4.1.11.2.17.18.0.1.2 | Address device.
54
9 ipv4Address IP Address The IPv4 address associated with the device
.1.3.6.1.4.1.11.2.17.18.0.1.2 (if any).
5.5
10 deviceTitle Octet String | The (network map) title of the device as
.1.3.6.1.4.1.11.2.17.18.0.1.2 defined by the appliance administrator.
5.6
11 priority Integer The priority of the device as defined by the
.1.3.6.1.4.1.11.2.17.18.0.1.2 appliance administrator: 1, 2, 3, 4, 5 or 6.
5.7
12 direction Integer Direction of port that triggered event:
.1.3.6.1.4.1.11.2.17.18.0.1.2 notAvailable, in, out.
7
28
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portEvent Notification

The portEvent notification is sent for events that correspond to a port or line, rather than a
device. For a detailed description of events that correspond to a port or line versus those that
correspond to a device, see the Reference Guide.

The portEvent event (OID: .1.3.6.1.4.1.11.2.17.18.0.2.2) contains the following members:

Table 2 portEvent Notification
Order | Object Type Description
1 serverlD Integer ServerID is an integer that has been
.1.3.6.1.4.1.11.2.17.18.0.1.1 configured by the administrator of the DDM
Inventory server; it is 1 by default. The
ServerID makes it easier for consumers of
the inventory to correlate devices managed
by different DDM Inventory servers.
2 eventID Unsigned32 | Increasing sequence number associated
.1.3.6.1.4.1.11.2.17.18.0.1.2 with this event. This object is present for
1 compatibility only. It is always blank.
3 datetime Octet String | Date and time when event occurred
.1.3.6.1.4.1.11.2.17.18.0.1.2 YYYYMMDD HH:MM:SS).
.2
4 category Integer For a complete list of possible events, see
.1.3.6.1.4.1.11.2.17.18.0.1.2 Help > Classifications > Supported Device/Port
3 Attributes, and select the appropriate
Internal Name. For example, for “Bytes In”,
select in_bytes
5 deviceNMID Unsigned32 | Network Manager Identification
.1.3.6.1.4.1.11.2.17.18.0.1.2
5.1
6 deviceType Unsigned32 | The device type (Icon).
.1.3.6.1.4.1.11.2.17.18.0.1.2
5.2
7 deviceTag Octet String | The name of the device.
.1.3.6.1.4.1.11.2.17.18.0.1.2
5.3
8 macAddress Physical The MAC address associated with the
.1.3.6.1.4.1.11.2.17.18.0.1.2 | Address device.
54
9 ipv4Address IP Address The IPv4 address associated with the device
.1.3.6.1.4.1.11.2.17.18.0.1.2 (if any).
5.5
10 deviceTitle Octet String | The (network map) title of the device as
.1.3.6.1.4.1.11.2.17.18.0.1.2 defined by the appliance administrator.
.5.6

Working with SNMP Traps
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Table 2

portEvent Notification

11 priority Integer The priority of the device as defined by the
.1.3.6.1.4.1.11.2.17.18.0.1.2 appliance administrator: 1, 2, 3, 4, 5 or 6.
5.7
12 portNMID Unsigned32 | Network Manager Identification.
.1.3.6.1.4.1.11.2.17.18.0.1.2
6.1
13 portIndex Octet String | An index value that uniquely identifies this
.1.3.6.1.4.1.11.2.17.18.0.1.2 port within a module. The value is
.6.2 determined by the location of the port on
the module. Valid entries are 1 to the value
of moduleNumPorts for this module.
14 ifSpeed Integer An estimate of the interface's current
.1.3.6.1.4.1.11.2.17.18.0.1.2 | (Counter64) | Pbandwidth in bits per second. For
6.3 interfaces, which do not vary in bandwidth,
or for those where no accurate estimation
can be made, this object should contain the
nominal bandwidth. If the bandwidth of the
interface is greater than the maximum
value reportable by this object then this
object should report its maximum value
(4,294,967,295) and ifHighSpeed must be
used to report the interface’s speed. For a
sub-layer, which has no concept of
bandwidth, this object should be zero.
15 ifType IANAIifType | The type of interface. The Internet Assigned
1.3.6.1.4.1.11.2.17.18.0.1.2 | (Integer) Numbers Authority (IANA), through
6.4 updating the syntax of the IANAifType
textual convention, assigns additional
values for ifT'ype.
16 duplex Integer The duplex of port within the device: full,
.1.3.6.1.4.1.11.2.17.18.0.1.2 half, or non-applicable.
.6.5
17 connectedToDevice Unsigned32 | The NMID of the remote device this port
.1.3.6.1.4.1.11.2.17.18.0.1.2 connects to.
.6.6
18 connectedToPort Unsigned32 | The NMID of the port on the remote device
.1.3.6.1.4.1.11.2.17.18.0.1.2 this port connects to.
6.7
19 direction Integer Direction of port that triggered event:
.1.3.6.1.4.1.11.2.17.18.0.1.2 notAvailable, in, out.
q
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4 Setting up Event Filters

Setting up Event Filters is for Administrator accounts only.

You can configure DDM Inventory to notify you when events occur. DDM Inventory can notify
you by email, by pager, or by SNMP trap. For example, you can create an event filter to notify
you when a particular device has a Break alarm.

) For specific details on SNMP traps, see Chapter 3, Working with SNMP Traps.

Topics in this chapter include:

e Interactions Affecting Event Filters on page 32

e What is an Event Filter? on page 33

e Preparing DDM Inventory for Event Filters on page 33
e Example of an Event Filter on page 35

e Modifying a Filter on page 37

e Deleting a Filter on page 38

e Listing Event Filters on page 38
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Interactions Affecting Event Filters

The most important thing to remember about event filters is that they rely on the
system-level device priorities which are controlled by Administrator and IT Manager
accounts. In order for your event filters to work properly, you must make sure you set the
system-level priorities for your devices properly.

Be very careful when setting up your event filters. Many factors contribute to making your
event filters work effectively. Make sure you complete all of the tasks in this chapter. If you
skip any of these tasks, or if you do any of them incorrectly, your event filters may not work.

If you are not familiar with the following concepts, read the appropriate sections of this User
Guide.

Table 1 Prerequisites

Concept Commands and where to get more information

E-mail Issues

Set up your SMTP server Administration > System Configuration > Server configuration >
SMTP server. See the Installation and Initial Setup Guide.

Events Issues

Understand the types of See the Reference Guide.
events recorded by DDM
Inventory

Account Issues

Set up account contact Administration > Account Administration > Account properties.
information

Network Map Issues

Change device priorities Changing Device and Port Properties on page 63

Event filters are an advanced option. You have the power to send pager and e-mail messages
whenever a device attribute changes state. This means that the potential exists to send
several pager and e-mail messages for the same event on the same device.

You must make sure you are setting up the event filters properly, to avoid excessive
notification, or notification on the wrong devices, or no notification at all.

If you have read this section and believe you have set up all the components properly, and
your events filters are not working properly, call Customer Support.
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What is an Event Filter?

All events in the network are recorded in the event log. You can select events that are
important to you, and DDM Inventory can notify you in the following ways:

e Send an e-mail message

e Send an alphanumeric page by means of an e-mail gateway

e Send an SNMP trap to another network management system
e C(Create an XML file for use with another application

DDM Inventory has two default event filters. You can create your own through Administration
> Event Filter Configuration.

You can enter a range of IP addresses if you want to be alerted about events on a portion of
your network. This allows you to create event filters specifically for a network, subnet, or even
a single device. If you leave this section blank, the event filter will apply to all devices in your
network.

Table 2 Default Event Filters

Default Event Filter | Description

email-admin-device Send e-mail to the “admin” account? when a device of priority 6
breaks.

email-admin-line Send e-mail to the “admin” account? when a line of priority 6
breaks.

a. The “admin” account is the default Administrator account. If you have changed the name of this
Administrator account when initially setting up DDM Inventory, you should have changed these
default event filters.

Preparing DDM Inventory for Event Filters

In order to have event filters work properly, you must have several components set up.

¢ For a device with multiple IP addresses, be sure to determine its primary IP address when
specifying the IP range for your event filters.

e Make sure the following is set up in DDM Inventory:
e SMTP server
e SNMP traps setup (only if you plan to use SNMP traps)
¢ For accounts who are going to receive e-mail or pager messages:

e Make sure their accounts are set up with proper e-mail addresses and pager e-mail
addresses.

e Test their e-mail addresses and pager e-mail addresses to make sure they are
working.

e Make sure you have set the system-level priority for your important devices.

Once you know how to use all of these components together, you are ready to set up your event
filters.
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Event Filter Properties

The properties of event filters are as follows:
Table 3 Event Filter Properties

Property Explanation

Name The name can be 3-20 characters long, can include lower case
letters, numbers, underscore (_), and hyphen (-). The underscore
and hyphen cannot be the first character.

Description The description can be 0-60 characters long; used to provide a
reminder as to the purpose of the filter.

Event Type You have a choice of several types of events for which you want to
receive notification.

e All (all of the categories listed below)
e Adds (when a device is added in your specified IP range)
e Deletes (when a device is deleted in your specified IP range)

e Property (when you change a device property for the type of
device specified in your IP range, like an icon, device priority,
device tag, or device title)

e Moves (when there is a connectivity change within your IP
range, i.e., a changed port, or when devices are physically
moved and connected differently; indicated by a Port Moves
event in the Health Panel)

Note: The safest and easiest way to make sure you get your event
notification is to select the All Event Type category. That way,
you will be notified if any of these categories has an event occur.
However, if you want to receive notification for a very specific
event, you should pick an event type.

Priority The priority of devices about which you want to be notified.
Device Type The type of device about which you want to be notified.

Line Alarm Type The type of lines about which you want to be notified.

(only for Line Event

Filters)

IPv4 Range Enter a range of IPv4 addresses in which you want to be notified

of this event.

Notification Notifications must include an action, and can include an account.
e gsend e-mail

e send alphanumeric page via e-mail gateway

e send SNMP trap data

e create an XML file
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Example of an Event Filter

There are many ways to set up event filters. Sometimes, it is difficult to understand all the
possible implications.

It is always best to create simple and specific event filters that are easy to understand.

Read this section to understand how to create a few common, simple, and helpful event filters.
If you have more questions, please call Customer Support.

Example: Notification When a Device is Added to or Removed from the Network

You may want to know when a particular type of device is added to or removed from the
network. For this example, we will set up an event filter that will page an Administrator
account when any Linux workstation is added or removed.

To set up the Administrator account:

1 Click Administration > Account Administration > Account contact data.
Select the Administrator account that you want to change.
Click Modify Properties.

Enter your pager e-mail address.

u A 0N

Click Modify Contact Data.

To set up the event filter:

1 Click Administration > Event Filter Configuration > Add a device filter.

2 Enter the event filter information as it appears in this table:

Table 4 Example 1 Input

Field: Enter:

Name (create a name linux_box_add_delete

for the filter)

Description Page administrator when any Linux workstation is
added/removed

Event Types Adds and Deletes

Priority All

Device Type Linux Workstation

IPv4 Range Select the devices or IP range you want this event filter to
monitor

Alphanumeric Page (via | Select the Administrator account

e-mail gateway)

3 Click Add Filter.
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Modifying a Filter

To select a filter to modify:

1
2
3

Click Administration > Event Filter Configuration > Modify a filter.
Select an event filter from the pull-down list.

Click Modify Filter.

To edit the description of the filter:

When using Selection Criteria list boxes, you can select multiple options.

Windows users: Use the Shift and Control keys in combination with clicking the mouse.

1
2
3
4

Select one or more options from the Event Type list box.
Select one or more options from the Priority list box.
Select one or more options from the Device Type list box.

Select one or more options from the Line Alarm list box.

) These selection criteria apply to all notifications.

To enter the IPv4 range:

1

2

) Use primary IPv4 addresses. To find a device’s primary IPv4 address, look at the top of the

Click Add by interval and enter the starting and ending IPv4 addresses or click Add by
subnet and enter the IPv4 address and netmask.

Click Add IPv4 Range.

Device Manager.

To select notification:

1

Select the appropriate notification for the event filter:
e E-mail

e Alphanumeric Page (via e-mail gateway)

e SNMP Trap

To modify filter:

1

Click Modify Filter.

) DDM Inventory does not check to see if the user has provided the appropriate contact data.

Setting up Event Fifters
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Deleting a Filter

To delete an event filter:

1 Click Administration > Event Filter Configuration > Delete a filter.
2 Select a filter name from the list box.
Profiles are listed by name.
3 Click Delete Filter.
4 Click Confirm.

Listing Event Filters

The filter names are hyperlinked. Clicking the hyperlinks will take you to the Modifying a

Filter page for that filter.

To list filters:
1 Click Administration > Event Filter Configuration > List filters.
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emaik Adds &l g & Al Al

aaman-ng Delxtes
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11.222.330 10 Sand pags {via
11,222 33.255 emad) to
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2 Click a filter name hyperlink for more information about that filter.

Resetting to Defaults

To reset to default filters:

@ This action cannot be undone.

1 Click Administration > Event Filter Configuration > Reset to defaults.

2 Click Reset to Defaults.
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5 Adding, Removing, and Replacing Devices

There will be many situations when you are adding or replacing devices in your network. You
will have to take precautions when performing these activities, such as making sure all
devices have unique IP and MAC addresses.

Topics included in this chapter are:

e Importance of Unique IP Addresses on page 40
¢ Adding a Device on page 40

e Replacing a Device on page 41

¢ (Changing IP address of a Device on page 41

¢ (Changing Cards or Ports in a Device on page 42
e Removing Devices on page 42

e Activating Devices on page 48
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Importance of Unique IP Addresses

>»

DDM Inventory relies mostly on device IP addresses for gathering statistics and information.
It is important to have unique IP addresses for all your devices and their components.

If you have duplicate IP and MAC addresses in your network, you may have difficulty
obtaining accurate device and port statistics.

If you do have duplicate IP or MAC addresses, you can purge the devices, then reassign the
device addresses as necessary. DDM Inventory will then rediscover the devices and map them

properly.
This section features several possible scenarios, for adding, removing, or replacing devices and

ports in your network. If you experience problems and cannot find help in the documentation,
contact your DDM Inventory Customer Support representative.

When you remove a device from the network, purge the device. This will ensure that it is no
longer in the database.

Adding a Device

>»

These procedures will be helpful when you are adding any new device to your network.

If one or more of the ports on the device you add is the end of a Permanent Virtual Circuit
(PVC), make sure you add the correct Committed Information Rate (CIR) to the Port
Manager.

Once you have added a device to your network, DDM Inventory will discover it automatically.
If you want the device to appear in the database and on your map quickly, follow this
procedure.

To make a new device appear in DDM Inventory quickly:

1  From the Home page, click the Find button.
2 In the Find window, enter the IP address or domain name of the new device.

A warning appears, saying that DDM Inventory does not have the device in its database.
However, a link to the device appears.

Double-click the device name to open a Device Manager session.
In the Device Manager, click Update Model.

From the pull-down list, select Query Device.

o U A W

Click Update. DDM Inventory begins network discovery on the device immediately.
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Replacing a Device

There are many reasons for replacing one of your network devices. Perhaps a device has been
damaged, or you could be upgrading part of your network. Whenever you are replacing a
network device, be sure to use one of the following procedures.

) If one or more of the ports on this device is the end of a Permanent Virtual Circuit (PVC),
make sure you add the correct Committed Information Rate (CIR) to the Port Manager.

With Identical Device

If you are replacing one device with another of the same model, and the same MAC address,
DDM Inventory will see no difference between the two devices. DDM Inventory will register a
break alarm when the first device is shut down, but will clear that alarm when the new device
is powered on.

If the new device has different MAC and IP addresses, it is best to purge the old device
manually. This ensures that the device model for your new device is not merged with the
model of the old device.

) Properties (such as priority, device type, etc.) from “replaced” devices are not automatically
assigned to “new” devices. For example, if the Administrator manually changed the priority of
the old device, and you are introducing a new device with the same IP address as the old
device, make sure you manually change the priority of the new device. This will ensure
correct event notification.

With Different Device

When you replace a device with a different device and a unique IP address, it always best to
purge the old device before adding the new device.

Changing IP address of a Device

There are several reasons why you may be changing the IP address for a device. Some
€Ommon reasons are:

¢  You have been changing your subnets.

¢  You assigned an IP to a device, but discovered that the IP is not allowed because it falls
within a reserved IP range.

¢  You have accidentally created a duplicate IP in your network, and need to change one of
the addresses.

Changing the IP address of the device does not affect how DDM Inventory sees the network.
Read the following notes to make sure you understand how DDM Inventory reacts.

) If you change the IP of the device, but the MAC remains the same, the DDM Inventory
database updates automatically.

If you change the IP of a port, DDM Inventory automatically discovers the change. No
additional action is required.
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) If you change the IP of the device, and the MAC is not known, the update is slightly delayed.

Changing Cards or Ports in a Device

If you change all the cards in a device (and they have all new MAC addresses), DDM
Inventory reads the device as a completely new device.

If you change all but one card in a device, the new information is temporarily merged with the
old information. The new ports are discovered automatically, but the old ports remain in the
database until they are aged out. This means there may be some duplicate ports listed in the

Device Manager.

The best procedure is to purge the device before you change its ports or purge the old ports.
Then, DDM Inventory rediscovers the device as if it were new.

Removing Devices

Devices can be removed from the DDM Inventory database in one of two ways: automatic or
manual. This table shows the methods of removing devices.

Tablel Automatic and Manual Device Removal
Method Performed by How it works
automatic DDM Inventory 3 stages
e deactivate
* purge
e obliterate
manual an IT Manager or 3 methods
Administrator user .
e hide

e deactivate

® purge

This table compares the Hide, Deactivate, Purge, and Obliterate features.

Table 2 Hide, Deactivate, and Purge

Action Hide Deactivate | Purge Obliterate®
device removed from Network o o o

Map

device can be recovered if seen — w”b _b

“delete” event generated o o —

42
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Table 2 Hide, Deactivate, and Purge

Action Hide Deactivate | Purge Obliterate®
device statistics deleted — — o o

device events deleted from Events | — — o o

Browser

device events deleted from — — — o

Reports Database

a. Devices cannot be manually obliterated.

b. Once removed from the Discovery Database, a device can still be rediscovered, but it will be
considered a new device.

Removing Devices Automatically

The deactivation interval begins as soon as a device is discovered, and restarts after every
model update. When the deactivation interval ends, the device is made inactive.

A deactivation interval refers to the length of time DDM Inventory will wait before it makes a
device inactive. The deactivation interval should be long enough that devices are allowed to be
turned off for long periods, but short enough that devices removed from the network are not
needlessly kept in the database.

) There is limited space for deactivated devices. Once this capacity is exceeded, devices are
purged, regardless of the deactivation interval. The number of devices that can be
deactivated at one time is 10% of the device license for the DDM Inventory server.

When the device is inactive, it is considered “deactivated” and appears in the list of devices at
Status > Deactivated Devices. Once the device is inactive, the purge interval begins. When the
device is set to be purged, one of two things can happen:

e Ifyour device license capacity is full in the Discovery database, the purged device will be
obliterated, meaning that the device and all its associated data will be removed from the
database.

e Ifthere is space in the Discovery database, the purged device will remain in the database
until the obliteration interval passes.

) The number of purged devices that DDM Inventory keeps depends on your license. For
example, if you have a 10,000 device license, with 8,000 active devices in your network, DDM
Inventory will be able to keep records for 2,000 purged devices. However, active devices
always take precedence over purged devices. If you have 10,000 active devices, DDM
Inventory will not save any purged devices in its database.

Changing Device Expiry Intervals

Device expiry has three steps: deactivation, purge, and obliteration.

For deactivation and purge, there are three intervals, one each for devices with:
e SNMP management

e no SNMP management

e Scanner-only devices (if available in your network)
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Whether or not the deactivation interval is accepted depends on your Device Modeler
Interval.

The obliteration interval is the same for all devices.

To change the expiry intervals:
1 Click Administration > System Configuration > Expiry.
2 Enter the time values deactivation, purge, and obliteration.

3 Click Change.

Managing Devices with Dynamically Assigned IP Addresses

Reusing IP addresses is a common occurrence for users who connect their laptops over VPN,
where a new temporary IP address is assigned to the device each time the user connects to the
network. IP addresses can also be reassigned to devices if your office network has a short
DHCP address lease time-out. In this case, devices may get disconnected from the network for
longer periods of time causing their IP addresses to be reused.

By default, DDM Inventory will not deactivate devices with duplicate IP addresses in its
database. However, it will remove the main IP address from the older device record and
unschedule all modeling and scanning requests to run on the older device until the device’s
new IP address is discovered. The default setting ensures that DDM Inventory will not
deactivate devices in its database that have had their IP addresses reassigned to a different
device. The devices will continue to be active and searchable in the database. When there is a
duplicate IP address for a device in the database, DDM Inventory will create an exception,
and the device is marked with an asterisk (*) in the Configuration Panel of the Device
Manager.

You can configure DDM Inventory to deactivate a device in its database if it discovers another
device with the same IP address. If you decide to deactivate devices with duplicate IP
addresses and you add a new device to the network that has the same IP address as an active
device, the old device will automatically be moved to the list of Deactivated Devices (Status >
Deactivated Devices). You will also see an exception for the old device, stating that the device
has been deactivated because of a “duplicate IP address.”

Also, if you decide to use this option and a device has been deactivated (either manually by the
user, or automatically by DDM Inventory), and you add a new device with the same IP
address, there will not be a “duplicate IP address” exception.

However, if the deactivated device becomes reactivated (either manually by the user or it is
rediscovered by DDM Inventory), there will be a “duplicate IP address” exception.
Reactivation works similarly for deactivated devices and for devices with cleaned IP
addresses.

If you turn on this option, it will also be enabled if you upgrade to a later release of DDM

Inventory in order to preserve the current behavior of your system.

To deactivate devices with duplicate IP addresses

1 Click Administration > System Configuration > Network Devices.

2 For the Deactivate older devices with duplicate IP addresses option, select Custom and select
Yes.

3 Click Change.
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Removing Devices Manually

The manual removal process can occur in three ways. An Administrator can Deactivate, Hide,
or Purge a device.

By using these commands, you are not making a physical change to the device or network.
The manual removal of a device from the database and Network Map should be accompanied
by its physical removal from the network, otherwise the device may reappear.

To prevent the device from reappearing, you must do one of three things:
e Actually disconnect the device from your network

e Assign a Basic Discovery configuration profile with the “Allow group to manage devices”
property turned off to the device group that manages this device (Administration >
Discovery Configuration > Configuration Profiles)

) Devices can belong to multiple device groups. Be sure to apply this profile to the device
group that actually manages this device. To determine which device group this is, open
the Device Manager, click the Diagnosis button, and see the Configuration Profiles table.

e Use the Hide command to stop a device from being rediscovered

) If a device has not been seen for the period set (in Administration > System Configuration >
Expiry —see Changing Device Expiry Intervals on page 43), DDM Inventory automatically
takes appropriate action.

) If you change the address ranges in Discovery Configuration, devices that are no longer
included in the ranges are automatically deactivated.

The Deactivate, Hide, and Purge commands are available on the Network Map, through the
Object menu. The commands are also available through the Device Manager Device Visibility
panel, or by right-clicking on the device in any applet window (for example, the Alarms
Viewer).

If you want to Activate a device that you have hidden or deactivated, see Activating Devices
on page 48.
Hiding Devices

This command removes the device from the Network Map and all reports, though a complete
record of the device and its history is kept. The only way to bring the device back to the
Network Map is to use the Activate command. Once hidden, this device will appear on the list
at Status > Device Status > Hidden Devices.

The device remains hidden until reverted manually by an administrative command.

‘- For example, if you have a MAC-only device that appears on the map, and you don’t want to
see it, “Hiding” it is the best way to get rid of it. Hidden devices still count towards your
device license limit.

To hide a device—starting from the Network Map

1 Select a device on the Network Map.
2 Click Object > Visibility > Hide.
A confirmation message appears.

3 Click OK.
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To hide a device from the network—starting from the Device Manager:
1 Click the Device Visibility button.

2  Select Hide from the pull-down list.

3 Click Hide.

Purging Devices

If you use Purge, the device will vanish from the Network Map and database, but will
reappear if the device is still included in an actively discovered device group. Purging removes
all traces of the device from the system, including all identification and history. If the device is
still on the network, it may be rediscovered at some future time.

The only way to make sure a device never reappears on the Network Map or in DDM
Inventory reports is to use the Hide command.

The Purge command cannot be undone.

To purge a device from the network—starting from the Network Map

1 Physically remove the device from your network following your company’s standard
procedures.

2 Locate the device on the Network Map using the Find tool.
3 With the device icon selected, Object > Visibility > Purge.
A confirmation message appears.

4 Click OK.

To purge a device from the network—starting from the Device Manager:
1 Click the Device Visibility button.

2  Select Purge from the pull-down list.

3 Click Purge.

To purge a port from a device:
1 In the Port Manager, click the Purge port button.
A confirmation message appears.

2  Click Purge.

Deactivating Devices

This command makes a device inactive. DDM Inventory will stop monitoring the device’s
statistics. If the device is rediscovered by DDM Inventory, it will be reactivated, and will
return to the Network Map. Otherwise, you can use the Activate command to manually bring
this device back to the Network Map. When deactivated, this device will appear on the list at
Status > Device Status > Deactivated Devices.

To deactivate a device from the network—starting from the Network Map

1 Select a device on the Network Map.
2 Click Object > Visibility > Deactivate.

A confirmation message appears.
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3 Click OK.

To deactivate a device from the network—starting from the Device Manager:
1 Click the Device Visibility button.
2  Select Deactivate from the pull-down list.

3 Click Deactivate.

Removing Stale Connections

Related to removing devices (deactivate, purge, obliterate), you can also automatically remove
stale connections from your database.

Once a connection has a line break, you can change the length of time that will pass until the
connection is automatically deleted.
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Activating Devices

>»

This command will bring a device from the list of hidden or deactivated devices, and back onto
the Network Map. DDM Inventory will start monitoring this device again.

You can re-activate devices if they have been deactivated or hidden by DDM Inventory, or by
an Administrator.

For information on how to Hide, Purge, or Deactivate devices, see Removing Devices on
page 42.

To reactivate a device from the hidden list:

1 Click Status > Device Status > Hidden Devices.
2 Click on the device title.
A Device Manager will open for that hidden device.
3 Click the Device Visibility button.
4 Select “Activate” from the pull-down list.
5 Click Activate.
The device should return to the database and the Network Map, and DDM Inventory will

begin to monitor this device again.

To reactivate a device from the deactivated list:

1 Click Status > Device Status > Deactivated Devices.
2  Click on the device title.
A Device Manager will open for that deactivated device.
3 Click the Device Visibility button.
4  Select “Activate” from the pull-down list.
5 Click Activate.

The device should return to the Network Map, and DDM Inventory will begin to monitor this
device again.
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6 Exporting Data into Data Access Applications

There are many tools that you can use to gain access to the MySQL database. You can use any
tools from MySQL (www.mysql.com), or others that you already use in your organization.

In order to gain access to the MySQL database, you must first create a MySQL account under
Administration > MySQL accounts. Once that is complete, you can export the data into your
other applications.

This chapter contains a sample tutorial, taking you through a simple example of how to
connect to the DDM Inventory database from Microsoft Access by means of ODBC; how to link
in the tables and perform two basic queries.

Topics in this chapter include:

e Step 1: Set up Your MySQL Account on page 50

e Step 2: Install MySQL ODBC Driver on page 50

e Step 3: Select MYSQL as Data Source (Create ODBC Alias) on page 50
e Step 4: Create New Database in Microsoft Access 2000 on page 52

e Step 5: Link in DDM Inventory Tables on page 52

e Step 6: Create Basic Assets and Recognition Query on page 54

e Step 7: Create Basic License Query on page 56
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Step 1: Set up Your MySQL Account

>»

In order to access the MySQL database through ODBC, you must create a MySQL account in
Administration > MySQL accounts.

These accounts are completely distinct from regular DDM Inventory accounts. They will only
give the user access to MySQL, not to any Ul features.

1 Click Administration > MySQL accounts > Add an account.
2 Enter the account name and password (twice).

3 Click Add User.

Step 2: Install MySQL ODBC Driver

If your computer does not already have a MySQL driver, download the latest MySQL
Connector/ODBC driver MSI or executable from the following URL and run the program:

http://www.mysql.com/products/connector/odbc/
In this example we have downloaded version 3.51 of the MYSQL Connector/ODBC driver.

Step 3: Select MYSQL as Data Source (Create ODBC Alias)

Before you can use the DDM Inventory data with Microsoft Access you need to create an
ODBC alias for the database.

To set up MySQL as the data source
1 From the Windows Control Panel, select Administrative Tools > Data Sources (ODBC).

The ODBC Data Source Administrator appears.

£71 ODBC Data Source Administrator

User DSH l System DSH ] File DSH ] Drivers] Tracing] Connection Pooling] About ]

User Data Sources:

I ame | Criver | Add...
[ R |

Microzoft dB aze Driver [*.dbf]
Eucel Files Microzoft Excel Driver [* xlz] Femove

M5 Access Databaze  Microsoft Access Driver [*.mdb]
Configure. ..

An ODEC User data source stores information about how to connect to
the indicated data provider. A User data source is only visible to pou,
and can only be used on the current machine.

QK | Cancel | Help

2 In the User DSN tab, click Add.
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The Create New Data Source dialog appears.

Create New Data Source §|

Select a driver for which you want to et up a data source.

Mame | WA
Microzoft Paradowx Driver [*.db ] 4
Microzoft Paradow-Treiber [*.db ] 4
Microzoft Test Driver [*.tat; * cav] 4
Microzoft Test-Treiber [* tat; * cav] 4
Microsoft Visual FoxPro Driver 1

1

3

1
SOL Server 2
< ¥

| Finizh | Cancel

3 In the list box select MySQL ODBC.
4 Click Finish.

The Connector/ODBC - Add Data Source Name dialog appears.

nEunnecturﬂ]DBE 5.01.0000 - Add Data Source Hame

Connector/0DBC
Login | Connect Options I Advanced I
Data Source Mame IDDMI Tutorial
Descripkion I
Server [172.22.10,10
ser Iadmin
Pas=word I [T
Database I LI
Tesk Diagnostics > |

Password

The password For the server user combination,

Optional Yes
Default [empty]

2k, Cancel Help

5 Enter the following information:

e The Windows Data Source Name (DSN). In the following example we have called it

DDMI Tutorial.

e The name or IP address of the DDM Inventory server.

Exporting Data into Data Access Applications
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8

e For the name of the user, enter the account name of anyone who has been set up with
a user account

e Enter the password for the above user.

¢ In the Database name field, select the name of the database from the drop-down list.
Click on the Connect Options tab. For the number of the port, always enter 8108.

Once you have entered these fields, click OK.

Now you are returned to the UserDSN tab in the ODBC Data Source Administrator dialog box.

Click OK to exit.

You are now ready to connect to the DDM Inventory database with applications such as MS
Access by means of ODBC.

Step 4: Create New Database in Microsoft Access 2000

To create a new database

1
2

Start Microsoft Access.
Create a new blank database. Give it a name and save it.

In this example, the database has been named DDMITutorial.mdb and saved in the following
directory

C:\Program Files\Hewlett-Packard\DDMI\7.60\Common

The following dialog is displayed.

&= EnterpriseDiscoveryTutorial : Database (Access 2000 file f... E]@@

Open g Design 55 New Eg
Objects Create table in Design view
Create table by using wizard
S Create table by entering data
Forms
=] Reparts
@ Pages
2 Macros
W Modules
GEroups
[#] Favorites

Step 5: Link in DDM Inventory Tables

To fully understand the DDM Inventory database, you can read full documentation in the web
UI by clicking Help > Database Schema.

To link in the DDM Inventory tables

1

In the Objects menu, select Tables and click New.
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The New Table dialog appears.

New Table

This wizard creates tables in the
current database that are linked
to kables in an external file,

2 Select Link Table and click OK. The Link screen opens.
3 On the Link screen from the Files of type pull-down list, select ODBC Databases.
The following dialog appears.

The DDMITutorial.mdb file is not supplied with DDM Inventory but is the file that
you created in step 2 on page 52.

4 Click the Machine Data Source tab.
5 Select your entry (in this case DDMITutorial) and click OK.

) This is the Tutorial data source name that you created in step 5 on page 51.

The following Link Tables dialog is displayed.

Link Tables

Tables l

Anpliance i~ oK |
Application

ApplicationCategaory

Aftribute e
Attributecroup

AttributecroupStateSummary Select Al
AttributeRefreshSchedule

AktribubeState Deselect Al
Company

Connection

ConnectionEvent

DataSet ¥ [ save passwor%

6  Click Select All.
All the entries are now highlighted.
7 Click OK.

Exporting Data into Data Access Applications
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You are returned to the Tables Tab which shows the newly linked DDM Inventory tables.

Microsoft Access - [EnterpriseDiscoveryTutorial : Database (Access 2000 file format]]

File Edit View Insert  Tools ‘Window  Help
O & v - - =g # -
5] Mew %
Objects @ Dataset »@ hwassetData
Tables @ DatasetGranularity » @  hwassetDatalnfo
s »& DBversion »@ hwEiosData
+ @ Device #@  hwBiosMachineDescriptions
Bl F
B s +@ DeviceCategory »@  hwBinsMachineExtensions
B reports @ Devicelron » @ hwBusData
@ Pages »@ Event »@ hwBusesSupported
2 Macros » @  Eventsummary » @ hwcards
@ Family »@  hwCMOsMemary
Madul
el +@  HourlySummary @  hwCPUCacheInformation
+@  hwappleTalkaddresses + @ hwCPUDaka
@ hwappliancelnfo » @ hwcPUs
+ @ hwassetanalysis @ hwDiskData
»@ hwAssetAutomatic »@ hwhisplayaraphicsadapters
Groups £ |
Ready

@
@
@
@
@
@
@
@
@
@
@
@
@
@

MM

hwiDisplayMonitg
hwiDisplayMonitg
hwDOSGEroup
hwDOSMemoryl
b IPDMISUFfixe
hwIPRAddresse:
hwikevboardDat
hwilegacyFPUD:
hwatemaryConfi
hwitemoryData
hwModems
hwMountPoints
hraMaunkPaink Sy

hwMouseData

5

To create a basic assets and recognition query

1 From the Objects list, select Queries.

File Edit View Insert  Tools ‘Window  Help
Dy v M0 o5
£ M
Objects
Tables
Forms
=] Reparts
@ Pages
2 Macros
W Modules
Groups
Ready MM

2 Double click Create query in Design view.

Step 6: Create Basic Assets and Recognition Query
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The Show Table dialog appears.

Showr Table

Tables | queries | Both |

Application
ApplicationCategaory
Attribute

Attributecroup
AttributecroupStateSummary
AttributeRefreshSchedule
AktribubeState

Company

Connection
ConnectionEvent

DatasSet
DataSetaranularity

|

Close

Add

3 In the Tables tab page, from the list, select:

e hwAssetData
e Device

e  hwCPUData

¢ hwRecognitionInfo

e hwSystemData
4  With the table selected, click Close.

The table appears.

5 Save the query. (In this example we have called it Assets and Recogpnition.)

6 Enter the query field parameters as shown below:

Microsoft Access - [Assets and Recognition : Select Query]

File Edit VMiew Insert Query Tools ‘Window Help -_ 8 X
-EE8 & B G= R S i 3
A
fCPUData =
*
Device_ID Device_ID — | | Device_ID Device_ID
hwhssetDescription Device_Discovered b PUICount hwFilesTatal
hwhssetTag Device_ManagedCe hwiPhysical CPUCount hwFilesProcessed
hwassetEmployesl Device_Preferredh, hwFilesRecognised T
hiwiissetliserLasti Device_PreferredIP ¥ hwFilesUnrecognised i
* A
Device I Device_ID
hwwScanCmdlic hwScanCmdLine
hwCreationtMe hwiCreationiMethod
hwScannerDes— hwScannerDescription —
hwScanDate hwScanDate
hwScanneryer hwiScanneryersionMajor
hwScanneryer hwScannerifersionMinor
hwScannerBuil % hwScannerBuild i 2
2m) 3
]
Figld: 10| r |hwassetTag hwassetDescription | hwScanDate hwCPUCount hwFilesRecognised A
Table: |hwassetData hwwdssetData hwwdssetData hwwSwstembData hwiCPUDaka hwRecognitionInfo =
Sort:
Shiow:
Criteria:
of: v
0 | >
Ready UM

7 Run the Query. From the Query pull-down menu, select Run.

Exporting Data into Data Access Applications
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A query is generated, showing asset and recognition data from the inventory scans in the
Inventory Database.

Microsoft Access - [Query] : Select Query]

File Edit Miew Insert Format Records Tools  Window  Help - @ X
E-HH &L i YR Ba- 0.

Device_ID| hwiAssetTag | hwAssetDescription | hwScanDate |[hwCPLUCount| hwFilesRecognise] «
| 56 _0010F3043579 _0010F3043579 - Pentium IIl, 700MHz, 128Mb 32005 23:40:28 1 0
| 58 Windows_2000_Profession: Windows_2000_Professional_7895 - Pentium IIl, 700K 352005 23:39:48 1 ]
| 59 0010F30437F6 0010F30437F6 - Pentium IIl, 700MHz, 128Mb 32005 22:02:20 1 0
| B0 780099 780099 - Pentium NI, 1133MHz, 1280Mb 3/2005 00:29:51 1 0
| 61/ 0010F30437 CE_Mex01-16 | 0010F30437 CE_Nex01-16 - Pentium I, 700MHz, 125 32005 22:38:10 1 0
| 62/ 0010F3043720 0010F3043720 - Pentium Ill, 700MHz, 128Mb 32005 23:358:56 1 0
| 66 6118FCh4AT00 {1 - Pentium IIl, 8E6MHz, 512Mb 32005 14:57:20 1 2105
| 67 0010F3043574 0010F3043574 - Pentiumn Ill, 700MHz, 128Mb 32005 23:40:58 1 0
| 65 0010F304385C 0010F304385C - Pentium Ill, 700MHz, 128Mb 2005 23:42:23 1 0
| 69 _0010F3043850 _0010F30435850 - Pentium IIl, 700MHz, 128Mb 2005 23:37:08 1 0
| 70/ 0010F304B044 0010F304E044 - Pentium Ill, 1200MHz, 128Mb 3/2005 04:58:01 1 0
| 72/ 0010F304385C 0010F304385C - Pentium Ill, 700MHz, 128Mb 32005 02:00:46 1 0
| 73/ 0010F3043757 0010F3043757 - Pentiurn Ill, 700MHz, 128Mb 32005 23:10:56 1 0
| 74/ 0010F3043750_Mex10-04  0010F3043780_MNex10-04 - Pentiumn Ill, 700MHz, 1280 32005 17:41:36 1 0
| 75/ 0010F304B030 0010F304B030 - Pentium IIl, 1200MHz, 128Mb 32005 23:18:18 1 0
| 76 KCMCTFWW KCMC1FW - Pentium 4, 3000MHz, 1536Mb 3/2005 08:51:03 2 0
| 77 B107FCMAATT S B107FCM4AATTS - Pentium IIl, BE6MHz, 256Mb 2005 17:13:55 1 0
| 165 0010F30437E1 0010F30437E1 - Pentium Ill, 700MHz, 128Mb /2005 04:27:33 1 0
| 172 0010F30437ED 0010F30437ED - Pentium IIl, 700MHz, 128Mb 2005 23:32:37 1 0
| 176 0010F30438C8 0010F30435CE - Pentium Ill, 700MHz, 128Mb /2005 02:04:33 1 0
| 179 NEXD3-01 NEXD3-01 - Pentium Ill, 700MHz, 128Mb /2005 10:19:04 1 0
id 182 0010F3043778 0010F3043778 - Pentiumn Ill, 700MHz, 128Mb 32005 23:35:44 1 0l ~|

Recard: M| 4| &0 _» [¥l
Datasheet Yiew UM

Step 7: Create Basic License Query

To create a basic license query

1

From the Objects list, select Queries.

Microsoft Access - [EnterpriseDiscoveryTutorial : Database (Access 2000 file f... F|E|P§|

File Edit Wew Insert Tools

Dy v

Window  Help

- 5

-8 X

-3,

] Mew
Objects

Tahles Create query by using wizard

Queries

Forms
=] Reparts
@ Pages

2 Macros

W Modules

Groups

Ready

MM

Double click Create query in Design view.
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The Show Table dialog appears.

Showr Table

Tables ]Queries ] Bath ] Add

Close

Appliance

Application
ApplicationCategaory

Attribute

Attributecroup
AttributecroupStateSummary
AttributeRefreshSchedule
AktribubeState

Company

Connection

ConnectionEvent

DatasSet

DataSetaranularity b

12

3 In the Tables tab page, select:
e Company.Company_Name
e Release.Release_ Name
e  SWSubComponent.SWSubComponent_LicenceRequired
e  Version.Version_Name
e Application.Application_Name
4 With the table selected, click Add, then Close.

The table displayed is similar to this:

Microsoft Access - [Query] : Select Query] |._||E|r'5__<|
File  Edit  Wew Insert Query Tools Window Help - @ X
E- @5 #- ! mE oA -ENE 2
A
#* v M
] Yersion ID | Applcation_IT Company ID
Yersion_ID Version_Mame Application_M 3 Company_Mar—
SWSubCompe OperatingSys Company_ID Company_LR
Wersion_TDLio % |lLanguage_ID ApplicationCa ¥ Comparry_Abl ¥ 3
22m] 3
]
Field: (] -
Table:
Sort:
Show: ] ] ] ] ]
Criteria:
of:
&4 T >
Ready MM

5 Click File > Save As and save the query

In this example, we have called it Licenses.
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Enter the query field parameters as shown below:

e Licenses : Select Query,

SWSubComponent Yersion Application Company
* * ~
e Yersion_ID W] Company_ID
Yersion_ID . Version_Name Company_Mame
SSubComponent_LicenceRequired OperatingSystemGroup_ID ] Company_URI
Wersion_IDLicence hd Language_ID v ApplicationCategory_ID % Company_Abbreviation o
<] >
Field: [Company_Name Application_Name Version_Mame SwwSubComponent_LicenceRequired SwSubComponent_LicenceRequired A
Table: [Compar Application Version SwySubCompanent SwSubComponent =
Total: {Group B Group B Group B Counk Group B
Sort:
Show:
Criteria:
ort v
[ >

Run the Query. From the Query pull down menu, select the Run option.

A query is generated, showing license data from the inventory scans in the Inventory

Database.
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7 Deleting Data and Connections

This section is for Administrator accounts only.
Do not perform these procedures unless you completely understand the consequences.

After you delete connections, DDM Inventory will start building connections again. This could
take a long time, especially in large networks.

By changing the deactivation and purge intervals, you risk removing devices from your
network that would not be removed with the default settings.

Deleting Data

This procedure will delete all of your network and configuration data. Once you complete this
operation, your server will appear as it did when you first installed DDM Inventory.

@ Deleting network data and statistics stored on your server is an extremely drastic action that
cannot be undone. Your backup data will not be deleted, however you should consider making
an external backup of your data first. See the Installation and Initial Setup Guide.

There are three options of increasing severity, and the options are outlined in the following
table:

Table 1 Delete Data

Above plus

Above plus configuration
What gets deleted Network data accounts data
Device models o o o
Connection data o o o
Device and Port o o o
Statistics
Forecast views o o o
Scan Files ‘5’ ‘5’ ‘5’
Prime Map o o o
Configuration
Map Configuration Files o o o
for all accounts
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Table 1 Delete Data

What gets deleted

Network data

Above plus
accounts

Above plus
configuration
data

Device and Line fault
events

W

W

Reports

W

Account names and
passwords

Account Properties and
Contact Data

Account Map
Preferences

€ €] €€ £

Server Configuration

Discovery Configuration
(Device groups,
configuration profiles,
etc.)

4 € € €4

System Configuration
settings

SNMP Trap Recipients

Event Filters

Router Discovery
Settings/Results

MySQL Accounts

Agent Deployment
Accounts

Asset Questionnaire
configuration

All Remote Server data?

€ €] €€ €449 &

a. This applies only when an Aggregator license is present.

To delete DDM Inventory data:

1 Click Administration > Data management > Delete data.

2 Select one of the following:

e Network data

e Above plus accounts
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e Above plus configuration data
3 Click Delete Data.
4 Click Confirm to delete the data.

Deleting Connections

This procedure will delete connections between objects on the Network Map. It will take a few
minutes for changes to be reflected in the map.

You can choose to delete:

e all the connections that have been made, both those established by DDM Inventory and
those defined by the user

¢ just the connections defined by the user

If you delete all connections, DDM Inventory will start over in its attempts to establish
connections between objects. User-defined connections will not be re-established by DDM
Inventory, no matter which of the two options you select.

You can potentially lose all the connectivity data DDM Inventory has gathered.

This action cannot be undone.

=N

To delete all connections:

1 Click Administration > Data management > Delete connections.

2 Select AllL

3 Click Delete Connections.

4 Click Confirm.

Both automatic and user-defined connections are deleted.

After connections are deleted, DDM Inventory will restart its attempts to establish automatic

connections between objects. It will not reconstruct user-defined connections.

To delete user-defined connections:

1 Click Administration > Data management > Delete connections.
2 Select User-defined only.

3 Click Delete Connections.

4 Click Confirm.

oAl
© User-defined only

Delete Connections
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8 Changing Device and Port Properties

If you have an Administrator or IT Manager account, you can change various Device and Port
Properties. This chapter shows you how to do this.
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Customizing for IT Manager and Administrator Accounts

This section is for IT Manager and Administrator accounts.

IT Manager and Administrator accounts can make changes to the Network Map that affect
what all accounts see.

When you make changes to a map configuration, the changes have the potential to affect all
accounts and all configurations.

64

Table 1 Properties
Affects other
accounts and
To change Do this maps Also affects
icon—devices see Changing Device o e whether event
Properties on page 64 filters are applied
(all accounts)
® reports
icon—packages | see the Network Data — —
Analysis Guide
tag Changing Device Properties | — —
on page 64
derived title see Administration > System | .» —
(devices) Configuration > Display
preferences
title see Changing Device —
Properties on page 64
priority see Changing Device whether event filters
(devices) Properties on page 64 are applied (all
accounts)
to top object see the Network Data — —
Analysis Guide

Changing Device Properties

If you have an Administrator or IT Manager account, you can change the following in the
Device Properties dialog (click the Properties button on the Device Manager):

e Device Icon
e Device Tag

e Device Title

e Device Priority

0 Changing a device icon affects what reports the device appears in.
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Changing a device icon can change how it is packaged. Certain icons are packaged
automatically. For example, when you change an end node icon to an icon that is not an end
node, the device may be automatically unpacked. If you change a device icon to an end node
icon, that device can be automatically packaged with the end nodes. See Administration >
System Configuration > Automatic packaging.

You might increase the priority of a device that is important to you or a device that you will
want to monitor more closely. Devices with priority 6 are the most important. The higher the
number, the higher the priority and the greater the importance.

To change Device Properties:

1 In the Device Manager, click the Properties button.

The Device Properties dialog appears.

2 To change the device icon, select a new icon from the pull-down list.

3 To change the device tag, enter your own custom text.

4 To change the device title, enter your own custom text.

5 To change the device priority, select a new priority from the pull-down list.
6  Click Apply.

7 Click OK.

) As soon as you change a property, DDM Inventory will register a change event in the Events
Browser.

= Device Properties - Server
-Device lcon

b . iz
(@) Default: B, Win2000 Wiorkstation

e
LIS |@Winznnn Workstation -

Device Tag
(@ Default:  yin 2000 Pro
1 C Win 2000 Pro

-Device Title
(@ Default:  HUES-AUTC2
| @ [HuBs-auTO2

-Device Priority-

(@ Default: 1

) Custom: ﬂ
| 0K Cancel

To reset Device Properties to the default settings:

1 In the Device Manager, click the Properties button.
The Device Properties dialog appears.

2 For the properties you wish to reset, select “Default.”
Click Apply.

4 Click OK.
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Changing Port Properties

If you have an Administrator or IT Manager account, you can change the following in the Port

Properties dialog (click the Properties button on the Port Manager):
e Interface Rate

e Interface Type

e Line Alarm Type

¢  Duplex Mode

To change Port Properties:

1 In the Port Manager, click the Properties button.
The Port Properties dialog appears.

. Port Properties - Server

(¥
=Ll HUB5-AUTOZ, Port 1.250

rInterface Rate
@ Default: 10 Mbitsisec
@)= 10 | [Mbitsisec v|

rInterface Type-

@ Default:  Ethernet CSMAICD
() Custom: | Ethernet CSMA/CD -

-Line Alarm Type
(@ Default:  Ethernet 10= HD
) Custom: | Ethernet 10< HD -

Duplex Mode -
@ Default:  Half duplex

() Custom: | Half duplex ¥
. 0K Cancel

To reset Port Properties to the default settings:

1 In the Port Manager, click the Properties button.
The Port Properties dialog appears.

2  For the properties you wish to reset, select “Default.”
Click Apply.

4 Click OK.

2 To change the Interface Rate, add a new rate in the custom text box.

3 To change the Interface Type, select a new type from the pull-down list.

4  To change the Line Alarm Type, select a new type from the pull-down list.
5 To change the Duplex Mode, select a mode from the pull-down list.

6  Click Apply.

7  Click OK.
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9 Contiguring Scanner Settings

When you installed DDM Inventory, you set up some Scanner configuration profiles as part of
your initial configuration (see the Installation and Initial Setup Guide for more details). If you
choose to, you can change various Scanner deployment options.

To start configuring your Scan File settings:
1 Click Administration > System Configuration > Scanner deployment.
2 Change the settings as necessary.
e AutoSequence Number on page 68
e Minimum Scanner Execution Retry Frequency on page 69
e Maximum Scanner Upgrade Attempts on page 69
e Initial Time to Wait between Scanner Upgrade Attempts on page 69
e Initial Time to Wait between Retrieve Scan File Attempts on page 69
e Maximum Scan File Download Attempts on page 70
e Download Current Scan File before Running Scanner on page 70
e Scanner Versions on page 70
e Scanner File Names on page 70
e Scanner Locations on page 71

3 Click Change.
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AutoSequence Number

The AutoSequence Number commands will help you assign an automatically generated number
to your scan files. This feature is optional, but it will be helpful if you want to assign numbers
to your scanned workstations. If you enable this function, each new scan file will be given a
“hwAutoSequenceNumber” field that will contain this automatically generated number. You
can use these options to determine the format of the number.

) If you are using aggregation, you should assign unique sequences to every DDM Inventory
Server in your network. If one asset is being monitored by two DDM Inventory Servers, the
sequence number from one DDM Inventory server will be visible on the other.

The Prefix can be an alphanumeric string (valid characters are A-Z, a-z, 0-9, dash, and
underscore).

) There must be a prefix configured.

The Character Count determines how many digits will be in the AutoNumber.

The Next Number will be the number at which the Auto-generator will start. For example, if
you enter “1”, the first asset number will be 0001.

) If you enter a Next Number that is more digits than configured in the character count, the
character count will automatically change to accommodate.
To configure AutoSequence numbers:
1 Click Administration > System Configuration > Scanner deployment.
2 Enter a Prefix, Character Count, and Next Number.

3 Click Change.

AutoSequence Number

AutoSeguence prefix: ® Dpefault:
O Custom:
AutoSequence character count: ® pefault: 3

O custom: =

AutoSeguence next number: ® Default: o

O custom: o
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Minimum Scanner Execution Retry Frequency

The minimum amount of time DDM Inventory will wait to attempt scanner execution.

) This setting should not occur every 24 hours. Try to avoid executing scanners at the same
time every day. If you have many users on VPN, set this to a shorter frequency.

If for some reason communication with a device is down, DDM Inventory will wait this length
of time before trying to run the scanner again.

Maximum Scanner Upgrade Attempts

Maximum scanner upgrade attempts controls the maximum number of attempts made by
DDM Inventory to transfer the relevant scanner executable and configuration files to a
machine.

If the maximum is reached, processing begins from the Agent Upgrade step.

Initial Time to Wait between Scanner Upgrade Attempts

Initial time to wait between scanner upgrade attempts controls how long after a failed
attempt will DDM Inventory wait before retrying to transfer the relevant scanner executable
and configuration files to a machine. The time between the unsuccessful attempts becomes
longer and longer (based on an exponential formula) and the value defined here represents
the initial delay, after the first attempt.

Initial Time to Wait between Retrieve Scan File Attempts

Initial time to wait between retrieve scan files attempts (in case of failure) controls how long
after a failed attempt will DDM Inventory wait before retrying to transfer the resulting scan
file back to the server. The time between the unsuccessful attempts becomes longer and longer
(based on an exponential formula) and the value defined here represents the initial delay,
after the first attempt.

This option also controls how long DDM Inventory will wait after sending the Run Scanner
request, before transferring the resulting scan file back to the server.

For example, the <fastsw> scanner takes a different amount of time than <hwonly>, so you
may want to adjust this setting so that it is long enough for more than 80% of your network
computers to complete scanning.
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Maximum Scan File Download Attempts

Maximum scan file download attempts controls the maximum number of attempts made by
DDM Inventory to transfer the resulting scan file back to the server.

If the maximum is reached, the process begins from the Agent Deployment step.

Download Current Scan File before Running Scanner

This option determines if the DDM Inventory Server will check how current the scan file is on
the remote device before running the scanner. If the scan file on the remote device is newer
than the one on the server, DDM Inventory will download the device’s scan file before running
the scheduled scan. When enabled, this option allows DDM Inventory to always have the most
recent device information in its database before initiating a new scan.

You should enable this option if you have several users who connect to your network
infrequently for short periods of time, such as VPN clients. When there are short connections,
a scan may start but not complete during the connection interval. In this case, DDM
Inventory will not have had the opportunity to download the latest scan file to its database
since the scan completed after the user disconnected the device.

) If the connect time for a particular device is always short (and this option is not set), this
process can repeat forever. As a result, even though the device is regularly scanned, the
associated scan files are never downloaded and the related device information is never
refreshed on the server database.

Scanner Versions

You can manually change the version of scanners you want to use for running on different
operating systems. See Help > Compatibility Matrix in the DDM Inventory GUI for a complete
list of supported operating system platforms.

This allows Scanner patches or upgrades to be applied for selected platforms only.

) For the Windows (x86) scanner, “.exe” is automatically appended to the name.

If this is your first installation of DDM Inventory, then there are only two options in the list:
<latest> and the version shipped with the version of DDM Inventory you are using. As you
upgrade to newer versions of the product, new versions will appear in this list.

Scanner File Names

You can manually change the name of the Scanner that will be sent to a particular type of
computer.
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Some antivirus programs may take note when DDM Inventory uploads a Scanner executable
onto the remote computer. Using these setting to give the Scanner a unique name can exclude
this name from being monitored by the antivirus program.

The default setting is appropriate in most cases.

Scanner Locations

If you use a tool other than DDM Inventory to deploy Scanners, you must specify the path
name for the scanner executable on the network devices. Refer to “Using A Different Tool to
Deploy Scanners” in the Installation and Initial Deployment Guide for more information.

The default setting is appropriate in most cases.
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|
10 Agent Communication Configuration

In order to distribute and run Scanners on your workstations, you must first install an agent
on each workstation.

The DDM Inventory server communicates with the Agent, allowing the server to run the
Scanner and retrieve data from the devices and export it back to the server.

The agent is installed as a permanently running program on a remote computer. On Windows
NT/200x/XP/Vista agent is installed as a Windows service. The agent enables the computer to
be securely scanned at any given time.

e For security reasons, agent communication is encrypted and authenticated.

¢ The agent performs requests for the DDM Inventory server. For example, it can access a
new scanner and execute it, or transfer a scan file to the server.

The agent must be installed on every computer that will be part of the automatic inventory
process. If you are doing the inventory manually using manual deployment mode, you do not
need the agent.

Communication with the agent can only be initiated by the server. The agent is not able to
initiate any file transfers, scans, etc.

) Each agent originating from a server will have a security key from that server. This means
that the agent will only be able to communicate with that server.

Supported Plattorms for Discovery Agents

For a list of supported platforms for the discovery agents, see Help > Compatibility Matrix in the
DDM Inventory GUI.

Disk Space Requirements on the Managed Device

Running scanners on your workstations requires a certain amount of available disk space on
the workstation. Refer to the “Disk Space on Managed Devices” chapter in the Installation
and Initial Setup Guide.
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Agent Security

During the initial setup and installation DDM Inventory generates a new set of security
certificates and keys to be used for secure communication between the agent and the server.
These certificates and keys are stored in the Cert directory located under the DDMT data
directory (usually C:\Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\Cert). The generated files are as follows:

e ACSKeyStore.bin - contains private security key of the server, server and agent
certificates.

® acstrust.cert - contains the exported server certificate to be used by the agent

® agentca.pem - contains the agent's private key and certificate.

0 These are crucial files. Keeping a reliable backup of them is extremely important.
ACSKeyStore.bin contains the private server key, so it must also be kept secret. If these
files get overwritten or a new set is generated, DDM Inventory will not be able to talk to the
installed agents any longer.

Once the set of certificates and keys has been generated, any successive installation on the
same computer will not generate new certificates/keys, but will use the old ones instead.

If multiple DDM Inventory servers are used to communicate with the same agents, the
certificates generated on one server need to be copied onto all the other servers.

0 If you manually overwrite the security keys on the DDM Inventory server, you must restart
the DDM Inventory server by restarting the System Monitor service. When the server is
restarted, a new client set of security keys becomes embedded into the agent media files that
correspond to the current keys that were used to overwrite the original ones on the DDM
Inventory server.

Agent Media Files

After the security keys and certificates become available, DDM Inventory generates the agent
media containing the corresponding agent security keys and certificates. In order to do this,
the agent media files are taken from the Agents\RawMedia directory located under the DDM
Inventory program directory (usually C: \Program
Files\Hewlett-Packard\DDMI\7.60\Agents\RawMedia), the two agent specific security
keys/certificate files acstrust.cert and agentca.pem are added to the agent media files
and the resulting files are placed into the LiveAgents directory located under the DDMI data
directory (usually C: \Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\LiveAgents).
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The content of this directory looks similar to this:

hp-ddm-inventory-agent-aix-ppc-7.60.000.8200.tar.Z
hp-ddm-inventory-agent-hpux-hppa-7.60.000.8200.tar.Z
hp-ddm-inventory-agent-1inux-x86-7.60.000.8200.tar.Z
hp-ddm-inventory-agent-macosx-x86-7.60.000.8200.tar.Z
hp-ddm-inventory-agent-solaris-sparc-7.60.000.8200.tar.Z
hp-ddm-inventory-agent-solaris-x86-7.60.000.8200.tar.z
HP DDM Inventory Agent (x86) 7.60.000.8200.msi

HP DDM Inventory Agent (PPC) 7.60.000.8200.dmg

e A .tar.Zz file for each UNIX platform supported by the agent.
e A MAC disk image file (.dmg).
e An MSI setup file for Win32.

The agent version and the build number are included as part of the file name for each agent
media file. Files from the LiveAgent directory are then used either for automatic or manual
agent deployment.

‘n- Under no circumstances the agent media files from the RawMedia directory could be used to
install agents. The files in this directory do not contain the agent keys/certificate required for
secure communication. Only agent media files from the LiveAgent directory must be used.

‘n- Only the agent media files for the current version of the product are updated with the latest
keys. Other agent media files that happen to be in the L.i veAgents directory (for example,
those belonging to older versions of DDM Inventory/Enterprise Discovery) are not updated.

Agent Directories

When the agent is installed on the computer it uses two directories for its operation:

e Agent program directory. This is the directory where the agent is installed to. The MSI
installer uses the Hewlett-Packard\Discovery Agent directory under standard
Windows Program Files directory. For UNIX agents, the installation directory is chosen
manually during its deployment. For Mac OS X agents, the installation directory is the /
Library/Startupltems/DiscoveryAgent directory.

e Agent data directory. This directory is used by the agent to store various files, such as logs,
utilization data, etc.

On Windows, it is normally located under the profile for the local service in Application
Data\Peregrine\Enterprise Discovery\Data.The discagnt.log file is found in

this directory. It is the log file that is written to by the agent on the local workstations and
servers on which the agent runs.

On UNIX, the data directory containing log files is the SHOME/.discagnt directory. On Mac
OS X, it is the /var/root/.discagnt directory.
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Initial Agent Deployment

Deployment through Windows RPC

This deployment method uses remote execution capabilities found in the Windows NT/200x/
XP/Vista operating systems. For this reason it does not work on Windows 98SE based
computers. In order for this method to work, the computer on which the agent is to be
installed needs to meet these minimum requirements:

e  Windows Installer must be installed and enabled in the Group Policy (see above for more
details).

¢  On Windows XP, Simple File sharing mode should be turned off. This is controlled from
the following Windows Explorer menu:

Tools->Folder Options->View -> Advanced Settings->Use simple file sharing

¢  On Windows XP with Service Pack 2 installed or Windows 2003 Server with Service Pack
1, the firewall either should be switched off or when left on, the remote administration
should be enabled. The officially recommended (by Microsoft) way of enabling remote
administration on a population of computers is to enable it in the Group Policy. The
remote administration can also be enabled manually by using this simple script (save as
enableremoteadmin.vbs and run):

Set objFirewall = CreateObject ("HNetCfg.FwMgr")

Set objPolicy = objFirewall.LocalPolicy.CurrentProfile
Set objAdminSettings = objPolicy.RemoteAdminSettings
objAdminSettings.Enabled = TRUE

However, this script requires administrator rights to work properly and must be run
locally on the target computer.

Also if the firewall is enabled, Do now allow exceptions check box should not be checked in
the firewall configuration.

In order to access remote computers, this deployment methods needs to know the
administrator account name and password for the remote computer. This is usually a domain
administrator account. As multiple domains can be in use, multiple account names/passwords
can be entered. The order in which the accounts are tried is as follows:

e The account names where the domain matches the network model workgroup name. The
network model workgroup is normally available when NetBIOS over TCP/IP is enabled on
the remote computer. This allows the appropriate domain administrator account to be
used first.

e The account names where the domain name is not specified (local administrator
accounts).

¢ Any other remaining accounts.

The deployment code tries to connect to the remote computer's ADMIN$ share using the
administrator account names and passwords provided in the order described above. Once
connection is established, it copies the agent installation to the remote computer and launches
the installation. The DDM Inventory server only registers successful attempts to launch the
installation. Once successfully launched, the agent installation can still fail because of
external factors, such as lack of available disk space, etc. When this happens, detailed
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information is available in the log file ovedagentinstaller. log located in the Windows
directory on the remote computer. This log file can help in troubleshooting agent installation
problems.

Automatic Agent Deployment to Computers Running Windows Vista and Server

2008

In Windows Vista and Server 2008, a new feature called User Account Control (UAC) has
been introduced to reduce the privileges of running programs. By default, a program launched
by a local administrator is not given full administrator privileges. To run a program with full
administrator rights, a local administrator can launch the program through a special
Windows Explorer command, namely, “Run as administrator.” Alternatively, a program can
request to be run with full administrator rights, in which case the UAC dialog is shown so
that the user can confirm that the program should be run with full local administrator rights.

UAC has an unfortunate side effect with regard to remote administration. When a local
administrator account is connected to a computer remotely (either through Remote Desktop,
“net use”, etc.), the account is not given full administrator rights. Since accessing system
shares requires full administrator privileges, it is not possible to connect to the default remote
administration shares, such as ADMINS using a local administrator account. For this reason,
automatic agent deployment does not work properly using local administrator accounts.

There are two ways of resolving this issue:

e Ifacomputer is in a domain, use a domain administrator account. When a domain
administrator is logged in remotely, it is given full administrator privileges.

¢ Otherwise, if a local administrator account must be used, the policy on the Windows Vista
computer needs to be modified to enable a local administrator to connect remotely with
full administrator rights.

To do this, run regedit on the Windows Vista or Server 2008 computer in question and
look for the following registry key:

HKEY_LOCAI_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\sys
tem

The registry value that gives full administrator rights is located under this registry key.
The value is called LocalAccountTokenFilterPolicy. Create this registry value if it
does not already exist. It is not there by default. To create this value, create a new DWORD
value, name it LocalAccountTokenFilterPolicy, and set the value to 1. If the value is
already there, make sure it is of type DWORD and has the value of 1. After this
modification, agent deployment should work properly when using local administrator
accounts.

) After this change has been made, local administrators connecting to the computer remotely
will have full administrator privileges.

Custom Deployment

This deployment method allows the end user to create custom deployment process using a
Windows batch script and/or other programs. For example, it is possible to implement a
custom UNIX agent deployment, using SSH. DDM Inventory runs the currently configured
shell (usually cmd.exe) with the /C parameter and passes the name of the program/batch file
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configured in the web UI (Administration > System Configuration > Agent communication > Agent
deployment command for custom) to it. This custom program receives the following command
line parameters:

e [P address of the box where the agent needs to be installed
e NMID of the device. This is the internal ID of the device in the DDM Inventory Database

e Version of the Windows (x86) agent media to be installed (for example: "7.60.8200"). The
agent media files need to be taken from the LiveAgents directory.

¢ Version of the AIX (POWER) agent media

¢ Version of the HP-UX (HPPA) agent media

e Version of the HP-UX (ia64) agent media

¢ Version of the Linux (x86) agent media

¢ Version of the Solaris (SPARC) agent media

e Version of the Mac OS X (PPC) agent media

e Version of the Mac OS X (x86) agent media

e Version of the Solaris (x86) agent media

e Max bandwidth to use for the operation (in K/sec) or 0 if no limit was configured.

e Workgroup - network workgroup from the network model. This is detected from the
NetBIOS workgroup name, which usually corresponds to the destination computer's
domain name.

The deployment is considered to be successful if the program returns an exit code of 0.

To automatically deploy an agent
1 Configure the deployment methods to be used in the web UL

Administration > System Configuration > Agent communication > Agent deployment method
2 To deploy to a single device:

¢ Open the device manager for the required device (for example by using the Find
command on the front page of the web UI)

e (Click on the Diagnosis panel, go to the Discovery Configuration section and check the
value for the Agent deployment property. The value should be None or Deploy in order
to be able to execute the next step.

e (Click the Update Model icon at the top.
e Select Deploy Agent from the drop-down box and click the Update button.

3 To deploy to a device group, configure the Agent configuration profile assigned to this
device group to include agent deployment:

a Click Administration > Discovery Configuration > Configuration Profiles.
b  Click the Agent tab.

c¢ Click the name of the profile assigned to this device group.

d Make sure that Allow Agent Communication is selected.

e Select Allow Agent Upgrade, and specify the <All the time> schedule.
f  From the Agent deployment list, select Deploy.

g Click Save and Close.
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4 Activate the configuration changes.

) There is a system defined Agent configuration profile called <Deploy agent> which has the
Agent deployment property set to Deploy. You can assign this profile to this device group if you
prefer.

If the deployment attempt failed to start the agent installation, detailed progress log is
available in the following place:

Device Manager> Diagnosis> Agent Log

Deployment through Login Scripts

Agents can also be installed via login scripts or a software distribution mechanism. In order to
execute a silent installation that does not require any user interaction, the MSI installer can
be executed with the following command line:

msiexec -gn -1 "D:\PathToLiveAgents\HP DDM Inventory Agent (x86)
7.60.000.8200.msi" -1v* D:\PathToLog\agentinstall.log

Where D: \PATHToLiveAgents specifies the path of where the live agents are located (for
example, the LiveAgents directory could be shared and the UNC path of that share can be
specified). The -Iv* logfile parameter is optional - D:\PathToLog\agentinstall.logis the
full name of the log file where the MSI will output the detailed progress/error information,
which could be useful to diagnose installation problems.

To install the agent in “Manual Deployment” mode, which installs only the software
utilization plug-in, add the property SETUPTYPE=Manual. For example:

msiexec /i "HP DDM Inventory Agent (x86) 7.60.000.8200.msi" /agn /Lv*
c:\agentinstalllog.txt SETUPTYPE=Manual

If this option is not set, the agent is installed in Enterprise mode. Refer to Manual
Deployment on page 79 for additional details on agent setup types.

Manual Deployment

The agent installation requires Microsoft Installer version 2.0 or above, which is part of the
Windows operating system (earlier service packs of Windows 2000 may have an older version
installed). When an older version is installed, the MSI installation must be upgraded to
version 2.0 or above. This can be done using Windows Update or by downloading the Windows
Installer 2.0 for Windows 2000 and Windows NT redistributable from the Microsoft web site.

The agent installation can be performed by running the install program located in the
following directory on the DDM Inventory server by default:

C:\Documents and Settings\ All Users\ Application Data\ Hewlett-Packard \DDMI\ LiveAgents
The agent installer will prompt for setup type:
¢ Enterprise Mode (recommended)

Selecting this mode will cause the scanners to be deployed by the DDMI server via the
agent. This mode will install both the agent and the software utilization plug-in.
Enterprise Mode is appropriate in most instances

e Manual Deployment
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This mode installs only the software utilization plug-in and is useful if you will be using
agentless scanning, but would still like to collect utilization data. Scanners must be
deployed manually, using either a third-party software distribution tool or a login script,
etc.

The Software Utilization license module must be enabled in order to collect usage
information. If this module is not enabled, utilization data is discarded when the scan file is
processed. See Chapter 1 of the Installation and Initial Setup Guide for additional
information.

Deploying a UNIX Agent

Because of high sensitivity of many UNIX environments, UNIX agents should be installed
either via custom deployment or manually. The following is the recommended way of
installing the UNIX agents:

e They should be installed into a directory which is only accessible by root.

e The content of the live agent media .tar.Z file should be extracted into the agent
installation directory.

e The agent should be run as root.
The agent could be launched as part of the UNIX startup scripts as follows:
cd /agentdir
nohup ./bin/discagnté&
Where agentdir should be replaced with the actual agent installation directory.

e The agent data directory is stored under SHOME/.discagnt. Special care needs to be taken if
$HOME refers to a common directory mounted via NFS to avoid agents from different
computers sharing the same data directory. In such cases, the HOME environment
variable needs to be redefined to point to a local directory prior to launching the agent.

To install the agent for UNIX in Manual Deployment mode (see Manual Deployment on
page 79), you would use the following command:

cd /agentdir
nohup ./Plugins/usage/discusge -d $SHOME/.discagnté&
Where agentdir should be replaced with the actual agent installation directory.
The following option can be passed to discusge:
-d <usage-dir> : To specify a directory for usage data

The utilization period is automatically set based on the PERIOD= value in the
discusge. ini file. This value can be either 365, 90, or 31 If the number of days must be
changed after the agent is deployed, modify the value in the discusge.ini file.

If the scanner has to later collect usage information it is recommended to run the scanner
under the same account as the usage agent which is in most cases, root.

Also, to avoid ambiguities with the position of scanner data, it is recommended that you set
explicitly the usage data path to $HOME/.discagnt/ using option -d. The .discagnt folder
under the home directory may need to be created if it does not exist.

This will allow the scanner to take usage information from the same location it usually uses
when run via the normal agent.
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) During normal operation on UNIX, the agent (discagnt) will generate 2 log files:

e discagnt.log: General information about agent status, this file is located in
SHOME/ .discagnt.

¢ nohup.out: This file contains all outputs from agent and other programs executed by the
agent. This file is located in /opt /Discovery.

These log files may be added to the system list of "rotated" log files (files that will split when
they grow to a certain size). Normally, they will not grow to more than 1MB of data for a year
of operation.

Deploying a Mac OS X Agent

The following is the recommended way of installing the Mac OS X agents:

e Copy the HP DDM Inventory Agent 7.60.xxx.xxxx.dmg file from the
DATA\LiveAgents directory to a folder on your Mac OS X machine. For example, you can

copy it to your Mac Desktop.

) The DATA directory refers to the C:\Documents and settings\All
Users\Application Data\Hewlett-Packard\DDMI on the DDM Inventory
server.

e Double-click the .dmg file to mount it. A drive icon named HP DDM Inventory Agent
appears.

e Double-click the newly mounted icon. A window opens showing the Agent package,
DiscoveryAgent.pkg.

¢ Double-click DiscoveryAgent .pkg to start the installation process.

) You may be asked for a system password to complete installation. This can occur if
you do not have the appropriate privileges on the system you are accessing to
perform the install.

) The DiscoveryAgent .pkg tree in the agent . dmg file can be used directly for
installation. For example, you can copy it to a Mac Xserve share.

The installation process installs the agent in the /Library/StartupItems/
DiscoveryAgent directory and starts the agent.

The following files are installed in the /Library/StartupIltems/DiscoveryAgent
directory:

— acstrust.cert - agent certificate
— agentca.pem - agent private key
— bin/discagnt - agent executable
— postinstall

— postupgrade

— StartupParameters.plist

— Plugin/usage/discusge

— Plugin/usage/discusge.ini
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— Plugin/usage/plugin.ini

) Do not change the location or edit any of the agent files.

During normal operation, the agent (discagnt) generates the /var/root/.discagnt/
discagnt.log log file.

The startup logs for the Mac OS X agent are located in /var/log/discagnt.log.

To start and stop the service from the terminal using the root account, run the following
commands:

SystemStarter start “DDM Inventory Agent”
SystemStarter stop “DDM Inventory Agent”

To install the agent for Mac OS X in Manual Deployment mode use the following commands
(note that Manual Deployment mode installs only the usage plugin--scanners must be
managed separately. For additional information, see Manual Deployment on page 79):

1 As aroot user in a terminal window, stop the DDMI agent using the command:
SystemStarter stop "DDM Inventory Agent"
2 Edit the service script () StartService function and replace the following lines:
cd SAGENTPATH
SAGENTPATH/bin/discagnt >> SAGENTLOG 2>&1 &
With:
cd SAGENTPATH
SAGENTPATH/Plugins/usage/discusge >> SAGENTLOG 2>&1 &
3 Restart the service with the following command:
SystemStarter start "DDM Inventory Agent"
The following option can be passed to discusge:
-d <usage-dir> : To specify a directory for usage data

The utilization period is automatically set based on the PERIOD= value in the
discusge. ini file. This value can be either 365, 90, or 31 If the number of days must be
changed after the agent is deployed, modify the value in the discusge. ini file.

If the scanner has to later collect usage information it is recommended to run the scanner
under the same account as the usage agent which is in most cases, root.

Also, to avoid ambiguities with the position of scanner data, it is recommended that you set
explicitly the usage data path to $HOME/ . discagnt/ using option -d. The .discagnt folder
under the home directory may need to be created if it does not exist.

This will allow the scanner to take usage information from the same location it usually uses
when run via the normal agent.
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Upgrading the Agent

Upgrading a Windows Agent

When a Windows (x86) agent is upgraded the following occurs:

® a copy of the new MSI agent media file is uploaded to the remote computer

¢ the old agent is uninstalled

¢ the new agent is installed

Any problems with initiating the upgrade sequence can be seen from the log available in:
Device Manager > Diagnosis > Scan Log

Once the upgrade has been successfully started, it can still fail on the remote computer. If
anything goes wrong during this uninstall/install process, the detailed error information is
saved into the log file ovedagentinstaller.log located in the agent's program directory. This file
can be used to diagnose problems with the upgrade.

Upgrading a UNIX Agent

When a UNIX agent is upgraded the following happens:

e The file Agents\bin\agentupgrade. sh located under the DDM Inventory program
directory is getting uploaded to the remote computer to the agent's program directory
together the appropriate agent's live media . tar.z file.

e agentupgrade.sh is started on the remote computer, giving the name of the new
.tar.Z media file.

e The agent upgrade script makes an assumption that a few standard UNIX commands are
available in PATH: uname, which, uncompress/gzip, nohup, etc. The script should be
reviewed and amended as necessary to accommodate the actual UNIX environment.

Upgrade Procedure

1 To upgrade the agent on a single device:

a Open the Device Manager for the required device (for example by using the Find
command on the front page of the web UI)

b Click the Update Model icon at the top.
¢ Select Upgrade Agent from the drop-down box and click the Update button.

2 To upgrade the agent on all devices in a device group, configure the Agent configuration
profile to include agent upgrade:

a Click Administration > Discovery Configuration > Configuration Profiles.
b  Click the Agent tab.

¢ Click the name of the profile assigned to this device group.

d Make sure that Allow Agent Communication is selected.

e Select Allow Agent Upgrade, and specify the schedule that you want.
f  Click Save and Close.
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3 Activate the configuration changes.

If the agent upgrade attempt failed to start the agent installation, a detailed progress log is
available in the following place:

Device Manager> Diagnosis> Scan Log

Uninstalling the Agent

>»

As automatic deployment is only supported on Windows, automatic agent uninstall is only
available on Windows too.

UNIX scanners must be uninstalled manually or via a scripted uninstall applicable to the
environment.

To uninstall an agent on a Windows system

1 To uninstall the agent on a single device:

¢ Open the Device Manager for the required device (for example by using the Find
command on the front page of the web UI).

¢ (lick on the Diagnosis panel, go to the Discovery Configuration section and check the
value for the Agent deployment property. The value should be None or Uninstall in order
to be able to execute the next step.

¢ (Click the Update Model icon at the top.
e Select Uninstall Agent from the drop-down box and click the Update button.

2 To uninstall the agent on all devices in a device group, configure the Agent configuration
profile assigned to this device group to include agent uninstall:

a Click Administration > Discovery Configuration > Configuration Profiles.
b  Click the Agent tab.

¢ Click the name of the profile assigned to this device group.

d Make sure that Allow Agent Communication is selected.

e From the Agent deployment list, select Uninstall.

f  Click Save and Close.

e Activate the configuration changes.

If the agent uninstall attempt failed to start the agent installation, a detailed progress log is
available in the following place:

Device Manager> Diagnosis> Agent Log

Even when the agent uninstall was launched successfully on the remote computer, it can still
fail because of external factors, such as files being locked on the computer, etc. To troubleshoot
agent uninstall problems the log file ovedagentinstaller.log located in the agent's program
directory can be used.

Uninstalling a Mac OS X Agent

Mac OS X agents must be uninstalled manually.
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To uninstall a Mac OS X agent

To uninstall the agent on a single device by using the GUI:

1 Use the Finder to select the correct System Disc.

2 Navigate to Library > Startupltems.

3 Select the DiscoveryAgent folder and move it to the Trash.

) Users need local system rights (computer password) to be able to delete the
DiscoveryAgent folder.

4  Reboot the system.

Software Utilization

DDM Inventory agents include a plug-in that allows collection of the software utilization data.
If software utilization capability was purchased and enabled in the DDM Inventory license, it
can be enabled both globally and on a per device group basis. The device group property
applies to data collection, and the global one applies to the data processing.

e The global setting is available in Administration > System Configuration > Scan processing >
Process utilization data.

e The device group setting is available in the Agent configuration profile under
Administration > Discovery Configuration > Configuration Profiles. Select the Collect utilization
data option.

) There is a predefined Agent profile called <Collect utilization data> which has the
Collect utilization data property selected. Just apply this to your device group.

¢ The time period for which the software utilization is collected (31, 90 or 365 days) is
configured in the Administration > System Configuration > Agent communication > Utilization
period setting.

In Enterprise Mode, the utilization period is automatically transferred to the managed
device by the DDM Inventory agent. In Manual Mode (only software utilization portion of
the agent is installed), the agent media is generated automatically with the correct
software utilization period embedded.

) Only the agent media files for the current version of the product are updated with
the correct utilization period. Any other files in the LiveAgents directory (for
example, from previous releases) are not updated.

Once utilization data is enabled in both places, the agent is instructed to collect utilization
data. It launches its software utilization plug-in that constantly monitors the processes that
are running on the computer and collects software utilization information. The plug-in stores
its data in the Perf subdirectory of the agent data directory. There is a separate file for each
day as well as the summarized version named discusg.cxu which contains the aggregated
utilization information.
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When the inventory of a computer is performed, the scanner collects a copy of the discusg.cxu
file and stores its content in the scan file in a special stored file called Software Utilization
Data. While processing the scan file, the XML Enricher, the Viewer and the Analysis

Workbench make use of this special stored file to extract and process software utilization
data.

You can import this data into AssetCenter to assist in tracking license compliance.
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Agent Communication Configuration

When you installed DDM Inventory, you set up some Agent configuration profiles as part of
your initial configuration (see the Installation and Initial Setup Guide for more details). If you
choose to, you can change how the DDM Inventory server communicates with the Agents on

your network computers.

To start configuring your Agent Communication settings:

1 Click Administration > System Configuration > Agent communication.

2 Change the settings as necessary.

Table 1 Description of the Settings

Setting

Description

Agent Deployment Method

This option determines how you want to
deploy Agents to your network devices.

Agent Deployment Command for Custom
Deployment

Agent Deployment Command For Custom
deployment allows you to specify the full
filename of your own custom Agent
deployment process.

Agent Deployment Retry Interval

Agent Deployment Retry Interval
determines how often DDM Inventory will
attempt to send the Agent to a network
device.

Agent Deployment Concurrent Sessions

Agent Deployment Concurrent Sessions
determines how many Agents DDM
Inventory can deploy at any one time. This
controls how fast you want Agent rollout to
occur.

Agent Deployment Device Types

Agent Deployment Device Types determines
the types of devices to which DDM Inventory
will try to send Agents.

Agent Communication Concurrent Sessions

Agent Communication Concurrent Sessions
determines how many Agents DDM
Inventory Server can communicate with at
any one time.

Agent Communication Reserved Sessions

Agent Communication Reserved Sessions
determines how many Agent sessions will be
reserved for manual operations, such as
debugging or testing.

Utilization Period

This option determines how long DDM
Inventory will keep utilization data.

Allow Downgrade Agent Version

This option allows you to downgrade your
Agent version. You can downgrade your
Agent version in situations where you have
distributed new Agents that cannot work in
your network.

Agent Communication Configuration

87



88

Table 1 Description of the Settings

Setting

Description

Agent Port

This option determines which port DDM
Inventory will use to communicate with the
Agent. You can select 2738 or 7738 (the later
of which is registered with IANA).

Agent Call Home

If you have enabled the Agent Call Home
option, these options specify the DDM
Inventory server names or IP addresses to be
used by the Agent to call the DDM Inventory
server.

Agent Versions

Also on this screen, you can manually change
the version of the Agent you want to use for
running different Operating Systems.

3 Click Change.
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11 Scanner Generator

After defining requirements, the next step in an IT asset inventory is to collect data. This is
accomplished by using the DDM Inventory Scanner Generator to generate scanners and then
by running the generated scanners.

The scanner is configured and generated in the Scanner Generator according to the
specifications determined in the planning stage of the inventory. Then the scanner is run
across the computer population to collect inventory data, either automatically using the
scheduling mechanism (Enterprise Mode) or manually (Manual Deployment Mode).

The Scanner Generator is used to both configure and define the level of information to be
collected. One or more scanner executable programs with the desired configuration are then
generated and subsequently run across a computer population.

Configuration file

Fixed Scanner

Enterprise Output
Mode file
Manual
Deployment
Configured
Scanner __»| Scanner Scan files
Generator Executable XSF,DSF —
Customize Run on
Scanner computer

Scanners can collect four different types of information and can be configured to collect any or
all of them. See Information Scanners Can Collect. The details recorded for each computer
within each main category depend on the options and settings selected when the scanner is
generated and the configuration of the computer.

The Scanner Generator also provides a set of options for controlling the behavior of the
scanner as it scans each computer, under both normal and exceptional conditions (such as
when an error occurs).

Scan File Formats

The information collected from each computer can be stored in two formats:

e Compressed XML (XSF) - with the file extension .xsf
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e Delta Scan File (DSF) - with the extension .dsf

) In Desktop Inventory 7.x, the .xsf extension was known as .xml.gz. The file format is the
same.

The information collected in these scan files can be viewed and analyzed.

XSF Scan File

The compressed XML scan file format (.xsf) allows the scan data to be augmented with
application recognition information. The uncompressed XML data inside these scan files is
compressed using gzip compression. The files can be uncompressed using gzip, WinZip, or any
other program that supports gzip decompression.

Further information about the XSF format can be found in XML Enricher on page 169.

DSF Scan File

Instead of sending a full scan file to a server after every scan, the scanners can calculate the
difference (the ‘delta’) between the last full scan and the current one and transfer just this in
Delta Scan File format (DSF). This can dramatically reduce the network bandwidth used
when using DDM Inventory. Delta Scan files cannot be viewed in the analysis tools (Analysis
Workbench and Viewer).

Components of a Scanner

A scanner consists of two files:
* The scanner executable file
This file is an executable file. It contains the constant parts of the scanner:
e strings
e data files
e the scanner executable code
® The scanner configuration file

The configuration file is a compressed XML file containing the settings for the scanner
you are currently configuring.

When the scanners are used in Enterprise Mode, they read the configuration from a
separate configuration file. This is a binary file with a . cxz extension. The typical size of
the configuration file is about 3K. As the size of the configuration file is significantly
smaller than the size of the complete scanner, a separate scanner configuration is useful
for repetitive inventory collection when the configuration of the scanner has been altered.
In this case, only a small configuration file is delivered to the user’s computer to run with
the original scanner instead of delivering the entire new scanner.

Self-Contained Scanner Executable
When used in Manual Deployment Mode, the Scanner Generator generates self-contained

scanner executables that consist of a combination of the scanner executable and configuration
file.
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Information Scanners Can Collect

The four types of information collected are:

e Hardware and Configuration Information on page 93
e Software Information on page 93

e User or Asset Information on page 94

e Software Utilization on page 94

Hardware and Configuration Information

Hardware information is detected automatically. The scanners collect and store from 100 to
1500 hardware items for a computer depending on the type and manageability options
available on the computer.

The Scanner Generator allows a subset of the hardware collection to be disabled. Normally
this is not required but may be desirable to decrease scan file size or scan time.

The hardware details that can be defined and recorded by the scanner include the following:
e The processor type and BIOS details.

¢ The memory size and configuration details.

e The computer bus type and details of the attached cards.

e The hard disk drive specifications (including the total size and free space).

e The network type and ID (if applicable). This hardware item cannot be disabled in
Enterprise Mode.

e Comprehensive detection of network settings, including detection of multiple network
adapters, TCP/IP settings, gateways, DNS servers, subnet masks, DHCP status.

e The monitor and video display adapter details.

¢ The type of keyboard and mouse driver installed and details of the I/O ports.

e The version and other details of the Operating System the computer is running under.
e The expansion (or adapter) cards detected.

e The hardware data information from System Management BIOS (SMBIOS).

Further Information

For a comprehensive list of hardware data the scanners can collect, see Help > Data Collected
by the Scanners.

Software Information

Software information is scanned automatically, and consists of detailed information about the
files and directories on the drives scanned. The information collected about files can be
defined (including the file types and the level of information collected). It is possible to define
the drives that are to be scanned based on either the media or format of the drive, or to use
the targeted scanning option to scan just a set of directories. Specific files can be collected
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(that is, stored in the scan file) for further analysis or for error recovery purposes. It is also
possible to configure the level of file detail stored in the scan file and filters can be set up that
specify directories or files to be included or excluded from being stored.

User or Asset Information

User or asset information consists of configurable fields that can be collected automatically. It
usually includes the asset number which is used to uniquely identify each computer. On
subsequent inventories, the asset information entered during the initial inventory can
optionally be re-used. Asset data fields are automatically populated from the data extracted
from text files, the Windows registry and environment variables.

Software Utilization

If you have a Utilization license, DDM Inventory can gather information about the software
that is being used on the machines in your network. This is referred to as Software Utilization
and the information collected can be used to optimize software license cost, for example by
eliminating unused or under-utilized software installations.

From a software recognition perspective, any files that are Unknown and are shown to have a
high Utilization should be marked for teaching.

Software utilization data shows the number of days that an application was used (as a
percentage) over a period of time. This period of time is known as the ‘Utilization Period’

As a guideline the Utilization Periods are as follows:
e Month (31 days)

® Quarter (90 days)

* Year (365 days)

Starting Scanner Generator

To start the Scanner Generator

Log into the DDM Inventory Web UI and select Server > Scanner generator.

The Scanner Generator opens.

Exiting Scanner Generator

To exit the Scanner Generator
e Kither click Cancel
e Or click the close icon in the top right of the window.

A message appears, informing you that you are now exiting the Scanner Generator.
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Scanner Generator User Interface

Navigation between Pages

You can navigate between the different pages of the Scanner Generator using the following
buttons:

Table 1 Buttons in the Scanner Generator pages

Button Function

Next Move to the following page after the settings on the page
reflect your requirements.

Back Return to a previous page to edit your previous settings.

Generate Execute the final action of the Scanner Generator. For Manual

Deployment Mode, self-contained scanner executables are
generated. For Enterprise Mode, a scanner configuration file is
sent to the DDM Inventory server.

Finish The Generate button changes to a Finish button after the
scanners have been successfully generated. Click this button to
exit from the Scanner Generator when you have finished.

Cancel Cancel the execution of the Scanner Generator completely.

Help Obtain help for the tab pages you are currently on.

Scanner Generator Pages

The Scanner Generator is composed of a succession of pages. Each of these pages displays
information or requires user input, such as selection of options or entry of data items.

There are two scenarios in which the scanners can be used. This is determined on the first
page of the Scanner Generator. Depending on which of these scenarios you select, different tab
pages are displayed.

e Enterprise Mode
e  Manual Deployment Mode

Scanner Generator 25



Scenario Page

On starting the Scanner Generator, the Scenario page appears. You will need to determine if
you want to carry out an automatic inventory using the DDM Inventory agents or manually
deploy the scanners.

## Scanner Generator - Server Mi=] E3

Scenario v
Choose the method that will be used to implement the F
inventory.

Select the scenario in which the scanner will be used. Click Hext to
continue.

i@ Enterprize Mode

Thi= default option should be used to automatically collect an inventory
using the scheduling and launching capabilities of HP Discovery and
Dependency Mapping Inventory.

In this mode, several options will be preconfigured to facilitate
seamless scanner integration. Some of these options will be greyed
out to indicate that they cannot be changed.

i_) Manual Deployment Mode
Choose this option if HP Discovery and Dependency Mapping Inventory

will not be used to schedule the scans, for example if the scans will be
launched from login scripts or non-networked machines.

Help Hext =~ Cancel

To select the method used to implement the inventory select one of the following options:

®* Enterprise Mode

This is the default option. Use this option to automatically collect an inventory using
scheduling and launching on the DDM Inventory Server.

In this mode, several options in the Scanner Generator have been preconfigured to
facilitate the integration between the scanners and the DDM Inventory Server. Some of
these options will be greyed out to indicate they cannot be changed.

®* Manual Deployment Mode

Use this option if the DDM Inventory Server will not be used to schedule and launch
scans. For example, chose this option if the scans will be launched from login scripts or on
non-networked machines.
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Standard Configuration Page

This page is used to select a preset configuration for the scanners. It is a starting point only
and the settings can be amended as required.

Use this page to select a default scanner setup or to select a previously stored setup.

¥ Scanner Generator - Server _ O] =]
Standard Configuration ¥
What kind of scanner do you want to create ? F

Select a default scanner setup or load a previoushy stored setup, and then
click Hext.

Default Setting=s:
)] Inventory Scan

i_! Shallow Scan
i Detailed Scan

|:| Enable scanning of Java class files

Stored Settings:
i_! Read From Server: |<default- -
i_! Read From File: Browse...
Help < Back Hext =~ Cancel

To select the type of scanner to create

1 You can do one of the following:
Under Default Settings, select a default scanner setup.
®* |nventory Scan

Uses default configuration setting for the scanner. Defines a set of options suitable for a
general inventory. Enough software information is collected to allow comprehensive
inventory analysis. All hardware information is collected and a standard series of asset
data fields are defined

e  Shallow Scan

Defines a set of options to allow very quick scans. Because hardware scanning is very fast,
most hardware items (as some are disabled by default) are collected, but limited software
scanning takes place and the data collected is not sufficient to perform reliable software
license recognition.

° Detailed Scan
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If scanning time is not a critical factor, the Detailed Scan option can be used to collect the
maximum amount of information. This, however, extends the scanning time significantly.
Use this option in special cases only.

If you select Inventory Scan or Detailed Scan, you can choose to Enable scanning of Java class
files. This setting deals with Java scanning. Enabling this setting does the following:

— Java .class files will be stored in the scan file
— Java specific environment variables for targeted scanning will be enabled.

— Windows scanner will add the location of the Java Home directory to the list of
directories for a targeted scan.

Or alternatively, under Stored Settings, select a previously stored setup.
e Read From Server

Reads the settings from a previous Enterprise Mode configuration stored on the server.
The drop down combo box shows the list of previously configured scanner configurations.
The names displayed with angle brackets around them (for example, <default>) are
predefined configurations. It is possible to read predefined configuration settings, but it is
not possible to overwrite them when generating the new configuration. If you have chosen
a predefined configuration, you will have to rename it when you come to the last page of
the Scanner Generator in order to save it to the server. If you save this configuration, it
will be available from the server with the other previous configurations.

Refer to the “Scanner Profiles“section under the “System Defined Configuration Profiles”
section in the “Configuring the Discovery Process” chapter in the Installation and Initial
Setup Guide to see how you can create and edit existing scanner configurations on the
DDM Inventory Server.

e Read From File

Replaces various configuration settings by reading information from files on the local
machine. It can read parameters from previously generated scanners, scanner
configuration files (. cxz), and scan files (. xsf). When the file name is provided, the
scanner generator determines the type of the file based on the file extension, which
eliminates the need to have a separate entry for each.

Click Next to continue to the Collection page.
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Collection Page

The Collection page is used to select the type of computer data to collect.

ﬂ Scanner Generator - Server M=] E3

Collection g
What data do you want to collect? P

Check the options below, and press Hext to continue.

Software Data

Select this option to scan and store information abouwut files and
directories on the maching or acces=sible to users of the machine.

Asset Data
Select this option to collect asset data automaticalhy.

Help < Back Hext >~ Cancel

When carrying out initial scanner deployments you might want to use hardware and asset
data collection to establish basic information for the target machine. This can be followed up
later by a more comprehensive scan that includes software data.

Selecting Type of Data to Be Collected

The selections you make on this page determine which of the data detail pages will be
displayed.

To select the type of data to be collected:

1

Scanner Generator

Select from the following options as required:

Hardware

Includes details of the processor, memory configuration, computer bus, attached cards,
hard disks, attached drives, monitor, video adapter, keyboard, mouse, OS version, network
protocols and addresses.
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See Hardware Data Page on page 100.
) For Enterprise Mode, this option is always selected and cannot be disabled.

e Software Data

Consists of detailed information about files and directories on all scanned drives. The
information collected about files can be defined (including the file types inventoried and
the level of information collected). It is possible to define which drives are to be scanned,
based on either the media or format of the drive, as well as determine which files are
included in the scan file and which are ignored.

See Software Data Page on page 106.

® Asset Data
Asset data consists of asset fields that can be collected automatically.
See Asset Data Page on page 128

2 Click Next to view specific data settings for each of the options.

Hardware Data Page

The Hardware Data page displays a subset of the hardware categories the scanner can collect. It
is used to disable specific hardware detection routines.

Normally all hardware options are selected. Routines only need to be removed if there is a
known problem scanning these hardware items. The hardware options have equivalent
command line options that can be used at run-time.

Further Information

¢ You can find more information about scanner command line options in the section entitled
“Command Line Options and Switches” in the Scanners chapter of the Reference Guide.
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¢ For a comprehensive list of hardware data the scanners can collect, see Help > Data
Collected by the Scanners.

Subset of
hardware
categories

Checked -
detection is
enabled

Unchecked -
detection is
disabled

Hardware Data
Uncheck any item=s to remove from hardware

detection

BIOS Information
BIOS extensions
SMBIOS
Plug'n'Play

CPU Identification

Menmory
Swap File Data

Operating System
|:| Device Driver Data

Cluster Data
Services

Yirtual Machines
Profiles

[4]

Il [ ]

Help

# Scanner Generator - Server M=l E3

O]

De=scription
BIOS Information

Scans the BIOS for information on
the model 1D, manufacturer, etc

< Back Hext > Cancel

The left side of the Hardware Data page shows a subset of the hardware categories detected by
the scanner. The right side of this page is a Support panel which shows a description of each
hardware item (displayed as the mouse pointer passes over each item in the list box). By
default, most categories are selected. This indicates that the hardware detection routine for
that particular category is enabled.

) The only hardware options which are unchecked by default are Device Driver Data and Installed
Applications (WMI). This is the default because both detections take a long time to perform. You
can enable the detection of these hardware categories by selecting them to take advantage of
the automatic device driver detection and collection of information about installed
applications (software features) from WMI.

Disabling Specific Hardware Detection Routines

You can disable the hardware detection routines for specific categories. All other hardware
detection will take place as usual.
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To disable specific hardware detection routines:

1 Clear the check box next to that particular category to remove it from hardware detection.

2 Click Next to continue.

Hardware Categories

Table 2

Hardware categories

Options

Description

BIOS information

Collects information about the computer BIOS, including the
computers asset tag, the BIOS date, ID, manufacturer and
revision (where applicable).

BIOS extensions

Detects installed BIOS extensions, such as video or SCSI
BIOS.

SMBIOS

Collects hardware data from System Management BIOS.

Plug’'n’Play

Provides details of whether the BIOS installed on the
computer is Plug and Play compatible. If the BIOS supports
Plug and Play specification, the version of the specification is
collected.

CPU Identification

Identifies the CPU (model), establishes if it has got FPU
(numeric coprocessor), MMX (MultiMedia eXtensions) and
ISSE/SSIMD capability and reports the speed of the CPU,
cache characteristics.

For newer Intel and compatible processors, the manufacturer,
model, family and stepping ID are reported.

Memory

Detects the total amount of memory installed on the computer,
including the amount of conventional and extended memory.

Swap File data

Collects data about swap files used for virtual memory.

Operating System

Collects information about the operating system and its
configuration.

Device Driver Data

When this option is enabled, the Windows scanner enumerates
all devices to determine which files are used as device drivers.
Each file in this list is given the ‘Device Driver’ attribute when
stored in the scan file.

The device driver option is now disabled by default to increase
speed of the hardware scanning.

Cluster Data Collects information about Windows Server Cluster
membership. It detects that the machine is part of a cluster,
the name and description of the cluster and the list of nodes
connected to the cluster.

Services Collects information about installed operating system services.
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Table 2

Hardware categories

Options

Description

Virtual Machines

Detects whether the scanner is running in VMware, Virtual
PC, or Terminal Services.

From an asset management point of view, it is important to be
able to determine which scanned machines are virtual (for
example, so you don’t pay too much maintenance for too many
machines).

Profiles

Collects data about user profiles.

Installed
Applications

Collects data about installed applications that are registered
with the operating system. On Windows (pre-Vista), it collects
data as displayed by the Add/Remove programs item in the
Control Panel. On Windows Vista, it collects data as displayed
by the Programs and Features item in the Control Panel. On
UNIX, it collects data from the system’s software package
manager.

Installed
Applications (File
Data)

Collects information about the relationship between installed
applications (packages) and the files that belong to them.
When this option is set, it causes the scanner to interrogate
the native operating system package manager to retrieve the
relationship information. This ensures that the installed
application rule-based recognition can correctly recognize the
files as belonging to the installed package/application.

Installed
Applications
(WMI)

Collects the information about installed applications from
WMI as stored in the Win32_SoftwareFeature class.

The Win32_SoftwareFeature WMI class is not available on the
Windows 2003 Server by default. The WMI provider that supports
this class is an optional component on Windows 2003 Server, and it is
not installed by default. To enable this WMI provider, you must go to
Control Panel > Add Remote Programs > Add/Remove Windows
Components > Management and Monitoring Tools > WMI Windows
Installer Provider and install the WMI Windows Installer Provider
component. Once this component is installed, the data collected by
Installed Applications (WMI) hardware detection becomes available.

Containers

Collects data about containers available in the operating
system. Currently, this is only supported by the Solaris
scanner, which can collect information about Solaris zones.

Video

Records details of the Video Display Adapter, which include
the adapter type (EGA, XGA, VGA and so on) and model/
manufacturer, where possible.

In Windows the current desktop resolution and number of
colors are also picked up.

DDC Data

When connected to a VESA DDC compliant monitor, collects
full monitor information.

I/O Ports

Detects and reports on the number of serial and parallel ports,
the I/O address for each, and for serial ports, the UARTSs
attached.
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Table 2 Hardware categories

Options Description
SCSI/ASPI Checks for the presence of an ASPI (Advanced SCSI
Detection Programming Interface) driver for a SCSI adapter. If the

driver is available, the host SCSI adapter name is reported.

SCSI/IDE/ATAPI Detects installed devices, such as hard drives, CD-ROMSs, tape
devices drives and other such devices. Also detects Serial ATA disks.

SCSI/IDE/ATAPI Detects serial numbers of the installed devices (where

serial numbers available). Also detects the serial number of Serial ATA disks.
Network Detects the network configuration, including Logon Name,
Information Workgroup Name, Machine ID, and Domain Name.

Detects information such as multiple network adapters,
gateways, DNS servers, subnet masks, DHCP status.

Information about installed network protocols (TCP/IP,
NetBIOS/NetBEUI, IPX/SPX) and network addresses is also
provided.

Note: In Enterprise Mode, it is possible to disable subsets of
network information. However, you should not disable ALL
network information.

TCP/TP Collects information about an installed TCP/IP protocol. This
information includes domain, DNS Servers, Node type,
NetBIOS Scope ID, WINS proxy status, NetBIOS resolution
status.

Network adapter information (including description, IP
address, IP routing status, subnet mask, default gateways,
DHCP status, DNS suffix, autoconfiguration status) is also
provided.

IPX/SPX Collects information about the IPX/SPX protocol.

NetBIOS/NetBeui | Collects information about the NetBIOS or NetBEUI protocol.

Shared Devices Collects information about shared devices, such as disks and
printers.

Keyboard & Mouse | Reports on the type of keyboard attached (extended or
normal); whether a mouse is connected and mouse driver is
loaded; the mouse brand and version of the driver, number of
buttons and type of connection (serial, PS/2, bus).

Disk Drives Collects advanced information about all attached disk drives.
This information includes the type of the drive (floppy disk,
hard disk, CD-ROM, network), the type of the file system (FAT,
NTFS, HPFS), amount of total and free space, location of the
hard drive partitions on the physical hard disk and so on.
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Table 2

Hardware categories

Options Description
Local USB Hard Controls the way USB hard drives are treated. If checked
Drives (default setting), the USB hard drives are treated as local hard

drives, and their size is counted towards the total and free
space on the local hard drives, which is recorded in the
hwDiskTotalFreeMB and hwDiskTotalSizeMB hardware
fields. If the option is unchecked, the USB hard drives are
treated as removable drives, and their size will not be counted
towards the total size. Also, by default, the USB hard drives
will not be scanned during a “classic” local hard drive scan.
However, you can enable scanning by checking the Software
Details > Drives > Removable Drives > Other removable drives
check box. This option is currently only applicable to the
Windows scanner.

Bus Detection

Detects the architecture of the bus used in the PC — ISA, EISA,
PCI, MCA, or PCMCIA.

EISA Detects and reports details of EISA cards.

MCA Detects and reports details of MCA cards.

PCI Detects and reports details of PCI cards.

PCMCIA Detects and reports details of PCMCIA cards.

ISA PnP Cards Detects and reports details of ISA Plug and Play cards.

USB Data Detects and reports details of the USB host adapters, hubs and

devices attached to them.

If the bus types checked for by the scanner are not available, the tests for checking
the cards will not be performed.

Peripherals Checks for installed peripherals, such as printers, modems and
sound cards.

UNIX system Collects UNIX, Linux, and Mac OS X configuration

configuration information.
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Software Data Page

The Software Data page is used to select the software scanning method. The choice of scan
method determines how extensive the software scan will be.

ﬂ Scanner Generator - Server _ O] x|

A

Software Data
Which scan method should be used?

Displays the
Directories,
File Scanning,
and Stored
Files tabs

Select software scanning mode, and then click Hext

i@ Targeted Directory Scan

Select this option for optimum scanning speed and software licence
accuracy. Only directories pointed to by Windows shortecuts or

Dlsplays the present inthe PATH are scanned.

Drives. File

Scanning, ) Classic Local Drive Scan
;I,lld Stoied Select this option to perform a complete =can of all local
iles tabs non-removable drives. This option takeg =lightly longer to complete
and =hould be used when performing a detailed scan.
Displays all——— (7 Combined Scan

of the above

tab Select this option to do both of the above: scan all local hard disk
abs

drives as well as directories on the network pointed to by shortcuts
or PATH.

Allow scanner command line to override this selection

Help < Back Hext > Cancel

Selecting a Preset Software Scanning Mode

Three preset modes are available in this page of the Scanner Generator. Depending on which
of these modes you select, different sets of tab pages will be displayed when you click Next.
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Each of the tab pages are described in the next section, even though you might not see all of
them depending on the choice you make on this tab page.

Table 3 Preset software scanning modes

Scanning Mode Tab Pages Displayed

Targeted Directory Scan Directories
File Scanning
Stored Files

Classic Local Drive Scan Drives

File Scanning
Stored Files

Combined Scan Drives
Directories
File Scanning
Stored Files

Under most circumstances, the default settings (which are determined by the presets chosen
on the Standard Configuration page) are satisfactory for defining the software information
collected, but the Scanner Generator allows the default options to be modified to create
custom settings.

To select a preset software scanning mode, select one of the following:

®* Targeted Directory Scan

Select this option for optimum scanning speed and software license accuracy. Only
selected locations are scanned, which are identified by the scanner from various sources,
such as Windows shortcuts, Services, file associations, environment variables, and so on.
The tab pages shown when you click Next are:

¢ Directories
¢ File Scanning
e Stored Files
e (Classic Local Drive Scan

Select this option to perform a complete scan of all local non-removable drives. This option
takes longer to complete and is used when performing a detailed scan. The tab pages
shown when you click Next are:

¢ Drives
¢ File Scanning
e Stored Files

e Combined Scan

Select this option to do both of the previous options: scan all local hard drives as well as
directories on the network pointed to by shortcuts, file associations and environment
variables, such as PATH. The tab pages shown when you click Next are:

e Drives

e Directories
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¢ File Scanning

e Stored Files

Enabling the Command Line Override Option

The Allow Command Line Override option is available for overriding the drive selection
configured in the Scanner Generator.

If you select this check box, the default drive selection specified can be overridden by
specifying a list of drive letters or directories to scan on the command line using the —paths
command line option.

An example of a command line override is:
Scanwin32-x86 -paths:C:\Windows -paths:D:

If you clear this check box, you cannot change the scan selection by specifying drive letters
and/or paths on the command line.

Further Information

You can find more information about scanner command line options in the section entitled
“Command Line Options and Switches” in the Scanners chapter of the Reference Guide.
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Drives Tab

The Drives tab page is used to define which of the drives are to be scanned when using either
Classic Local Drive Scan or Combined Scan.

-ﬂ' Scanner Generator - Server M=l E3
Software Details ¥
Which files and directories do you want to scan F

and store?

l/ Drives |/ Directories r File Scanning rﬁtured Files |

Select a =et of drives to scan.
Local Drives
Remowvable Drives:
[ ] ¢D and DVD Drives
|:| Floppy Drives
[ ] other Removable Drives
Miscellaneous Drives:
[ ] Hetwork Drives
[ ] SUBST Drives
Other Drives

Help < Back Hext =~ Cancel

Selecting Type of Drive to Scan

Options are provided for scanning all drives or just a particular type of drive.

To select the type of drive to scan, check the appropriate check boxes as required:

® Local Drives

These are hard disk drives visible and mounted by the current operating system. In
Windows, normal hard disk drives are assigned drive letters by the operating system and
are usually included in the scanning process.

® Removable Drives
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Removable drives are drives with non fixed media that can be removed or exchanged.
Removable drives are normally not included for scanning.

Table 4 Removable drives

Drive Selection Description

CD and DVD Drives Scans the contents of CD and DVD drives.

Floppy Drives Scans floppy drives.
Other Removable Scans other removable drives (for example,
Drives SyQuest drives).

Scanning removable media is not usually
recommended, as the content of these drives
vary depending on the media currently in the
drive.

® Miscellaneous Drives

These drives are any drives that do not fall into any of the previous categories, and may or
may not have local physical media associated with them.

Table 5 Miscellaneous drives

Drive Selection Description

Network Drives Scans network drives. Note that network
drives can be scanned by multiple computers.

Use this option with caution.

SUBST Drives Scans ‘virtual’ drives created using the
operating system substitute command -
SUBST. This is not normally desirable as a
substituted drive can be scanned using both
its true drive letter and substituted letter.

Use this option with caution.

Other Drives Scans drives created using other devices
drives (for example, RAM drives). Note that
scanning drives created using device drivers
can lead to false reporting of files on a
computer.

Use this option with caution.

Directories Tab

The Directories tab is used to specify which directories you want to scan when using Targeted
Scan or Combined Scan.

The settings allow you to specify the directories you want to add to the list of directories to
scan. For Windows Operating Systems, you also have the ability to scan desktop and Start
menu shortcuts.
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By scanning only selected directories rather than complete drives, software scanning is made
faster.

ﬂ Scanner Generator - Server M=] E3

Software Details ,
Which files and directories do you want to scan
and store?

| Drives | Directories |/File Scanning rﬁtured Files |

Directories from shortcuts (Windows only)

Start Menu Desktop

Only use shortcuts to files with these extensions:
|exe;cum;hat;cmd;ucu;dll |m

Directories from other sources

Windows Services File As=sociations

[ ] Java Home Software Utilization

Hon-Global Zone Root Directories Program Files/Applications
Packaged File Data

Directories from environment

Include directories from these environment variables:

IPATH;LIBPATH =]

Shortcuts to excluded drives
Scan excluded drives

Help < Back Hext > Cancel

Selecting Directories to Scan

To select the directories to scan, select the options as required:

® Directories from Windows shortcuts (Windows only) group
e Start menu

This option will scan the directories that are pointed to by shortcuts on the Start
menu.

® Desktop
This option will scan the directories that are pointed to by shortcuts on the desktop.
®  Only use shortcuts to files with these extensions

When checked, only shortcuts that point to files with one of the extensions specified
will be scanned.

® Directories from other sources group

e Windows services
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Check this box to include directories containing Windows Services for targeted
scanning. As the name implies, this option applies to Windows scanners only.

File associations

Check this box if you want the scanners to add directories containing applications that
are associated with various file types (for example NotePad for . txt files) to the list of
directories for a targeted scan. This option applies to Windows scanners only.

Java Home

Check this box if you want the scanners to add the Java Home directory to the list of
directories for a targeted scan. This option applies to Windows scanners only.

) If you checked the Enable scanning of Java class files on the Standard Configuration page,
this option is selected by default.

Software utilization

This setting instructs the scanner to include any directories from where used
programs are executed. These directories will be included in the list of directories for a
targeted scan. This ensures that the scanner collects the file data required for
recognition of used applications. This option applies to all scanners.

Non-global zone root directories

Check this box if you want the scanners to add the Solaris non-global (local) zone root
directories to the list of directories for a targeted scan. This ensures that all
directories used by non-global zones are scanned during the software scanning
process. This option applies to Solaris scanners only.

Program Files/Applications

Check this box if you want the scanners to add the standard location for program files
to the list of directories for a targeted scan. On Windows, it is the Program Files
directory, which is normally located in the root of the Windows system drive (such as
C:\Program Files). On Mac OS X, it is the /Applications directory where the
applications are installed by default.

Installed Applications

Check this box if you want to make sure that the directories where installed
applications are located are added to the list of directories to be scanned. For this
option to work, the Installed Applications (File Data) option must be enabled on the
Hardware Data Page.

® Directories from environment group

The paths included in the environment variables specified here will also be added to list to
scan if you enable this check box. If multiple environment variables are supplied, their
names must be separated by a semicolon (;).

® Shortcuts to the network/Used programs launched from the network

This option is available for Targeted Directory Scans only

Scan network drives

When checked, this option forces all directories pointed to by shortcuts to be scanned.
The scanners may scan directories on network volumes. This is particularly useful
when scanning for software licenses as the scanner will detect files that are part of a
network install that is accessible from the machine.
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If unchecked, the directories that are located on the drives that are excluded by the
drive selection on the Drives and Drive Selection tabs will not be scanned. Usually
shortcuts to network drives or network directories from which used programs were
executed will not be scanned.

® Shortcuts to excluded drives
This option is available for Combined scans only.
e Scan excluded drives

When checked, this option forces all directories pointed to by shortcuts to be scanned.
If unchecked, the directories that are located on the drives that are excluded by the
drive selection on the Drives and Drive Selection tabs will not be scanned.

When this option is checked, the scanners may scan directories on network volumes.
This is particularly useful when scanning for software licenses as the scanner will
detect files that are part of a network install that is accessible from the machine.

Although the Directories tab page allows you to specify the file systems and directories (known
to the Scanner Generator) that you want to include or exclude during scanning, you can
override the settings of the file systems and specific directories and files during software
scanning by using the content in the override files. How to add content to the override files is
explained in the section on Troubleshooting Tab on page 158.

File Scanning Tab

Scanner Generator

The File Scanning tab is used to specify the level of detail for the information collected about
files and directories and the methods used to check and identify files.

This tab page contains three sub tabs:
¢ Files to Scan Sub Tab

e File Identification Sub Tab

¢ File Information to Store Sub Tab
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Files to Scan Sub Tab

The Files to Scan sub tab is used to specify how much information is collected about files and
the checking processes used.

ﬂ Scanner Generator - Server _ O] x|

Software Details

Which files and directories do you want to scan
and store?

r Drives |/ Directories |/File Scanning rﬁtured Files |

O]

Collect File Data
[ Filesto Scan | File Identification | File Information to Store |
File: Attributes Size Range (KE) Add...
#er RHS - —
Edit...
Remove
Move Up
Move Down
{T_"I Ignore
ol Signature
Help < Back Hext > Cancel

Using the options on this page, it is possible to define which files get signatured based on
criteria such as file extension, attributes or size.

Files to Scan List Box

The File to Scan list box displays the checking methods used for processing files. You can build
up a prioritized list of filters which specify a sequence of checking processes to be used.
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The checking processes are denoted by the following icons:
Table 6 Icons in the Files to Scan List Box

Icon Meaning

Ignore the specified type of file.

In this case, Ignore means do not open the file. Its name, size and
attributes may be still picked up in the scan file.

7 Collect file signatures for the specified type of file. A signature is a
checksum of the first 8 KB of the file.

e New filters can be added by clicking Add. See Specifying Information Collected about Files
and Checking Methods Used on page 116.

e Filters can be edited by double-clicking on them or by selecting them and clicking Edit.

e Filters can be reordered by clicking on the row and dragging it up or down to its new
location or by clicking Move Up and Move Down.

Timing Considerations

Only files that have signatures enabled are opened and are available for further processing. If
a copy of the file name is all that is required, use the following command.

Ignore *.*

The file name, size and attributes may still be picked up in the scan file but no signatures will
be calculated. Scanning time will be greatly reduced but because less data is collected,
application recognition accuracy may be adversely affected.

File Signatures

The signature is an ISO checksum (CRC) of the first 8KB of the file. To calculate the
signature, the scanner opens the file and reads the first 8KB from it. Collecting signatures
helps to establish the file’s identity. Two different files rarely have the same signature.
Signatures are used by the software recognition in analysis tools to improve software
application recognition. Also, only those fields for which signatures were collected can
optionally be identified by the scanner (see File Identification Sub Tab on page 119).

Importance of the Order of Process Selections

The order in which process selections occur is important. For example, use Ignore first before
making Signature process selections.

This ensures that the Ignore items are processed first before a file needs to be opened. It may
be necessary to ignore certain files, the content of which is constantly changing.

Examples of files to ignore because of changing content are files that are normally used as
swap files (386part.par, pagefile.sys, swapper.dat, win386.swp) or files that contain volumes of
compressed drives, such as, DriveSpace, DoubleSpace or Stacker (Dblspace.0??, Drvspace.0??,
Stackvol?.sys).
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Specitying Information Collected about Files and Checking Methods Used

A scanner configured using the Scanner Generator scans selected files on the drives or in the
directories selected.

To specify the information collected about files and the checking methods used:

1

In the Files to Scan sub tab, select the Collect File Data check box. This option activates the
controls on this tab page.

2 Click Add. The Select files to process dialog box opens.

3

Select Files to Process

File Hame:|

Action

i) Signature i) Ignore

Attributes Size Range (KB)

Read Only || Limit Processing by File Size

Hidden Minimum Size (KB E
System Maximum Size (KB):

Cancel

In the File Name box, specify the relevant wildcard file type to process.

For example, *.tmp means all files with tmp extension. Multiple specifications, separated
with semicolons, are also accepted.

In the Action group box select one of the following options:

Signature
Collect file signatures for the specified type of file.
Ignore

Ignore the type of file specified in the File Name box.

In the Attributes group box, select from the following options as required:

Read Only

Files with the read-only attribute are capable of being displayed, but not modified or
deleted.

Hidden

Files with the hidden attribute are not normally visible to users. For example, hidden
files are not listed when you execute the DOS DIR command. However, most file
management utilities allow you to view hidden files.

System
Files with the System attribute.

In general, if a given attribute is not selected, the entry having the attribute will not
match, even if the file name does.
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6 In the Size Range (Kb) group, if required, select the Limit Processing by File Size check box
and specify the maximum and minimum file sizes. Only files within this size range will be

processed.

7 Click OK.

File Action Options - Example

File

'f!T_',TI *.trnp

'ﬂTﬂl JBEpart. par;pagefile. syzswapper.datwin 386, swp

'i'_TL’I Dblzpace. 077, Drvspace. 077 Stackyvol Y sys

m‘::! #

The entries in the file list box mean:

Attributes
RHS
RHS
RHS
RHS

Size Range ...

1 Ignore (do not open) any files (including read-only, hidden or system) with a . tmp

extension.

Select Files to Process |

File Hame:|*.tmp

Action
)] Signature

Attributes Size Range (KB}

i Ignore

Read Onhy |:| Limit Processing by File Size

Hidden
System

Help

Minimum Size (KB):

Maximum Size (KBj:

2 Ignore the following files, including files with read-only, hidden and system attributes:

— Files that are normally used as swap files:

— 386part.par
— pagefile.sys
— swapper.dat

— win386.swp
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Select Files to Process -

File Hame:|385part.par;pagefile.sys;swapper.dat;WiHSEE.SWp

Action

) Signature )] Ignore
Attributes Size Range (KB)

Read Only |:| Limit Processing by File Size

Hidden Minimum Size [(KE):
System Maximum Size (KB):

Cancel

3 Ignore the following files, including files with read-only, hidden and system attributes:

Files that contain volumes of compressed drives, such as DriveSpace, DoubleSpace or
Stacker.

— Dblspace.0??
— Drvspace.0??

— Stackvol?.sys

Select Files to Process

File Hame:|DbIspan:e.IZI??;Drvspace.ﬂ??;Stackml?.sys|

Action
o] Signature )] Ignore

Attributes Size Range (KB)

Read Only |:| Limit Processing by File Size

Hidden Minimum Size (KB):
System Maximum Size (KB):

Cancel

4 Calculate file signatures for all files, including files with read-only, hidden and system
attributes.
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Select Files to Process

File Hame:l*.*

Action

)] Signature ) lgnore

Attributes Size Range (KB)

Read Only [ | Limit Processing by File Size
Hidden Minimum 5ize (KB):

System Maximum Size (KB):

Cancel

File Identification Sub Tab

The File Identification sub tab page is used to determine whether the scanner will identify files
based on their content.

-ﬂ' Scanner Generator - Server Hi=] E3

Software Details ¥
Which files and directories do you want to scan
and store?

r Drives |/ Directories r File Scanning rﬁtured Files |

Collect File Data

[ Files to Scan | File Identification | File Information to Store |

Identify File Type

Process Archives as Subdirectories
Process Archives inside GZIP Files

Collect Internal File Identification

ELF Prelinking Aware

Preserve Last Access File Date

Help = Back Hext = Cancel
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Specitying Whether the Scanner Will Identify Files Based on their Content

To specify whether the scanner will identify files based on their contents:

1 Ensure that the Collect File Data check box is selected. This option activates the controls on
this tab page.

2 Select the options as required:
* Identify File Type

Instructs the scanner to check every file that was selected for signatures to identify all
executable and archive files. The scanner can identify LZH, LHA, ZIP, ARJ, ARC and
PAK archives. Selecting this check box will enable two further options:

— Process Archives as Subdirectories

Treats archive files as subdirectories and lists the files included in each archive (it
does not extract information from within these files). If this check box is not
selected, archive files are not scanned for embedded files and directories.

A further option is made available:
— Process Archives inside GZIP files

This option enables the handling of archives located in gzip files (such as . tar.gz
files). These are tar archives that were compressed using gzip. Checking this
option will instruct the scanner to process such archives.

— Collect Internal File Identification

Collects internal file information included in the executable file, for example,
version data and legal copyright.

— EIf Prelinking

During software scanning, this option instructs the scanner to check if an
executable file has been pre-linked by the ELF Prelinking Utility (prelink). The
ELF Prelink Utility is used to speed uploading times of ELF shared libraries and
executables by modifying them to reduce the number of the reallocations the
dynamic linker needs to do to load them in memory. If this option is enabled, the
scanner will calculate the size and signature of the file before it was pre-linked.
This is useful for accurate application recognition since the file size and signature
are used to perform application matching. However, enabling this option does
produce extra overhead during the scan as the scanner needs to run the prelink
utility to obtain the original executable file. The prelinked file is not modified by
the scanning process; the original file is only reconstructed temporarily in order to
collect the size and signature. This is for Linux platforms only.

® Preserve Last Access File Date

Collects the Last Accessed time stamp for files (where available). The support for the
Last Accessed time stamp varies depending on the Operating System and file system
used.

When this setting is used on Unix computers, although the last access time will be
preserved, the ct ime of the file gets changed. For this reason we recommend that you
do not use this setting on Linux, Mac OS X or Unix computers.

) When this option is enabled, the XML Enricher can make use of this feature to accurately
estimate the time when recognized applications were last executed.
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File Information to Store Sub Tab

The File Information to Store sub tab is used to define what file details to store in the scan file.

ﬂ Scanner Generator - Server M=l E3

Software Details ¥
Which files and directories do you want to scan
and store?

( Orives r Directories rFiIe Scanning rstured Files |

Collect File Data

[ Files to Scan | File Identification | File Information to Store

i) By default, tore information on... Do not store empty di...
i By default, dizcard information ...

StoreDiscard FilesTir Criteria Add...
Dizcard Dir Marme contains... -
Dizcard Diir Marme cortsins... Edit...
Dizcard Dir Marme contains...

Remove
Dizcard Dir Marme contains... -
Dizcard Diir Mame contains... Move Up
Store File Exeiitr; Match...
Move Down

Help < Back Hext = Cancel

Adding, Editing or Removing File Filter Storage Criteria

The three options at the top of the page set the default to either:

e By default, store information on all files - If selected, and no other options are specified, then
information about all files is stored in the scan file.

e By default, discard information on all files - If selected, and no other options are specified,
then no file data at all is stored in the scan file.

¢ Do not store empty directories - This option is selected by default. When checked, the
scanner discards information about directories that have no files in them. This can
include directories that may have files in them, but you have set up the scanner not to
scan for these particular types of file.

In addition to the default settings, you can define a prioritized list of filters, in a manner
similar to that of the File to Scan page.

Each filter can specify directories or files to be included or excluded from being stored. Each
file and directory entry found during scanning is looked up in the list, and the first matching
entry determines whether the entry is stored or not.

e  Multiple filter criteria can be specified on each line if they are separated by a semicolon.
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e Entries can be edited by double-clicking on them.

¢ The sequence and priority of an entry can be reordered by clicking on the row and
dragging it up or down to its new location. This can also be achieved by using the Move Up
and Move Down buttons.

To add, edit or remove file filter storage criteria:

e To add another filter criteria, click Add...

e To edit an existing filter criteria, click Edit... or double-click on the entry.
e To remove an existing filter criteria, click Remove.

" The options chosen here can dramatically affect both scanning speed and scan file size. Under
normal circumstances, the default options are adequate.

If you clicked Add or Edit, the Select Files to Process dialog box appears.

Select Files to Process

Storage

i) Store

i Digcard

Type

W) Files

i_! Files Inside Archives

o Directories

Options

|:| Identified as Executable
Has UHIX or Mac Executable Attribute
|:| Identified as Archives

|:| Scanned (i.e., Hot Ignored)

Matches Wildcard Mask(s): * EXE
[v] M

OK Cancel

This dialog box has three types (shown in the Type group box):
e Files
¢ Files Inside Archives

e Directories

Including or Excluding Files Based on File Name or Scanned Attributes

Follow this procedure if you selected the Files Type in the Select Files to Process dialog box.
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To include or exclude files based on the file name or scanned aftributes:

1

Choose one of the options Store or Discard from the Storage group box. This determines
whether a matching file is stored in the scan file, or discarded. Discarded entries are not
available for analysis.

Select the Files option in the Type group box.
Check the Matches wildcard mask(s) option.

Specify a list of wild cards separated by a semicolon (;). For example, when scanning of
Java class files is enabled (see Standard Configuration Page on page 97), the entry to
include *.class files inside archives is added to the default configuration. This causes the
scanner to only store the information about files with the .class extension found inside
of archives.

Files can also be stored or discarded based on attributes not known until the file has been
scanned. Select from the following in the Options group box:

Identified as executable

Files that are identified as any kind of executable (that is, not just . exe and . com files). If
Identify file type is not checked this has no effect.

Has Unix or Mac executable attribute

UNIX allows three different levels of access to a file for three different categories of users:
owner, group and other.

Table 7 UNIX levels of access

Level Description

Read View the file or directory without making changes.
Write Make changes to the file or directory

Execute Execute the file or list files in a directory.

Checking this option causes the scanner to store or discard files that have executable file
access in any of the user categories (namely, owner, group or other.)

Identified as archives

Files that are identified as compressed, such as .ZIP, .LZH. If Identify file type is not
checked this has no effect.

® Scanned (i.e. not Ignored)
Includes all files that are not ignored on the File Scanning page.
® Matches wildcard mask(s)

Includes files that match the wildcards specified here.

Explanation of the Operation

All file check box options specified are OR-ed together, that is, the entry is considered a match
if any of the selected entries match.

The order and content of these options can affect scanning speed and function significantly. If
the default is Discard, and a Store - Identified as executable entry is included, all files have to
be scanned before the scanner can determine if they are to be discarded.
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Including or Excluding Files Based on Files Inside Archives

Follow this procedure if you selected the Files Inside Archives Type in the Select Files to Process
dialog box.

To include or exclude files based on the files inside archives:

1 Choose one of the options Store or Discard from the Storage group box. This determines
whether a matching file inside an archive is stored in the scan file, or discarded.
Discarded entries are not available for analysis.

2  Select the Files Inside Archives option in the Type group box.
Check the Matches wildcard mask(s) option.

4 Specify a list of wildcards separated by a semicolon (;). Files discarded in this way are not
scanned either, and a wildcard filter can speed up the scanning process.

Including or Excluding Files Based on Directory

Follow this procedure if you selected the Directories type in the Select Files to Process dialog
box.

To include or exclude files based on the directory:

1 Choose one of the options Store or Discard. This determines whether a matching directory
is stored in the scan file, or discarded. Discarded entries are not available for analysis.

2  Select the Directories option in the Type group box.
3 Select from the following in the Options group box:
e Named

If this option is selected, the directory name specified in the entry field must match
100% (however, it is not case-sensitive) in order for a match to be established. The
directory name must begin with a path separator to match any entries, but must not
include a drive letter. The root directory \ or / cannot be excluded in this way.

®  Where name contains

If this option is selected, the name specified in the entry field is a partial string; any
directory containing this string in its name is considered a match. Typical examples of
entries would be:

\Private would match any directory where a directory starts with Private.
Temporary which would match any directory with Temporary anywhere in the name.
¢ Include subdirectories

For either of the directory options, there is an option to include subdirectories of
matching entries as well. This is particularly useful for discarding entire directory
trees, such as recycle folders, temporary Internet files and private directories.

Explanation of the Operation

The contents of filtered directories are not stored in the scan file. If the Do not store empty
directories (page 121) option is checked, filtered directories are considered to be empty and
are not stored in the scan file either. If this option is unchecked, the filtered directories are

represented in the Directories and Files tab of the Viewer application by a no entry icon =l

124 Chapfer 117



Directories are filtered prior to scanning (that is, directories that will not be stored are not
scanned at all). Consequently, directory filters may speed up scanning.

Stored Files Tab

The Stored Files tab is used to allow specific files to be collected and stored (embedded) in the
scan file created for each computer scanned. The types of files usually collected are system
configuration files. These files can be viewed in Viewer or exported from Analysis Workbench.

If a targeted directory scan selection was made earlier and does not include a specific

directory in which a stored file may be found (including the root directory), then any required
stored file must be specifically defined here with the full path.

#F Scanner Generator - Server [_ (O] x|

Software Details

Which files and directories do you want to scan

and store ?

Q]

r DOrives |/ Directories |/File Scanning rﬁtured Files

Store Specific Files
File Mame ta Stare Found Where

Tztak et Directory —
[ galN)s] et Directory
hosts et Directory
inetd .conf et Directory =
inittak et Directory
prafile et Directory
BT I Ay Root [ |
COMFIG 555 Ay Root
= ] Ay Root
LOWEFFIChE ini Arywehiere —
A ITEEYET™ BT A e aebiors bl
Only store files smaller than 100 ‘T{ KB Clear List

Help < Back Hext = Cancel

The dialog box shows a list with two columns:

e TFile Name to Store Column

e  Found Where Column

File Name to Store Column

This column displays a default list of system files. The name of the files can include wildcard
characters unless a specific directory is used.
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For example, collecting the Config.sys file for each computer scanned across a population
provides a snapshot of the system configuration for each computer. This enables the analysis
and consolidation of system configuration across the computer population.

Other commonly collected files are Net.cfg, Profile.ini, AutoExec.Bat, Win.ini,
System. ini and Boot.ini.

The one DDM Inventory specific file included in the list is the override file, which is named
override.ini on Windows systems and .override.ini on UNIX/Mac OS X systems. This
is an ASCII file used by the scanner at run-time to store a list of files to be ignored (that is not
opened at run-time). See Directories Tab on page 110.

Enabling the Controls on the Stored Files Page

To enable the controls on the Stored Files page:

Select the Store Specific Files check box to enable the controls on this page.

Adding another File to the List of Files Stored

To add another file to the list of files stored:

1 Enter a file name at the bottom of the File Name to Store column (or overwrite an existing
entry).

2 Select an option from the drop-down list in the Found Where column.

Deleting a File From the File Name to Store Column

To delete a file from the File Name to Store column:

1 Highlight the file name.

2 Press the Delete key or right-click on the entry and select the Delete option from the
shortcut menu.

Clearing Entire List of Files to Be Stored

To clear the entire list of files to be stored:

1 Click Clear List. A confirmation message is displayed.

2 Click Yes to clear the list.

Limiting Size of Files to Be Stored

To limit the size of files to be stored:

1 Select the Only store files smaller than option.

2 In the Kb box, use the arrows to select a value for the upper size limit or type the value
directly into the edit box.

Not restricting the size of files collected could result in very large scan files when large files
are collected and stored.
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Found Where Column

This column shows the location where the files to be stored can be found.

Changing the Directories that Are Scanned fo Locate Files

To change the directories that are scanned to locate the files

1 Click on an entry in the Found Where column.

2 Change the setting by selecting an option from the drop-down list.

Table 8 Options for changing directories that are scanned to locate files

Setting Description

Any Root Only stores the file if it is found in a root directory.
Directory

Root of Boot Drive | Only stores the file if it is found in the root of the boot drive.
Anywhere Store the file wherever it is located.

/etc directory

Only stores the file if it is found in the Unix /etc directory.

/var directory

Only stores the file if it is found in the Unix /var directory.

Specific directory

A specific copy of the file is collected irrespective of whether it is
included in the software scan or not.

For example, the list of specific stored files could be configured to be:

C:\Documents\config.txt
Z:\net.ini

/etc/fstab

In this case, the scanner will store the config.txt file from the C: drive
(when scanning PCs), the net.ini on the Z: drive (if it is available, and
only on PCs) and a file named fstab in the /etc directory (when scanning
UNIX machines).

) Files will only be stored if the directory where the file is located is included in the software
scan, unless the specific directory is specified.
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Asset Data Page

The Asset Data page is used to define and set up the asset data collected by the scanners.

The Asset Data page has two tabs:
e Asset Data Tab - Used to define which asset data is to be collected automatically.

e Asset Number Tab - Used to specify the source for the Asset Number (Manual
Deployment Mode only)

After the asset data settings have been configured, click Next to continue.

Asset Data Tab

The Asset Data tab is used to configure customized asset information as each computer is

scanned.
## Scanner Generator - Server _ O] =

Asset Data 8
Which asset fields should be automatically collected ? F

l/ Azzet Data r Azzet Humber

B X
Caption Field Field Type
E Aszet Humber from file Autarmstic 1 Text File Extract
As=zet Tag Azset Tagy SEUenCe
& Description Dezcription Combinstion Field
Help < Back Hext =~ Cancel

A default list of entries is displayed initially. These can be modified to create a custom list of
entries.

@ The Asset Data tab will help the scanner find specific asset information that is available on
the scanned device. To include other information about the user, you can use the Asset
Questionnaire through the web user interface. Log into your DDM Inventory server, and click
Administration > Asset Questionnaire to configure the fields you want in your questionnaire.
See the Installation and Initial Setup Guide for more information.
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Asset Data Form Layout

The Asset Data form is made up of a number of rows and three columns. Each row in the form
is used to define a piece of asset data and results in one item being collected during the

inventory.

The form is built up by using the combination of up to 23 predefined standard fields, 30
user-defined fields and 56 automatic fields.

Asset Data Form Toolbar

A toolbar is displayed at the top of the Asset Data form. The buttons have the following

functions:
Table 9 Asset data form toolbar
Button Function Shortcut
Create a new field Ctrl+N
2 The Choose Field dialog box appears.
Delete field None
Delete all fields None
Clear all the entries in the Asset Data form. A confirmation
message is displayed before the entries are cleared.
— Edit the type and settings for field Ctrl+T

LE

The Asset field configuration dialog box appears, which allows you
to edit the information for the field.

These functions are also available by using a right-click menu.

To further configure the field, double-click on the row or click the Edit button to bring up
the Asset Field Configuration dialog box.
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Asset Field Configuration Dialog Box

This dialog box is where the major part of the asset field configuration takes place.

Asset Field Configuration

Caption: |.ﬂ.sset Murmber from file |

Field: Automatic 1 Choose...

Max Width: SDE

Field Data Type
Calculated Fields:
i Environment Yariable Extract

o Registry Extract

(®) Text File Extract

() WMI Extract Field
Derived Fields:

) Sequence

) Combination Field

) 05/5can Field

Field Parameters

Parameters: COASSET BAT, SET ASSETMO= Change...

Help Extract... OK Cancel

Setting up a New Asset Field

Each row in the form has three columns. Each of these columns must be configured for a new
asset field.

The following table shows the steps that are required in setting up a new asset field and the
pages they are described on:

Table 10 Steps for setting up a new asset field

Step | Title

Set up a caption

Choose a standard field

1
2
3 Specify the maximum width in characters for the fields
4 Choose the field data type
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Table 10 Steps for setting up a new asset field

Step | Title

6 Set up field parameters
7 Set up extract options for calculated fields
8 Correct the order of the fields in the form

Step 1: Setting up a Caption
This text caption is used to identify each data input item (Scanner Generator truncates the
prompt at 22 characters).
To change the caption, change the entry in the Caption field.

The text entered here will be displayed in the analysis tools (Analysis Workbench and
Viewer).

Step 2: Choosing a Standard Field

To make the task of entering data as simple as possible, and to avoid discrepancies due to
typing and naming conventions, the Scanner Generator provides several predefined standard
field types with automatic validation controls.

The standard asset fields indicate to which hardware field the asset field will be mapped. For
example, if you choose Employee ID as the standard field, the data contained in this field will
be mapped to the Employee ID field, while allowing you to customize the prompt displayed
on-screen (for example, by translating it to French).

There are two special standard fields that you need to understand before proceeding with this
step.
Description Field

The Description field is represented by the |#] icon and can be configured to contain a brief
description of the computer. This field is normally read-only and by default is configured to be
of type Combination. It combines information from several hardware and asset fields.

When loading data from scans into the analysis tools (Analysis Workbench and Viewer), the
contents of the description field are displayed for each scan file to help identify them.
Asset Tag Field

The Asset Tag field is represented by the icon. It contains a unique identifier for the
machine. It is normally populated from a sequence of hardware fields such as MAC Address,
Serial Number or Asset tag.

The asset number entered in this field is usually used to name the scan file the scan results
are recorded to.

If you have not configured an asset tag field and the Asset Number Source is set to Asset Field,
you will not be allowed to proceed to the next page and a warning will appear.

) It is strongly recommended that Description and Asset Tag fields are included in your list of
asset fields.
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To choose a standard field:

1 Click the icon.

2 The Choose Field dialog box is displayed, showing all standard fields not currently in use.

Choo=e Field

From the list below, choose the standard field to use in the Asset Questionnaire

D Ear Cocle

[ Building

D Business Unit

D Cellphone Mumber
D Cost Center

D Department

D Device Type

D Divizion
D Employves ID
D First Mame

D Floor

[ et

F

-

Field De=scription

r:cur machines with bar codes on them, use thiz field to allowe the bar code to be entered |i|

oK

Cancel

3 Choose a new standard field from the list.

These fields are legacy fields left from previous releases of DDM Inventory when it was

possible to enter the asset data manually in the scanners.

In this version of the software,

the scanners do not have such ability. Instead this kind of manual data entry can be done

using the new web-based asset questionnaire.
Table 11 Standard fields

Field mapped to in the
Field Description hwAssetData table
Asset Tag The Asset Tag field contains a unique hwAssetTag

identifier for the machine.

These asset data fields can be
automatically populated from data
extracted from text files, the Windows
registry or environment variables.

Automatic
Asset Fields

You can configure up to 56 automatic
fields, which can then be used in the
calculation of derived or calculated fields.

hwAssetAutomaticl. .56

Bar Code For machines with bar codes on them, use
this field to allow the bar code to be

entered or stored

hwAssetBarCode
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Table 11 Standard fields

Field

Description

Field mapped to in the
hwAssetData table

Building

Identified the building containing the
machine

hwAssetBuilding

Business Unit

Name of business unit

hwAssetBusinessUnit

Cellphone Cell/Mobile phone number of user. hwAssetCellphoneNumber

Number

Cost Center Cost center description or code hwAssetCostCenter

Device Type Device type of the machine (Server, hwAssetDeviceType
Notebook, Tower and so on)

Division Division description or code hwAssetDivision

Employee ID Employee ID as used in the organization. | hwAssetEmployeeID

Floor The floor on which the machine is located | hwAssetFloor

Full Name Full name of user hwAssetFul 1Name

Job Title Job title of user hwAssetUserJobTitle

Machine Model | Model of the machine. This data can be hwAssetMachineModel

populated from SMBIOS using a
Sequence Field on machines supporting
SMBIOS.

Printer Asset
Tag

Asset tag of a local printer attached to the
machine, if any

hwAssetPrinterAssetTag

Printer Contains a description of a local printer | hwAssetPrinterDescription
Description attached to the machine, if any
Room Description, name or number of the room | hwAssetRoom
containing the machine
Section Section description or code hwAssetSection
Telephone Full direct telephone number of user hwAssetTelephoneNumber
Number
User Field These are user-defined fields. hwAssetUserFieldl. .30

You can configure up to 30 User fields.

4 Click OK to return to the Asset Data form.

Step 3: Specifying Maximum Number of Characters for Field

To specify the maximum number of characters for the field:

Enter a numeric value in the Max. width in characters field.
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Step 4: Choosing Field Data Type

The asset data fields are automatically populated. The data is either calculated or derived.
The data can be extracted from text files, the Windows registry, environment variables and
WMI fields. All data entry fields can be given a default value.

To chose the field data type:

In the Asset field configuration dialog box, choose a standard field type from the Field data type
list.

The following table describes the types of fields and whether they are derived or calculated.

Calculated Fields

These asset data fields can be automatically populated from data extracted from text files, the
Windows registry, environment variables and so on.

Table 12 Calculated fields

Field Description

Environment Variable Accepts data from a specified environment variable set in the
Extract operating system.

Text File Extract Extracts information from a single line in a named text file.

This field type is normally used for the Asset Number field. This
is used to extract the asset number from the file Asset.bat on the
line containing the text:

SET ASSETNO=

Other useful file extracts include the predefined SMS, which
extracts the SMS Unique Machine ID.

Registry Extract This field type extracts its value from the Windows registry. The
Data field must contain a valid registry key name to extract
from, for example:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\T
imeZoneInformation\StandardName

WMI Extract This field type allows you to extract and store pieces of data on
Windows available through the WMI interface. The Windows
scanner will populate this field (if set up) on systems where WMI
is enabled.
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Derived Fields

Derived fields are those that have dependencies on the data of other types of fields. In other
words, the data they contain is derived from other fields.

Table 13 Derived fields

Field

Description

Sequence

The Sequence field allows you to define a sequence of up to
ten asset or hardware fields. Each of these fields returns a
value depending on the machine or environment running.

The value returned as the result of the sequence field will
be the first of these fields which contains a non-blank
value.

0OS/Scan

Allows a single field to collect different information for
different operating systems. For example, you may want to
extract information from a registry on Windows and from a
file on UNIX.

For each scanner platform a separate asset field could be
defined.

Combination

The Combination field uses a substitution string to replace
occurrences of %1, %2 and so on. placeholders with the
actual values of hardware or asset fields. An example of a
Combination field can be found in the Description field of
the default Asset Data tab.

Up to five fields can be combined into one.

Step 5: Setting Field Parameters

Field parameters need to be set for the following types of fields:

Table 14 Field types

Field Reference
Sequence page 135
Environment Variable Extract page 137
Text File Extract page 137
Registry Extract page 139
0OS/Scan page 140
Combination page 141
WMI Extract page 142

Setting up a Sequence Field

The sequence field is used to test multiple entries from hardware and asset fields. The entries
are tested until a non-empty value is found, This can be modified so that certain values can be

ignored so that the test fails.
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The sequence field can be used to select the desired element of a hardware field that can have
multiple values. For example, when trying to identify the MAC address on a machine, fake
MAC addresses of PPP adapters etc. can be filtered out by specifying them in the Ignore
Strings option.

The sequence asset field allows up to ten asset or hardware fields to be specified. Each of
these fields return a value depending on the machine or environment running.

The value returned as the result of the sequence field, will be the first of these fields which
contains a non-blank value. If all values are blank, then the user can be allowed to type a
manual entry instead.

A blank field can be defined based on either of the two following criteria:

¢ The string matches one of a set of ‘ignore’ strings.

e A field is considered blank if the length of the field is shorter than the number specified.
To set up a sequence field:

1 After you have selected a Sequence field as the data field type, click Change.

Define Sequence Asset Field

Field Sequence

Field Mame: =3 Harchwvare Data
| & 3 asset Data
|| & CJ Bi0s Data
o [ Bus Data

“| = 3 crU Data

| & A visk data
:| & [ keyhoard and Mouse data

Ignore Strings

Matching: Shorter Than:

| 0

Cancel

2 In the Define Sequence Asset Field dialog box, select the field type by expanding the tree on
the right side and clicking on the required field.

The entry will now be displayed in the Field Name list on the left side.

3 Inthe Ignore strings group box, specify the criteria for a blank field using one or all of the
following methods:

4 In the Matching box, enter a sequence of strings (case-sensitive) separated by semicolons.

If the content of the field matches (is equal to) any of the strings specified here, the field is
considered to be blank. For example, if the text string Not Found is entered here, then a
field that has the value ‘Not Found’ is considered to be blank.

Multiple entries must be separated by semicolons ( ;), for example:
‘Unknown; Not Tested’

5 You can type a string in the form: *STRING*
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Here the asterisks (*) are ignored and any string that contains the text between the two
asterisks will be ignored too.

6  Specify ignore strings that are less than ‘n’ characters.

In the Shorter than box, use the arrow keys or type in a number to specify the maximum
length of text strings that are to be used to define a blank field (between 1 and 255). If the
string is shorter than the specified number, then the field will be considered blank.

7  Click OK to return to the Asset Field configuration dialog box.

Setting up Environment Field Parameters

This field is set up to read the value contained in an operating system’s environment string.
For example, you may have the Host Name, or SMS ID stored in an environment variable and
want this to be automatically picked up by the scanner.

To set up environment field parameters:

1 After you have selected an Environment Variable Extract as the data field type, click
Change.

Prompt

Enter the name of an environment variable
"TEMP |

Help 0K Cancel

2 Enter the name of the environment variable in the Prompt dialog box. Examples of
environment variables are TEMP or PATH.

3 Click OK to return to the Asset Field configuration dialog box.

Setting up Text File Extract Field Parameters

If you are using environment variables in the file path, they must be in uppercase. For
example:

SWINDIR%\SMSCFG.INI

This field searches a named text file for a defined character string and makes an automatic
entry of the characters between the search string and the end of the line.

This field type is normally used for the Asset Number field. This is used to extract the asset
number from the file Asset.bat on the line containing the text:

SET ASSETNO=
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To set up the Text File Extract field parameters:

1 After you have selected a Text File Extract field as the data field type, click Change.

File Extract Parameters

File Hame: |C:'I.ﬂ-.SSET.EF.ﬂ-.T
Search: SET ASSETNO=

Help OK Cancel

2 In the File Name group enter the name of the file that the information is to be extracted
from. Type the name and path to the file in the box.

A UNC path can also be entered as the path. The format for the UNC path is:
\\servername\sharename\path\
For example:

\\DDMIServer\DDM Inventory\Asset.bat

) Entries in this field are case-sensitive. This is applicable to UNIX and Mac OS X only.

Using environment variables

You can use an environment variable in the file extract asset Other field. The environment
variable name must be in upper case for this to happen. If it is not, the string is
interpreted as a literal.

For example, if the path is

SWINDIR%\SMS.INT

Then the final path (assuming WinDir=C:\WINNT) will be
C:\WINNT\SMS. INI

But if the path is

WinDir$\SMS. INI

Then no substitution will take place and the file extract will fail. This is done to ensure
that it's possible to extract files from a directory or a file that has one or more % signs in
the name.

Another example of using an environment variable is as follows:
You can type:

$HOMES / .bashrc

or

%SYSTEMDIR®\win.ini

Then the $HOME% will be replaced with the value of the HOME environment variable.

) This is applicable to all platforms and UNIX notation of the form $NAME is not supported.
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3 Enter the Search String. This determines what information is to be extracted. Any text
that appears on the line after the search string is extracted (up to the total number of
characters set by the field width). The search string is case insensitive.

) In the file being extracted from, if a comment is on the same line as the search string, then
the comment will also be returned. In other words, white space is counted in the search
string. Ensure that any comments in the file are placed on separate lines from the search
string. This is particularly relevant to UNIX users.

4 Click OK to return to the Asset Field configuration dialog box.

Setting up Registry Extract Field Parameters

This type of field searches the Windows registry for the defined key and makes an automatic
entry of the key value. This extract field is applicable to Windows only.

To set up registry extract field parameters:

1 After you have selected a Registry Extract field as the data field type, click Change.

B

Enter the name of an environment variable

|HHE“r’_CLIRRENT_LISEH'I.CnntrDI PanelDesktoptScreenSaveActive |

Help OK Cancel

2 Type the full path to the registry value you want to have in this field in the form
RegistryKey\ Value.

For example, to find out whether the Screen Saver is active on the system, you can use the
following registry extract field:

HKEY_CURRENT_USER\Control Panel\Desktop\ScreenSaveActive

) The registry does not allow the backslash ("\") character in the RegistryKey. However, it can
be used in Value. If the backslash character is contained in the Value name, it must be
escaped. For example, if Value is "a\b", it must be specified as follows:

HKEY_ LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\ED\7.60\\a\b

In Windows, the paths to various registry values can be found by viewing the content in
the Registry Editor. For more information about the Registry Editor refer to the
documentation supplied with Windows.

3 Click OK to return to the Asset Field configuration dialog box.

@ Do not change any of the settings in the Registry Editor. Doing this could result in lost
registry settings and may cause some of your applications to fail.

Extracting the Registry (Default) Value

Sometimes, you may want to extract the (Default) value for a registry entry.
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The following screen image shows the regedit screen with the (Default) value:

" Registry Editor

File Edit “iew Favaortes Help

EID Hewlett-Packard ;I Marne | Tupe | Data
Ell:l ED [Default) REG_SZ  [walue not zet]
=44 7.E0 B ackupDir REG_52 C:ADocuments and Settingzhall Uzers
{1 Agent Commmuri Branding REG_SZ ED

{0 Analysis Workbe BuildNurnber REG_SZ 9243
~{ Apache CornmonDir REG_SZ  C:\Program FileshHewlett-PackardyD
:g iﬂfﬁenticamr KnowledgeDir  REG_SZ  C:\Program Files\Hewlett- Packard\D
53 Branding LogsDir REG_S5Z C:ADocuments and SettingshAll Users
PackagezDir REG_S5Z C:A\Program FileshHewlett-PackardiD

77 Di A {
g Discoveny Ergy || ERPatchNumber  REG 52 000

{2 Logger R estareDir REG_52 C:ADocuments and Settingzhall Uzers
-] ovedSHMPage: RootDir REG_5Z  C:AProgram Files\Hewlett-PackandsD
{7 Pelib ServicesDir REG_S5Z  C:AProgram FileshHewlett-PackardyD
-2 58l Update TernpDir REG_S5Z  C:A\Documents and Settingshal Users
-7 Scheduler LItilitiezCrir REG_S5Z  C:\Program FileshHewlett-PackardD
[T Snzbamn b anibar h
o | 2]
|My Computert HKEY_LOCAL MACHIMENSOFT'AARENH ewlett-PackardtEDY 7. ED o

To extract the (Default) value from the registry:
End the registry extract value command in a backslash.
For example, to extract the (Default) value of "7.60," the following key will be used:

"HKEY_LOCAL_MACHINE\ SOFTWARE\Hewlett-Packard\ED\7.60\"

Setting Up OS/Scan Field Parameters

The 0S/Scan fields allow the definition of multiple types of data sources to provide an
automatic entry depending on the scanner used and the operating system being scanned.

This type of asset field is very useful in situations when you want to scan multiple operating
systems but want to collect the same piece of information for each from different sources.

For example, the data can be extracted from the registry on Windows or from a file on UNIX
and Mac OS X.

To set up OS/Scan fields:

1 After you have selected an OS/Scan field as the data field type, click Change. The Define
Multi-OS Asset Entry Field dialog box appears.

2 In the Operating System list select the operating system that will be affected by this
definition.

3 Select the field that is to be included in this definition from the Field Chooser tree. This
can be any existing asset field or any hardware/configuration field (except hardware fields
where multiple values may be collected, such as CPU type or IP address).

4 Click Add. The new definition will be included in the Fields referred to list.
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The Field Index column has a drop-down list which refers to the line numbers in the Fields
referred to list.

Setting up a Combination Field

Combination fields can combine up to five asset or hardware fields into a single field. This is
particularly useful for the description field.

The combination field is made up by string substitution.

To set up a combination field:

1

After you have selected a Combination field as the data field type, click Change.

Define Asset Combination

Master Substitution String: Fields:

£ [T Hardware Data

o= [ Azzet Data

o= ] BICS Data

o= |j Eus Data

o= [ CPU Data

o= 7] Dizk dats

o |j Hevyvhoard and Mouse data
o= |j Memory Data

Definitions:

Figld Matme

oK

Assign a Master substitution string by typing the template string in the box. The convention
is to use percentage signs followed by a number. For example, ‘%1 (%2)

The Definitions box lists the fields that have been defined for use in the substitution string.

To add a field to the Combination field, select either the Asset or Hardware field option and
the available fields will be listed in the Definitions box.

To clear an entry select the Delete command from the right-click menu or press the Delete
key.

In the Definitions of %1 to %5 grid, build up a list of up to five index entries (represented as
%1, %2, %3, %4 and %5).

Click in a row in the grid and from the Fields tree select the asset or hardware item that is
to be associated with the index. The asset or hardware field will now appear in the Field/
Description column.

Continue this for up to five index entries.

Define a master substitution string which replaces the percent values (for example, %1)
with the appropriate hardware or asset item. An example of a master substitution string
is shown in the next section.

10 You can also specify some text before or after the percent notation which will be a constant

il
12
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part of the value of the field.
Click OK to return to the Asset Field configuration dialog box.
Click OK to return to the asset entry form.
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Example of a Master Substitution String

If the master substitution string %1 %2MHz %3Mb is defined for the Description field in the
asset entry form, where the following index definitions apply:

Table 15 Example of a Master Substitution String

Index Field/Description Display
%1 CPU Data\CPUs\CPU Type |CPU Type
%2 CPU\CPUs\CPU Speed CPU SpeedMHz
(MHz)
%3 %Vle];r)lory Data\Total memory | Total MemoryMb
M

The Description field may look as follows:

Pentium II, 333MHz, 128Mb

Setting up a WMI Extract Field

Some data on Windows operating systems is only available via the WMI interface. This type of
field allows the scanner to be configured to extract and store specific pieces of WMI data. The
Windows scanner will populate this field on computers where WMI is enabled.

Windows Management Instrumentation (WMI)

Windows Management Instrumentation (WMI) is a component of the Microsoft Windows
operating system that provides management information.

WQL

Windows Management Instrumentation Query Language (WQL) is a subset of SQL that is
used to make data queries inside WMI.

Further Information

For further information about WMI and WQL refer to the Microsoft MSDN web site.
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To set up a WMI extract field:

1

Scanner Generator

After you have selected a WMI Extract field as the data field type, click Change.

Wl Extract Parameters

Query

WL Querny: Object Path: Tineout:
I | (=
Options Output Properties

i® Collect the first instance Add...

{_) Collect all instances Remove

Separate Instance With:

Separate Property Values With:

Help OK Cancel

Enter the WQL query. For example:

select Name, CurrentClockSpeed from Win32_Processor

The above query collects the name and the frequency properties of the installed processor.
Enter the Object Path

The Object Path should usually be:

root\cimv2

This is the default path for CIM v2 data provided by WMI.

Enter the Timeout - This specifies the number of seconds to wait until the query returns a
single instance of the queried data. If no data is returned within this period, the query
will return nothing and the value of the field will be blank.

You can use -1 to wait indefinitely for the query to return data. However, this is not
recommended since it may cause the query to hang.

Enter the Output Properties

These are properties whose value is required in the asset field. The WQL query returns an
instance of the WMI class which can have many properties. The required ones need to be
specified manually.

For example:
select * from Win32_Processor

This will return all properties for processor, but if Name is required, it should be specified
in the Output Properties list box.

Specify any Options

Collect First Instance and Collect all Instances
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These options specify whether the first returned instance or all returned instances should
be used.

For example, if there are several processors in a computer you can choose to have the
information about the very first processor or have the information about all processors.

If all instances are requested, their values will be separated with the string specified in
the Separate instances with field.

When multiple properties are specified, the values returned by the query will be
separated with the string specified in the Separate property values with field.

7  Click OK to return to the Asset Field configuration dialog box.

An Example WQL Extract Field Setup
Table 16 An Example WQL Extract Field Setup

Options Entry

WQL Query select Name,CurrentClockSpeed from
Win32_Processor

Object Path: root\cimv2

Timeout 10
Properties Name, CurrentClockSpeed
Options Collect all instances

Separate Instances with ;

Separate property values with ,

When executed on a computer with 4 CPUs it produces the following output in the WMI
Extract asset field:

Intel (R) Xeon(TM) CPU 2.80GHz,2790; Intel(R) Xeon(TM) CPU 2.80GHz,2791;
Intel (R) Xeon(TM) CPU 2.80GHz,2791; Intel(R) Xeon(TM) CPU 2.80GHz,2791

If only the first instance is requested, this will be the value:

Intel (R) Xeon(TM) CPU 2.80GHz, 2790

Step 7: Setting Extract Options

All calculated asset fields defined can be set up so that only part of the string is selected
instead of the entire string. They can also be set up, for example, to use the last part rather
than the first part of the string. This can be useful for obtaining the last part of an calculated
field that is too long.

Various other settings for manipulating the field contents are also available.

To set extract options:

1 After you have selected the field data type, click Extract. The button is only enabled for
those field that are calculated. This option is not available for user-entered fields.
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The Asset Field Extract Options dialog box is displayed.

Asz=et Field Extract Options -

Extract Characters From Optiong
i Start| Skip Characters | | Convert to Upper Case

5 End U= [ ] Treat Field as a File Hame
[ ]
Default Yalue:
Help 0K Cancel

In the Extract characters from group box, specify whether you want to use the last part or
the first part of the string. Select one of the following options:

Start Uses the first part of the string. Use the arrows next to the Skip characters box to
specify how many characters are to be skipped from the beginning of the string.

End Uses the last part of the string. Use the arrows next to the Skip characters box to
specify how many characters are to be skipped from the end of the string.

For example, ABCDEF123’ If you select End and skip 4 characters, then the result will be
ABCDE.

In the Options group box, select the options as follows:

Convert to upper case Select this option to convert the alphabetic characters to upper case,
if required.

Treat field as File Name Select this option to treat the string in the asset field as a file name.

Some characters are invalid in file names, so any invalid characters can be replaced with
the character specified in the Replace invalid characters with box. For example,
underscore ‘_’ is a valid file name character and can be used to replace invalid characters.

If you select the Delete invalid characters option then any invalid characters will be deleted.

If the extracted field is empty or is not found, then a default value for the string can be
specified in the Default Value box. For example, if the text string Not Found is entered in
this box, then an empty field or a field that has not been found will be assigned this
default value.

Step 8: Correcting the Order of the Fields in the Form

You will need to consider the order of the fields in the form and move them round accordingly.
The rule is:

A field cannot depend on a field that is placed below it in the form.

Scanner Generator

That is, if you have set up any derived or automatic fields that require data from fields

below them in the form, you will have to move them to a position in the form that is above
these fields.
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To correct the order of the field in the form:

1 Re-order the fields by clicking on a row and dragging the selected line to its new location
in the form.

2  When you click Next in the Asset Data page, a confirmation message may be displayed.
Click Yes to have the Scanner Generator automatically do this for you.

4 Click No to do this manually.

Asset Number Tab

The Asset Number tab is used to set options for managing the asset number used to uniquely
identify a machine.

ﬂ Scanner Generator - Server M=l E3

Asset Data )
Which asset fields should be automatically collected ? F

Asset Data Asset Humber

Asset Humber Source

i® Asset Tag Field

i Scanner Command Line {/o switch)

Help < Back Hext = Cancel

Asset Number Definition

Each computer that is scanned needs to be identified by a unique tag known as the Asset Tag.

Asset tags are generally assigned to allow each hardware item to be recorded and identified in
an asset management tool, such as AssetCenter. The conventions used depend on the
numbering system and asset registering policies adopted by your organization. Ensure that
your asset numbers can be reconciled between DDM Inventory and AssetCenter.

In Enterprise Mode, the Asset Tag is also available for display in the Device Manager, just as
it can be used for performing a “Find”. The Asset Tag is used to identify each asset. In all
reports, the Asset Tag is used to identify each asset.
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Source for Asset Number

In Enterprise Mode the options for selecting the source for asset number source are disabled.
The source is always from the Asset tag field. This option will use the value in the Asset Tag
field that was created in the Asset Data tab page. This is usually used as the unique key to
identify each computer. When this (the default) is selected and an offsite scan file will be
saved, an Asset Tag field must be defined in the Asset Data tab.

If you chose to deploy the scanner manually in Manual Deployment Mode you will need to

configure this yourself as follows:

To specify how the Asset Tag identifying the machine is chosen:

Select one of the following to use as the source for the asset number:
®* Asset Tag Field:

This option will use the value in the Asset Tag field that was created in the Asset Data tab
page. This is usually used as the unique key to identify each computer. When this (the
default) is selected and an offsite scan file will be saved, an Asset Tag field must be
defined in the Asset Data tab.

e Scanner Command Line (/o switch):

An offsite scan file name can also be specified by the -o: command line option. This
overrides the scan file name (as well as the path, if specified).

To configure this:

Select the Scanner Command Line (/o) option. The scan file name is taken from the
command line. This is entered using the /o: command line option when the scanner is
started, using the name specified. For example,

Scanwin32-x86 -o0:FP00017

Scanner Options Page

The Scanner Options page is used to set options for controlling the behavior of the scanner
during the usual scanning process and under exception conditions, as well as options for
saving the inventory results.

The Scanner Options page has four tabs:
e Saving Tab

e Settings Tab

e Miscellaneous Tab

¢ Troubleshooting Tab

After the options have been selected as required, click Next to continue.
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Saving Tab

The Saving tab page is used to set options for saving the inventory results.

F Scanner Generator - Server E =]

Scanner Options

Where should the scan file be saved? How should the scanner

behave when running ?

1/ Saving r Settings |/ Miscellaneous r Troubleshooting

A

|:| Enable delta scan files

|:| Save result to network (off-=site)

Always create log file

only be saved when an error occurs.

Define which scan files =hould be saved, and where they should be saved.

If checked, the scanner will always create a log file. f unchecked, a log file will

Help

< Back

Hext =

Cancel

) For Enterprise Mode some of the options are pre-set to optimal values and cannot be

changed.

Saving Local and Offsite Scan Files

The scanners can save two scan files per scan:

e Local scan file - Saved to a local directory.

e Offsite scan file - Saved to a specified output directory, with its name being derived from

the value in the Asset Tag field specified as the asset number.

The saving of local scan files cannot be disabled in Enterprise Mode (the option is on and is

greyed out).

In Manual Deployment Mode both of these scan files (local and offsite) are saved by default,

however, one or the other can be disabled.

Saving Results Locally

The Save results locally option determines whether the scan file is saved to the local machine.

148

Chapter 117



The local scan file is always called local$.xsf.

The Windows scanner uses the Peregrine\Discovery subdirectory of the application data
directory of all users. The location of this directory varies. For example, on Windows XP
installed on C:\, it could be:

C:\Documents and Settings\All Users\Application Data\Peregrine\Discovery

Enabling Delta Scanning

The Enable delta scan files option enables/disables this feature. It can only be enabled if a local
scan file is saved. When delta file scanning is enabled, the scanner first saves the complete
scan file copy offsite by copying the local scan file.

Instead of sending a full scan file to a server after every scan, the scanners calculate the
difference (the delta) between the last full scan and the current one - and transfer just this
data. This can dramatically reduce the amount of network bandwidth used when using DDM
Inventory. By default delta scanning is enabled.

The XML Enricher re-assembles the full scan files based on the previous scan and the delta
scan. No other DDM Inventory component uses the delta scan file. The re-assembled scan can
however, be used in Viewer and Analysis Workbench. See the section about the “Delta
Command Line Utility” in the XML Enricher chapter of the Configuration and Customization
Guide for a description of a standalone utility that can be used to manipulate delta scan files.

Setting up the Scanner to Handle Delta Scan Files Correctly (Manual Deployment Mode
Only)

In Manual Deployment Mode for the delta scan file processing in the XML Enricher to work
correctly, ensure that you do the following:

1 Configure the scanner to save results to the XML Enricher incoming directory. This
directory can be found in the following location on the DDM Inventory Server by default:

C:\Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\Scans\incoming

Create a share on the DDM Inventory Server to share this disk and specify its UNC path
in the Save result to network (off-site) field on this page. See the next section for more
information about off-site saving.

2 Set the Path to original off-site scan files to the Original directory. This directory can
be found in the following place by default:

C:\Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\Scans\original

Create a share for this directory and specify its UNC location in the Path to original
off-site scan files: field to do this. The format for the UNC path is:

\\Servername\ShareName\path\
For example:

\\DDMIServer\Inventory\Scans\

Saving Results to Network (Offsite)

The Save result to network (off-site) option saves the scan file to remote (offsite) disk (such as
floppy disk or network drive).
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The Offsite Save Path can take the following four types of values:
e Normal File Path

e UNC Path
e FTP URL
e HTTP URL

Normal File Path

To save to a normal file path:

1  Click Advanced.

Advanced Settings

Save As

File Path/URL
®! File A

) FIP
) HTTP

Help

2  Select the File option and enter the path in the File Path/URL field.

The full path name (beginning with the drive letter) must be specified in the PC Save
Path or Unix Save Path box. For example:

A:\Inventory\Scans

UNC Path
A UNC path can be entered as the offsite save path.
To save to a UNC path:
1 Click Advanced.
Advanced Settings

Save As
File Path/URL

@) File WSERVERED

) FIP
) HTTP

Help

2 Select the File option and enter the UNC path In the File Path/URL field.
The format for the UNC path is:

\\servername\sharename\path\
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For example:
\\DDMIServer\DDM Inventory\Scans\
The specified UNC path must have write access. Do not specify a file name here.

The offsite save location can be overridden by using the -p: or /p: command line option. For
example:

Scanwin32-x86 -p:C:\Scanners\

A UNC path can also be entered as the argument to this option. The format for the UNC
path is:

\\servername\sharename\path\
For example:
Scanwin32-x86 -p:\\DDMIServer\DDM Inventory\Scans\

In Windows, if the UNC name specified is visible to the machine, the scan file will be
saved to the specified location, even if it is not mapped to a drive letter.

On UNIX and Mac OS X machines, the UNIX/Mac OS X save path is used instead,
allowing UNIX-style syntax for specifying directories to be used. On UNIX/Mac OS X, do
not use drive letters, and the save path must instead start with ¢’ (root) and point to a
directory writable by the scanner.

Click OK to return to the Savings tab page.

FTP URL

The scanners can save to any FTP server.

To save to an FTP server:

1

4

Click Advanced to display the Advanced Settings dialog.
Advanced Settings

Save &S Eie pathURL

_ File Ty Sitmi

® FIP
(. HTTP

User Hame Pazsword

Help Cancel

Select the FTP option.

Extra fields are displayed.

Enter the FTP path and enter a User Name and Password if one is to be supplied.
Click OK to return to the Savings tab page.

) When an FTP location is specified with the —p scanner command line option, the User Name
and Password can be encoded into the URL as follows:

ftp://user:password@host:port/dir

Scanner Generator
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HTTP URL

The scanners can save to an HTTP server if one has been configured to allow writing to a
particular directory.

To save to an HTTP server:
1 Click Advanced to display the Advanced Settings dialog.
Advanced Settings

Save &S Eie pathURL

_ File hittp: fitmp

I FIP
® HTTP

User Hame Pazsword

Help Cancel

2 Select the HTTP option.

Extra fields are displayed.
3 Enter the HTTP path and enter a User Name and Password if one is to be supplied.
4 Click OK to return to the Savings tab page.

If the —p scanner command line option is used with an HTTP location, ensure that the
location is not password protected. If the User Name and Password is required with HTTP
saving, specify it using the setting in the Advanced Settings dialog. The —p switch should not
be used in this case.

HTTP Saving for Apache and IIS Web Servers

The Web Server needs to be configured to allow execution of the Put command. Usually, by
default web servers are set to enable Post and Get commands. You will need to ensure that if
you are using HTTP saving that the Put command is enabled in the directory.

The following is a quick description of what you would have to enable for HT'TP saving on both
IIS and Apache.

Setup of Apache 2.0
If you are using basic authentication:
In the bin directory run:
htpasswd -c "<path>\htpass" Username

You will need to put the following in the .htaccess file of the directory that you intend to
save in:

PUT_EnablePut On
PUT_EnableDelete Off
AuthType Basic

AuthName "Write" AuthUserFile "<path>\htpass"
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Require user Username
Download the mod_put. so file and put it into the modules directory.
Enter the following into the httpd.conf file:

LoadModule put_module modules/mod_put.so

Setup for IIS

Check the option that allows writing to the desired save directory. Ensure that you have given
write access to the Username and Password that you plan on adding to the scanners http save
path.

Setting up the Creation of a Log File

The log file stores progress messages for scanner hardware detection, indicates what directory
data is scanned, how long the software scanning took, and contains the status of the scan file
saving.

To set up the creation of a log file:

Check the Always Create Log File option.

A log file is always created if this option is selected (which indicates the successful completion
of the scan if no errors are encountered).

Otherwise, a log file is only created if an error is encountered.

Depending on the saving options chosen, the log file is saved to the following locations:
¢ The same location as the local scan file.
e The same location as the offsite scan file (if an offsite location has been specified).
¢ In the scan file itself (as a stored file).

The name given to the log file is the same as the name of the scan file. For example, if the
scan file is called:

XSF014 .xsf
Then the log file generated will be called:
XSF014.1log

) The log file is not stored with the offsite scan file if the offsite scan is saved to an FTP or an
HTTP location.
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Settings Tab

The options on Settings tab of the Scanner Options page are used to control the behavior of the
scanner as it scans each computer.

¥ Scanner Generator - Server M=l E3
Scanner Options ¥
Where should the =can file be saved? How should the scanner F
behave when running ?

Saving Settings rMiscellaneuus rTruuhleshuuting

Define how fast the scanner should run:
Run scanners at low priority

e CJ' i Hormal
Speed

Increase scanning speed when the screen saver i running (Windows)

Define various time-outs used by the scanner by changing the values below:

Retry Offsite Save After Error: | IJIZI‘ Times

Delay Before Retrying Offsite Save: l]l]:l]l]:l]l]E hhimni:ss
Maximum Random Delay Before Scan: [ll]:l]l]:ll[lE hh:nim:ss
Help < Back Hext = Cancel

These options are used for controlling the behavior of the scanner as it scans each computer
and how it interacts with users.

By default the scanner is made to run with the lowest priority but will go to full speed when
the screen saver is active.

Defining How Fast the Scanner Should Run

To set user inferaction options for the scanner, select from the following:

®* Run scanners at low priority

The scanners can be set to run at slower than normal speed, so that they do not impact on
the users work.

Use the slider control to specify how slow or how fast the scanner will run. A further
option is enabled.

® Increase scanning speed when the screen saver is running (Windows)

This option will allow the scanner to run at an increased speed when a screen saver is
enabled. When this setting is checked, the scanner runs slower. It increases its speed to
normal when it detects that the screen saver is running. As soon as the screen saver
disappears, the scanner runs slower again.
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When the option to run at low priority is checked, the PC-based scanners allocate CPU
resources less aggressively and wait much longer between each file scanned. In UNIX and
Mac OS X, the scanner performs a re-nice of itself to run at a lower priority.

Setting Time-Out Options
These options set scanner time-out settings.

To set up the timer options, select the options as required:

® Retry Offsite save after error

The scanner will attempt to retry the offsite scan file saving if an error occurs the number
of times specified here.

® Delay before retrying offsite save

The scanners will wait for the time specified here before retrying the offsite scan file
saving if an error previously occurred in this process.

e Maximum random delay before scan

This setting is applicable to the Windows scanner only. The scanner can wait for the
amount of time specified here before doing anything on the machine. The default setting
for this is 00:00:00 with a maximum allowed value of 23:59:59

If the scanner is launched via a login script, using this option allows the saving of scan files to
be spread over a longer period to avoid overloading the network at busy periods. For example,
in the morning when all users come to work, power up their computers and start the scanners
at approximately the same time.
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Miscellaneous Tab

The Miscellaneous tab allows you to:
e Terminate the scanners if running in a virtual machine

e Set the behavior when a user is not logged into a computer.

Virtual Machines

When the scanner is run inside a virtual environment, you may not want a full software scan
to take place, because this would scan the server for every client.

Settings on the Miscellaneous tab can instruct the scanner to exit without doing any
processing with a special error level 20, allowing a script that launched the scanner to handle
this situation and launch another scanner tailored for the virtual environment if required.

¥ Scanner Generator - Server M=l E3
Scanner Options i
Where should the scan file be saved? How should the scanner P
behave when running #

|/ Saving |/ Settings |/ Miscellaneous |/ Troubleshooting

If the scanner is found to run inside a virtual machine, it may not be desirable to
complete the scan.

Terminate the scanner if the following environments are detected:
|:| Terminal Services (Windows)

[ ] vMware pindowsLinux)
[ ] wirtual PC (windows/Linux)
Hon Global Zone (Solaris)

Select the action to perform when no user is logged into the computer (Windows)
Action

i Sean immediately
i Wait until someone logs in

i) Exit the scanner

Help < Back Hext = Cancel

Select the virtual environment(s) for which you want the scanner to terminate. If detected:

¢ Terminal Services (Windows scanner only): the scanner is going to exit without doing
a scan if launched within a Windows terminal services session.

e  VMware (Windows and Linux scanners): the scanner terminates if launched within a
VMware virtual machine.

e Virtual PC (Windows and Linux scanners): the scanner terminates if launched within
a Virtual PC’s virtual machine.
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e Non Global Zone (Solaris scanner only): the scanner terminates without doing a scan
if launched in a non global zone on the Solaris operating systems supporting zones.

Setting Actions when a User is Not Logged into the Computer
This option is for the Windows scanner only.

Enterprise Mode

The scanner is launched via the DDM Inventory agent. The agent itself runs as a Windows
service under the LocalSystem account. However, the scanner always tries to impersonate the
account of the currently logged in user in order to collect the required network, environment,
and other configuration information for the user. This setting specifies the scanner behavior
when no user is logged in at the time the scan is scheduled:

¢ Scan Immediately: Forces the scanner to run under the local system account. However,
it will not be able to collect the environment information for a particular user. The
environment settings for the local system account will be detected. Also any program
running under the local system account does not have access to network resources, so the
scanner will not be able to access any files or directories on the network.

e  Wait until someone logs in: This instructs the scanner to wait until an interactive user
logs into the system. When this is detected, the scanner impersonates this user and
executes using this user’s account. This allows the scanner to collect environment
information for the user. However, this setting is not suitable for standalone servers
where interactive users rarely log in.

e Exit the scanner: The scanner simply exits without scanning the computer.

Manual Deployment Mode

The scanner runs under the account of the currently logged in user, so normally these settings
do not apply. They may only take effect when the scanner is launched by a software
distribution tool that can run it under the LocalSystem account. In this case, the above logic
for Enterprise Mode applies.
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Troubleshooting Tab

The Troubleshooting tab is used to set up additional troubleshooting options for the scanners.

¥ Scanner Generator - Server Hi=] E3

Scanner Options v
Where should the =can file be saved? How should the scanner F
behave when running ?

|/ Saving |/ Settings |/ Miscellaneous |/ Troubleshooting

Additional command line parameters to supply to the scanners:

Additional content for . override.ind file:

Help = Back Hext ~ Cancel

Additional Command Line Parameters to Supply to the Scanner

You can specify additional content for the override files here. Although the options for the
scanner are normally set using the Scanner Generator, it may be necessary to change some
settings to allow better operation on some machines. The operation of a scanner can be
modified with the use of the various command line parameters.

Additional file scanning configuration specified in the override. ini (Windows) file and the
.override. ini file (UNIX/Mac OS X) can be entered in this field. The content specified here
is processed by the scanner before processing the content of the override file (if available on
the system where the scanner runs).

Override Files

You can override the settings of the file systems, directories and files during the software
scanning process by specifying additional settings in the override file. As indicated, on
Windows systems, the name of this file is override.ini. On UNIX and Mac OS X systems,
the name of this file is .override. ini. The override file must be located in the same
directory as the scanner executable.
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File Systems

Because it is always possible, particularly on UNIX and Mac OS X systems, that some file
systems are not in the list, you can create a file where you can specify any additional names of
file systems that you want to include or exclude during scanning.

You can also specify names of existing file systems in case you want to change the inclusion/
exclusion of such file systems after the scanner has been generated.

The format of the file is as follows:
[include]
fs=<name of a file system>
[exclude]
fs=<name of a file system>
There can be several “fs” entries in each section.

For example, to ensure that all afs mount points are scanned, and that nfs and swap
volumes are not, create the override file with the following contents and place it in the same
directory as the scanner prior to running:

[include]
fs=afs
[exclude]
fs=nfs
fs=swapfs

) The name of the file, the sections and the files systems are case-sensitive.

) For the feature to work correctly, the override file must be present in the directory in which
the scanner resides.

Directories and Files

The override file can also be used to exclude specific directories or files from being scanned
without regenerating the scanner.

) Files can only be excluded; they cannot be included.

To make use of this file, add one or more

dir = <name>

or

file = <name>

entries to the [exclude] section of the override file. Excluded directory names must be fully

qualified. Excluded file names can contain wild cards.

Example

[exclude]
fs=autofs

dir=/temp
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dir=/etc
file=*.exe

When excluding files using the override file, the scanner may still store information about the
excluded files in the scan file. Adding file entries to the override file ensures that the file will
not be opened for any reason, so no file identification, signatures, or archive processing will
happen for excluded files.

Example 1
Exclude a specific file system, two directories and all files with exe extension.
[exclude]
fs=autofs
dir=/temp
dir=/etc

file=*.exe

Example 2

This runs a scan without software on a Windows machine.
[exclude]
fs=FAT

fs=NTFS

Example 3 Virus Warning

Since the scanner opens files on the computer, if real-time antivirus software is in operation,
it may detect a virus being present in a file.

Depending on the virus product being used, actions will have been defined to deal with an
encountered virus. Some will try to deal with the problem and immediately disinfect the file.
Others will try to move the infected file to a quarantine directory and rename its file
extension. In this case, the quarantine directory may be scanned by the scanner later during
its scan.

To prevent this from happening, use the override file with * .vir specified for exclusion
(where .vir is a typical quarantine file extension). Check the specific virus product to find
the extension for this type of file.
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Scanners to Generate Page

The Scanners to Generate page is used to specify which scanners to generate and where they

will be stored.

In Enterprise Mode only the Output Options tab will be displayed.

ﬂ Scanner Generator - Server =]

O]

Scanners to Generate

Which scanner do you want to generate, and where should

they be stored?

[ Output Options |

Scanner Description:

|S|:anner

|:| Save scanner options to an HTML file

Scanner Generator Output

Configuration File Hame to Use:

Scanner Generator will create a Scanner Configuration file containing the
specified settings, and transfer it to the DOM Inventory Server

SCaEn.Cxz

Help

< Back

Generate >

Cancel

In Manual Deployment Mode, both the Output Options and Scanners tab will be displayed.

ﬂ Scanner Generator - Server M=] E3

Scanners to Generate

Which scanner do you want to generate, and where should they be

stored?

l/ Output Options |/ Scanners

Q]

Sscanner Description:

|S|:anner

|:| Save scanner options to an HTML file

Help

= Back

Generate >

Cancel

Scanner Generator
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Output Options Tab

The Output Options page is used to set up scanner descriptions, save the configuration to an
HTML file if required, and, for Enterprise Mode only, name the configuration (. cxz) file.

Setting up a Scanner Description

These options allow you to specify the scanner description. You can also optionally produce an
HTML file of the scanner selections that you have made.

Having a scanner description is very useful for change control if different scanners are being
developed for different circumstances.

It is useful for documentation purposes, to have a file with the scanner’s configuration stored
in a file. If this step is missed, then load the scanner or a scan file derived from it into Scanner
Generator and produce the documentation from this.

To set up a scanner description and save the options to an HTML file:

e In the Scanner Description box, enter a description to identify the scanner.
For example:
Standard PC Inventory - July 18, 2007

The scanner description is saved in the scan file as the hwScannerDescription
hardware field and subsequently in the Discovery Database in the hwSystemData table.

Saving Scanner Options to an HTML File

The Save scanner options to HTML file box is used to instruct the Scanner Generator to
output an HTML file containing a complete listing of all settings defined elsewhere in the
program. Select the check box and specify the path and file name to which the scanner options
will be saved to. The HTML file cannot be used by the Scanner Generator, but is intended for
user/internal documentation purposes.

Example of the ScannerOptions.html File
You can look at a ScannerOptions.html file using an Internet browser such as the

Microsoft Internet Explorer. The following shows the first few sections that you will find in
the file:
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General

Product Version: 7.60 (24 Aug 2007)

Scanner Version: 7.60 (2007-08-24 15:36:52)

Platform: Win32 Scanner

Description: Scanner

Tvpes of Data Collected: Software, Hardware, Asset Data
Default Scan File Name: DEFAULT

Hardware and Configuration

s Excluded Hardware: Compag Asset Tag, Device Drivers, Installed Applications
(WMI)

Software Data

Allow scanner command-line to override this selection: Yes

Drives: Default

s Drive Selection: Local hard disk:, File, Unknown

Filesystem Types: FAT, Device Driven, HPFS, NTFS, ext, extl, ufs, tmpfs, vafs,
hfs, hfs Extended, ifs, ext3, DVD-ROM

Directories

s Emvironment Variables: PATH.LIBPATH
s Options: Scan subdirectories
+ Windows Onlv

Naming the Configuration (.cxz) File

In Enterprise Mode the configuration file is saved on the DDM Inventory Server as well, using
the same file name as the copy specified in the Configuration file name to use field.

The configuration file is a compressed XML file containing the settings for the scanner you
are currently configuring.

When the scanners are used in the Enterprise Mode, they read the configuration from a
separate configuration file. This is a binary file with a . cxz extension. The typical size of the
configuration file is about 3KB. As the size of the configuration file is significantly smaller
than the size of the complete scanner, a separate scanner configuration is useful for repetitive
inventory collection when the configuration of the scanner has been altered. In this case only
a small configuration file is delivered to the user’s computer to run with the original scanner
instead of delivering the entire new scanner.
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Scanners Tab

The Scanners tab is only available in Manual Deployment Mode. It is used to select which of
the scanners to generate.

8 Scanner Generator - Server Hi=] E3

O]

Scanners to Generate
Which scanner do you want to generate, and where should
they be stored?

r Output Options |/ Scanners

Generate Scanners For

7 HP Precision Architecture 1= All
HP-UX (HPPA) Scanner
Hone
¢ IBM REOOD =
AlX (POWER) Scanner Invert
¢ Intel 1386+ .
Linux (x§6) Scanner
Mac 05 X (x86) Scanner
Solaris (86} Scanner =
Bage Scanner File Hame: Output Directories
jscan | i@ One Directory
OQutput Directory: i) Separate Directories
|C:1Dn:u::uments and Settingz\Adminiztrstor Browse...
Help < Back Generate > Cancel

Selecting which Scanners to Generate

The scanners are presented in a tree view in the Generate scanners for list box.

As the mouse pointer passes over a scanner in the list, the status bar (just below the list box)
displays the following information for that particular scanner:

e Ifthe scanner is enabled (meaning it is valid with the current set of options).

¢ The directory that the scanner will be generated in. If the scanner was invalid, then a
description of why this is the case is displayed instead.

To select which scanners fo generate:

Select the check boxes next to the scanner.
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Buttons

e Al - Selects all scanners
e None - Deselects all scanners

e Invert - The Invert button allows the selections to be reversed. This saves having to
deselect all the scanners one by one, when only a single scanner is required. If all the
scanners are selected, just deselect the one you want and choose Invert.

Specifying Base Scanner File Name and Output Directory

You can define the base name of the scanner (up to 5 characters). Alternatively for each
scanner, you can either have a file name to identify the operating system or you can use a
separate directory for each operating system.

To specify the base scanner file name and output directory:

1 For all selected scanners, specify a fully qualified file name. The initial part of this file
name can be entered in the Base Scanner File Name box. The remaining three characters of
the file name are used to describe the scanner executable.

For example, by entering Scan (the default setting) in the Base Scanner File Name (Max 5
characters) box, the following scanners can be generated (if they have been selected in the
Generate scanners for list box):

Table 17 Base scanner file names and output directories

Scanner File Name | Scanner Type
scanwin32-x86.exe Windows (x86)
scanwin32h-x86.exe Windows (86, hidden)
scansolaris-sparc Solaris (SPARC)
scansolaris-x86 Solaris (x86)
scanhpux-hppa HP-UX (HPPA)
scanhpux-ia64 HP-UX (ia64)
scanaix-ppc AIX (POWER)
scanlinux-x86 Linux (x86)
scanmacosx-ppc Mac OS X (PPC)
scanmacosx-x86 Mac OS X (x86)

2 In the Output Directory box, type in or click the L=l button to specify the directory that the
generated scanners will be saved to.

Setting Naming Conventions for Scanners

The Naming conventions options determine the manner in which scanner files are named:
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To set naming conventions for the scanners:

1 Select one of the following:
* Filename includes operating system
This option incorporates the scanner name with the operating system, for example:
scanwin32h-x86.exe
®  One directory per operating system

This option dictates that the names of each scanner generated are the same, but are
copied into individual subdirectories which are named as per the operating system.

For example, a scanner named scan. exe (Windows)/scan (other platforms) would appear
in directories for all operating system options selected:

:\Program Files\Hewlett-Packard\DDMI\7.60\win32-x86
:\Program files\Hewlett-Packard\DDMI\7.60\solaris-sparc
:\Program files\Hewlett-Packard\DDMI\7.60\hpux-hppa
:\Program files\Hewlett-Packard\DDMI\7.60\hpux-ia64
:\Program files\Hewlett-Packard\DDMI\7.60\aix-ppc
:\Program files\Hewlett-Packard\DDMI\7.60\1inux-x86

:\Program files\Hewlett-Packard\DDMI\7.60\macosx-ppc

Q QO QO QO Q0 QO O M

:\Program files\Hewlett-Packard\DDMI\7.60\macosx-x86

2 Click Generate to create the scanner executable files.
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Generating Scanners Page

After you have selected the scanners to be generated and have clicked Generate, the last page

of the Scanner Generator is displayed.

ﬂ Scanner Generator - Server M=l E3

Generating Scanners

The requested scanners are being generated

Q]

Time:

Meszage

May 17, 2009 F:55:44 PM

Generating 10 scanners

May 17, 2009 7:55:45 PM

Requesting scanners from Server

May 17, 2009 7:57:49 PM

Al =canners generated successfully.

May 17, 2009 7:57:49 PM

Finizhed

Help

= Back

Finish

Cancel

This page shows the progress information during the generation of the actual scanner

executable.

In Enterprise Mode, the scanner configuration is generated instead of stand-alone scanners
and the configuration is uploaded to the DDM Inventory Server. If you chose to generate your
scanner from a stored default predefined configuration on the server when you were on the

Standard Configuration page, you will be told to rename it since default predefined

configurations cannot be overwritten.

Right-clicking anywhere in the log window displays a shortcut menu which allows you to:

e Save the contents of the window to a log file.

e Copy the contents of the log window to the clipboard.

¢ (Clear the log window.

If a scanner already exists with the same name in the chosen directory, a confirmation

message is displayed. This allows you to choose whether to overwrite the existing scanner.

After the scanners have been generated, click Finish to exit the Scanner Generator.

The generated scanners can be found in the directory specified in the Scanners tab of the

Scanners to Generate page.

Scanner Generator
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12 XML Enricher

The XML Enricher is a process that runs in the background and automatically adds
application data to scan files. This process is called scan file enrichment. It works as follows:

1 The XML Enricher looks for new scan files (xsf or dsf format) in the Incoming directory.

2 If afile is found, it processes the file using SAI (Software Application Index) application
recognition.

3 Information about recognized applications is added to the file data and a separate
<applicationdata> section is added to the XML file.

The XML Enricher provides data that is automatically imported into the aggregate database.

You can set up Viewer and Analysis Workbench to use the processed scan files in the
Processed directory for analysis, or the processed scan file can be consumed by a Connect-It
script.

The XML Enricher can also be used to re-enrich scan files that were enriched previously. This
can be useful after applying a significant update to the SAIs.
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As a guideline, on a fast machine an average sized scan file (200-300Kb) will take 3 to 8
seconds to process.

Enrichment
SAI
Enricher Files
Di ED Reports
1scovery Recognition Objectives
Database Scan Data Viewer
Connect-It
\ 4
3rd Party
A
ssetCenter Software
Publish
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XML Enricher Directory Structure

The XML Enricher uses a directory structure under the DDM Inventory Data directory.

By default, the DDM Inventory Data directory is:

C:\Documents and Settings\All Users\Application Data\Hewlett-Packard\DDMI.

0 The Data Directory is customizable during the installation process. Ensure that you have no
other data in this directory. The data directory must be dedicated to DDM Inventory.

The following table shows the various directories that are used by the XML Enricher.
Table 1 Directories used by the XML Enricher

Directory Explanation
\Scans The base directory
\Scans\Failed The base failure directory. Failed scans are moved to a

subdirectory of this one.

\Scans\Failed\Corrupt

Scans that cannot be read or may not be scan files are
moved here.

\Scans\Failed\Delta

If the original scan file is missing or there is an error
applying the delta scan file to the original one, then those
delta scan files will be moved here.

\Scans\Failed\Error

When any other error occurs, scan files are moved here.

\Scans\Failed\Filter

The scan file ends up here if it has an IP address outside a
range that has been configured to allow scanned devices.

\Scans\Failed\Licence

If the number of processed scan files exceed the maximum
number of licenses, new scans are moved here.

\Scans\Failed\01ld

Scan files that are copied to the incoming directory but are
older than the one already in the database are moved here.

\Scans\Deferred\Firstscan

If the Automatically defer all new scans option was set, the
scan file is not processed. See Automatically Defer all New
Scans on page 179.

Instead, it is moved to this directory.

Any scan files in this directory are from the first time a
scan file was seen for a particular computer.

This allows the administrator to review the asset and
application data.

When you are satisfied that the data is OK, you can move it
back to the incoming directory.

Note: New scan files from a computer will not be processed
while a scan file for it exists in this directory. The existing
scan file in this directory will be overwritten by the new
scan file.

\Scans\ Incoming

The incoming directory. The enricher looks for new scan
files here.

XML Enricher
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Table 1 Directories used by the XML Enricher

Directory Explanation

\Scans\Original This folder is used for delta scanning. It stores copies of
original scan files, which are then used in conjunction with
delta scan files to recreate the new version of the scan file.

\Scans\Processed The processed directory. Enriched scan files are created

here.

\Scans\Processed\ [user
defined]

You can group the scan files based on Hardware fields. This
is user-defined. Define the setting on the following web UI

page:
Administration > System Configuration > Scan file management.
See Group Processed Scan Files on page 183.

\Scans\Temp

This is where the XML Enricher stores its temporary files.
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The following flowchart shows how the enrichment process works for XSF and delta (DSF)

scan files.
Monitor

_ |Incoming <
7| Directory —

Move the

Incoming Reconstruct

Scan Fileto  [€—] With Old

Original Scan File

Directory From

Original
Directory
Process Scan File
Move the
Enriched Scan
File into the
Processed
Directory
Move
reconstructed new
Delete the Incoming Scan File to
Scan File Original Directory

Processing Normal Scan Files

XML Enricher

At the end of the process, a new enriched scan file is created. If delta scanning was enabled in

the parameters for the Scanner used to produce the scan file, the incoming scan file gets

stored in the Original directory for future use by the delta scan processing. If delta scanning

was disabled, the incoming scan file is deleted.
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If an error occurs, the original scan file is moved to a failure directory and is not deleted.

If an enriched scan file for the same asset/device already exists, the old file is overwritten.

Processing Delta Scan Files

The delta scan file is used in conjunction with the previous version of the scan file located in
the Original directory to reconstruct the new full version of the scan file. This full version is
then moved into the Incoming directory, where it gets processed in the same way as other
normal scan files.

At the end of the process, the reconstructed scan file is moved to the Original directory, ready
for the next time a delta scan is found for this particular scan file instance.

Setting up the Scanner to Handle Delta Scan Files Correctly in Manual Deployment Mode

When conducting an inventory in Manual Deployment mode, for the delta scan file processing
in the XML Enricher to work correctly, ensure that you do the following:

e Configure the Scanner to save results to the XML Enricher Incoming directory. This is
done in the Save result to network (off-site) field on the Scanner Generator Scanner
Options > Saving tab page.

This directory can be found in the DDM Inventory Data Directory in the following folders:
[DDM Inventory Data Directory]\Scans\Incoming

This directory should be accessible to all users as the Scanner should be configured to
save to the incoming directory used by the XML Enricher.

You can also use the command line option -p: <path> with the Scanner to override the
selection made in the Scanner Generator.

e Set the separate refilling path to the Original directory. This directory can be found in the
following place:

[DDM Inventory Data Directory]\Scans\Original

This directory should be accessible to all users. This will ensure that the Original
directory will contain the original scan file to be used in reconstruction.

You can also use the Scanner -r: <path> command line option to specify the location of
this directory.

Delta Calculation Command Line Utility

A command line utility can be used for calculating the delta between two scan files and
applying a delta scan file to a full scan file. This utility is not used by any of the DDM
Inventory components; delta scan file processing is built into them. It is only provided for
technical support purposes and can also be used to create custom delta scan processing, which
is different from the built-in delta scan support.

This utility is called FSFDelta.exe and can be found in the following location:
C:\Program Files\Hewlett-Packard\DDMI\7.60\Scanner Generator
The convention for using this command line utility is as follows:

XSFDelta OldFile NewFile DeltaFile
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Where:
e [XSFDelta] is the command

e [OIdFile] is the name and path to the old scan file - Enter the full scan file name (for
example, Test .xsf)

¢ [NewfFile] is the name and path to the latest scan file - Enter the full scan file name (for
example, Latest .xsf)

¢ [DeltaFile] is the name and path to the delta scan file produced. If no extension is specified
for this file, the default .dsf is assumed.

If you have all three of these files contained in the same directory as the XSFDelta utility,
then you do not have to specify the full path to these files.

To create a delta scan file, run XSFDelta specifying the two input scan file names and the
name of the output delta scan file. XSFDelta compares the two full scan files specified and
creates a delta scan file containing the differences between them.

To perform the reverse process of reconstructing the new version of the full scan file using the
previous scan file and a delta scan file, run XSFDelta with the —d command line switch,
specifying the input OldFile name and DeltaFile names and the output NewFile name.

XSFDelta will apply the differences in DeltaFile to OldFile to reconstruct the new version of
the scan file in NewFile.

Application Utilization Data

XML Enricher

Agent software utilization generates individual utilization files, one per day when it runs up
to the maximum period for which utilization data is collected.

In addition, it also produces a summary file for the entire utilization period. This file is an
XML data file compressed using gzip (Compressed XML utilization). The XML is encoded
using the UTF-8 encoding.

The XML Enricher does the following during its processing:
e Extracts and parses the XML data out of the stored file.

e C(Calculates the software utilization for each recognized application and adds this
information to the enriched scan file.

e Adds a ‘Utilized’ flag to the file attributes, calculates and adds utilization figures for
executables that were executed.
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Log Files

Whenever enrichment of a scan file fails, an entry describing the occurrence is added to a file
named log.txt in the relevant failed subdirectory.

For example, the following is an excerpt from log.txt from the Licence directory:
2005-August-28 13:21:08.000 - Assetl9 (Licence limit reached)
2005-August-28 13:21:29.125 - Asset292 (Licence limit reached)

The format of a line in the log file is

<date> <time> - <AssetTag> (<Failure reason>).

The XML Enricher also adds entries to the Discovery Log in the following circumstances:

e  When it starts up and shuts down.

¢  When it starts enrichment of a new scan file.

e If an error occurs.

Application Recognition in XML Enricher

The XML Enricher reads scan files and outputs ‘enriched’ XML scan files containing all of the
original data as well as data identified in the application recognition step.

Each file is stored as a <file> element. When a file is identified as belonging to an application,
two attributes are added to the element: versionid and flag.

For example,
<file name="winword.exe” size="12345" versionid="1111" type="M"/>

would represent a file named winword.exe identified as belonging to the application with a
version ID of 1111. The type of the file is “M”, which means Main file. The possible values for

the type field are:

Type “type” tag in enriched XML file
Main M

Associated Y

3rd Party 3

Device Driver A
Unknown N
The versionid attribute refers to the unique ID associated with every version in the library.

In an enriched XML scan file, the <applicationdata> section contains a list of applications
identified on the machine along with the version IDs.
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For example,

<applicationdata>
<application version="6.0 spl"
release="6.0"
name="Internet Explorer"
desc="Microsoft Internet Explorer"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Web Browsers"
maindir="C:\Program Files\Internet Explorer"
lastUsed="2004-05-05 00:00:00"
versionid="12790"
releaseid="131"
/>
<application version="6.0 spl"
release="6.0" name="Outlook Express"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Communications"
maindir="C:\Program Files\Outlook Express"
lastUsed="2004-05-05 00:00:00"
versionid="12792"
releaseid="372"
licencedby="12790"
licencedbyrelease="131"
/>

</applicationdata>

The example above could be found for a machine with just two applications on it: Microsoft
Internet Explorer and Microsoft Outlook Express. The “licencedby” attribute indicates that
Microsoft Outlook Express is licensed by Microsoft Internet Explorer. In other words, while
both are licensable applications, this machine requires 1 license for Microsoft Internet
Explorer - with this license, no separate Outlook Express license is required.
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Configuring the XML Enricher

You can configure the following options to control the XML Enrichment process:

Process Utilization Data

Application Recognition

Automatically Defer all New Scans

Merge Priority

Generate Solaris Local Zone Inventory from Global Zone
Advanced SAI Recognition Options

SAls

Filtering

To configure the XML Enricher:

1
2

Click Administration > System Configuration > Scan processing.

Set the options as required.

Process Utilization Data

If you want to stop collecting utilization data, turn this option off. The default option is Yes.

) DDM Inventory can only collect Utilization data if you have a license for it.

Application Recognition

There are three options for Application Recognition:

Software application index (SAl)

This is the default setting. If you select this application recognition option, the XML
Enricher uses the Software Application Index files (. zsai) to perform application
recognition. The SAI files contain a database of software applications. By default, only
executable files are sent to the recognition engine for processing. You can set this so that
all files are sent to the recognition engine by modifying the filter settings. See Filtering on
page 181.

No recognition

This option is used to disable any application recognition. When recognition is disabled,
scan file processing is slightly faster as no file information is sent to the recognition
engine for processing. However, the processed scan files are not enriched with application
data and no application data is added to the database.

Installed applications

If you select this application recognition option, the XML Enricher uses the operating
system’s internal list of installed applications to report the application data. As this list is
incomplete and not normalized, it is not recommended as the preferred recognition
method, except for quick initial assessment.
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Refer to the “Application Recognition and Teaching” chapter in the Scan Data Analysis Guide
for more details.

Automatically Defer all New Scans

If enabled, the following happens when a scan file is found in the Incoming directory:
e The scan file is looked up in the internal database (Not the Discovery Database).

e Ifthe machine has never before been scanned, the scan file is not processed or enriched.
Instead, it is moved to the firstscan directory.

e If the machine has been scanned before, the enricher checks if there is a scan file with the
same name in the firstscan directory. If there is, the old scan in the firstscan directory is
deleted and is replaced with the new one.

When a new computer is scanned for the first time, the data is not added to the Discovery
database until it has been manually reviewed and the scan file has been moved back to the
Incoming directory.

Merge Priority

This allows you to define what to use as the primary data merge keys. In the case of the
automatic deployment of the scanner in Enterprise Mode, the scanner has extra information
(for example, the NMID), but if this information cannot be used, the other fields will be used.

For example, if NetBIOS Name and Windows Domain are chosen, then it will use this
information in the scan file to find the matching device in DDM Inventory.

Generate Solaris Local Zone Inventory from Global Zone

For Solaris zones, this option allows you to specify to the XML Enricher how you want it to
process the global zone scan file. If this option is enabled, the XML Enricher generates
individual scan files for each local zone from the global zone scan file on the Solaris server.
You want to enable this option if you are running the scanner in the recommended global zone
scan mode. This option is enabled by default. Disable this option if you are running the
scanner in the non-recommended local zone mode.

) If you are running the scanner in the non-recommended local zone mode and enable this
option, the XML Enricher will discard the local scan files produced for each local zone by the
individual scanners and replace them with the scan files that are generated from the global
scan file.

Advanced SAI Recognition Options

These three sets of options determine how the XML Enricher performs the SAI application
recognition. They correspond to the controls available on the Recognition tab of the Options
dialog box in Viewer and Analysis Workbench.
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Advanced Recognition Methods

There are two advanced recognition options. They are independent of each other. By default,
both are selected.

¢ The Level 3 recognition heuristics option determines when the XML Enricher processes
scan files for a particular machine. If this option is selected, the XML Enricher waits until
all the files in all the directories on that machine have been read before issuing its final
recognition information.

If this option is selected, more accurate recognition is achieved. If this option is not
selected, machine-based recognition does not take place, and recognition data is returned
after each directory is loaded. A time overhead of about 10% is normal when Level 3
Recognition is enabled.

¢ The Auto-identify unrecognized device driver files option instructs the XML Enricher to
mark files that meet the following criteria as recognized in the enriched scan file:

— They cannot be identified by standard SAI recognition.
— They have the Device Driver attribute.

Files used as Device Drivers represent a large portion of the files that are not identified by
the Application Library. Being able to identify these automatically can significantly
reduce the effort required to achieve good recognition rates.

Preferred Language

This option enables you to specify the language that the XML Enricher uses when it
encounters more than one language version of the same file - for example, Microsoft Word in
both English and French. Because these versions are equally recognized, this setting tells the
XML Enricher which version to select.

This option works in concert with the Override OS Language option. By default, no preferred
language is set.

Override OS Language

This option works in concert with the Preferred Language option. If you specify a Preferred
Language, and you select the Override OS Language option, the recognition engine will
overlook the OS locale setting and use the Preferred Language that you specify.

By default, this option is set to No.

‘n- For more information about the process of application recognition, refer to the Scan Data
Analysis Guide.

SAls

There are two XML Enricher options that pertain to Software Application Index (SAI) files:

SAl files

This option enables you to specify the SAI files that the XML Enricher uses to recognize
applications.

180 Chapfer 12



The list of available SAI files matches the contents of the SAI folder in your DDM Inventory
data directory. By default, this is:

C:\Documents and Settings\All Users\Application Datal\Hewlett-Packard\
DDMI\SAI

For each SALI file that appears in the list, the following information is displayed:

e A description

¢ The size (in kilobytes)

¢ The number of unique application versions the SAI file contains

e The type: Master (read-only) or User (editable)

e The creation date for a Master SAI file. For a User SAI, the date the file was last saved.

The XML Enricher searches for master.zsai and user. zsai. If the locale is France, it adds
french.zsai. If the locale is Germany, it adds german.zsai.

) The XML Enricher can only load SAIs from non-substed locations. This is because Windows
drives created by the SUBST command are not accessible to Windows services.

SAl File Used to Store Rule-created ltems

This option specifies the SAI file to which items encountered that were created by rules will
be added. These rules are present within the SAI files themselves. You can specify additional
rules by using the SAI Editor.

If this field is left blank, DDM Inventory will create a file called Auto.zsai and put this in the
same location as the first Master SAI.

‘- For more information about SAI files and the process of application recognition, refer to the
Scan Data Analysis Guide.

Filtering

There are four filtering options that determine what types of files the XML Enricher
processes:

Use Only Files with the Following Extensions
This option specifies the extensions of the particular file types that will be processed by the

XML Enricher. Type the extension(s) that you want to use directly into the box. Separate
extensions with commas or semicolons. Only these file types will be processed.

Use Only Executable Files

This option specifies that only executable files should be processed by the recognition engine.
This includes *.exe, *.com, *.dll and other files containing executable code.

Look also for Files within Archives
Use this option to specify that files within archive files should be processed. The following

archive file types are supported: ARJ, zIP v1, ZIP v2, LHA, LZH, ARC, CAB, TAR,
GZIP, TAR/GZIP and PAK.
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Comma Separated List of Regular Expressions used to Filter Junk Files

Some files may be executable but are of no interest for licensing or other purposes. These files
are often identifiable via the file name. For example: TMP[0-9] *\ . \$\$\$. This option
enables you to specify file names that should be ignored by the XML Enricher. Do this by
entering comma-separated regular expressions in the text box. Any files whose names match
the regular expressions will be ignored.

When the XML Enricher matches a file name against a junk filter regular expression, the file
name is first converted to lower-case. For this reason, all letters entered as part of the regular

expression must be in lower-case for a match to successfully occur.

For more information about the process of application recognition, refer to the Scan Data
Analysis Guide.

Analysis Asset Field Configuration

The Analysis Asset Field configuration settings that affect the XML Enricher cannot be
modified in the Web UL You can change these settings by using the Viewer. To do this, follow
these steps.

1 Select Start > All Programs > Hewlett-Packard > DDM Inventory 7.60> Viewer.
2 Use File > Options > Asset Fields to configure the Analysis Asset Fields.

For more information, see the “Viewer” chapter of the Scan Data Analysis Guide.
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Managing Scan Files

You can configure the following options to control scan file management:
e Delete Orphaned Scan Files
¢  Group Processed Scan Files
Delete orphansd scan files: @ Defauly; | Always
O custarn: | @ aAlways

O on purge
O Hever

Group Processed Scan Files

Group processed scan files by primary: @ Default:
O Custam:
Group processed scan files primary blank: @ Default: unknown
O Custam: unknawn
Group processed scan files by secondary: @ Default:
O Custam:
Group processed scan files secondary blank: @ Default: unknown
O Custam: unknawn
Group processed scan files by tertiary: ® Default:
O Custom:

Group processed scan files tertiary blank: Y Default: unknown

®

) Custorn: | |unknown

/'\
L6 |

To configure scan file management:

1 Click Administration > System Configuration > Scan file management.

2 Set the options as required. They are described below.

Delete Orphaned Scan Files

Orphaned scan files are scan files that are no longer associated with a network device.
There are two scenarios that create orphaned scan files:
¢ The network device has been purged from the database.

¢ An admin user has changed the scan file groupings, so the original scan file is orphaned,
while the new scan file for that device is located in another folder.

You can use this feature to have DDM Inventory automatically delete these orphan scan files.
Group Processed Scan Files
The grouping commands will help you organize your scan files in the processed directory. You

can group your scan files based on Hardware Fields (for a complete list, see Help >
Classifications > Hardware Fields).
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The value of the selected hardware field will be used as the name of a subdirectory under the
“processed” directory.

If the Hardware field you have chosen is blank in a scan file, that file will be moved to a
“Blank” directory.

Updating Application Library used by Enricher

This is done via an update package that contains Rulebase, JAY Scripts and the latest SAI
files. This gets dropped into the C: \Program
Files\Hewlett-Packard\DDMI\7.60\Install directory and the system monitor service
automatically detects this, unpacks it and installs it.

Refer to the chapter entitled Installing Knowledge Updates in the Installation and Upgrade
Guide for further information on how to do this.
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Structure of Enriched XSF File

Scanfile.dtd describes the structure of the scan file in standard DTD format. By default
this file can be found in the following location:

C:\Program Files\Hewlett-Packard\DDMI\7.60\Common

The file is a text file, but is easiest to read with an XML reader.

An XSF scan file contains a sequence of elements, each of which have various attributes. Root
elements are:

e <hardwaredata>

e <applicationdata>
o <filedata>

e <storedfiles>

e <configurationdata>

Example of How Data is Stored

XML Enricher

The following is an example of several sections in an xsf file.

<?xml version="1.0" encoding = "UTF-8" ?>

<inventory codepage="1251" locale="English (United States)" fsfmajorver="7"
fsfminorver="6" enricherver="7.60.000.8200">

<hardwaredata>
<hwAssetData type="shell">

<hwAssetDescription type="attrib">tbrown - Xeon, 2800MHz, 3712Mb</
hwAssetDescription>

<hwAssetTag type="attrib">000590 </hwAssetTag>
</hwAssetData>
<hwMemoryData type="shell">
<hwMemTotalMB type="attrib">3712</hwMemTotalMB>
<hwSwapFiles type="shell">

<hwSwapFiles_value type="shell_ value">

<hwMemSwapFileName type="attrib">C:\pagefile.sys</hwMemSwapFileName>

<hwMemSwapFileSize type="attrib">1534</hwMemSwapFileSize>
</hwSwapFiles_value>
</hwSwapFiles>
<hwDOSMemoryData type="shell">
<hwMemConventional type="attrib">640</hwMemConventional>
</hwDOSMemoryData>
<hwCMOSMemory type="shell">
<hwMemExtended type="attrib">3799944</hwMemExtended>
<hwMemCMOSTotal type="attrib">3800584</hwMemCMOSTotal>
<hwMemCMOSConventional type="attrib">640</hwMemCMOSConventional>
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</hwCMOSMemory>
</hwMemoryData>
</hardwaredata>
<applicationdata>
<recogconfig>

<sal name="C:\Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\SAI\user.zsai" desc="User SAI File" date="04/06/
2007"

type="User" />

<sal name="C:\Documents and Settings\All Users\Application
Data\Hewlett-Packard\DDMI\SAI\master.zsai" desc="" date="07/05/2007"
type="Master" />

<application version="6.4.09"
release="6.4"
name="Windows Media Player"
publisher="Microsoft"
language="English"
os="Windows 2000"
type="Interactive Media Tools"
maindir="C:\Program Files\Windows Media Player"
lastUsed="2007-08-26 00:00:00"
versionid="9978"
releaseid="582"
licencedby="11907"
licencedbyrelease="84"
/>
<application version="6.0 spl"
release="6.0"
name="Internet Explorer"
desc="Microsoft Internet Explorer"
publisher="Microsoft"
language="English"
os="Windows 98/NT/2K/ME/XP"
type="Web Browsers"
maindir="C:\Program Files\Internet Explorer"
lastUsed="2007-05-07 00:00:00"
versionid="12790" releaseid="131"
/>
</applicationdata>
<filedata>
<dir name="C:\" date="2007-07-03 03:23:04" contains="-1">

<file name="AUTOEXEC.BAT" size="0" modified="2007-04-03 13:51:04"
attr="a"/>

<file name="BOOT.INI" size="288" modified="2007-04-03 15:14:38"
attr="rsa"/>
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<file name="sd_settings.ini" size="462" msdos="SD_SET~1.INI"
modified="2007-06-14 09:08:44" attr="a">

<verinfo name="DOS 8.3 Name" value="SD_SET~1.INI"/>
</file>
</dir>
</filedata>
<storedfiles>

<storedfile type="storedfile" name="SYSTEM.INI" size="217" istext="1"
istruncated="0" dir="C:\WINNT\SYSTEM.INI">

<contents encoding="text">; for 16-bit app support

[386Enh]
woafont=dosapp. fon
EGA80WOA . FON=EGA80WOA . FON
EGA40WOA . FON=EGA4 0WOA . FON
CGA80WOA . FON=CGA80WOA . FON
CGA40WOA . FON=CGA4 0WOA . FON
[drivers]
wave=mmdrv.dll
timer=timer.drv
[mci]
</contents>

</storedfile>
</storedfiles>

</inventory>

Running Multiple XML Enricher Services

By default, DDM Inventory is configured to use one XML Enricher service. This is adaquate
for most situations. However, in exceptional circumstances when the scan files flow into the
incoming directory faster than the XML Enricher is able to process them, a build-up of scan
files can appear in the incoming directory. To allocate more processing power to enriching scan
files, DDM Inventory can be configured to use 2 XML Enricher services. You can specify this
in Administration > System Configuration > Server configuration > Number of XML Enrichers to run.

) Running two XML Enricher services makes sense only if the computer on which DDM
Inventory is running has multiple physical CPUs or a single CPU with multiple cores.
Although some benefit can be gained if a single processor system has hyper-threading
supported and enabled, the real benefit can be seen on multi-core or multi-processor systems.
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13 Getting Data into AssetCenter

This chapter explains how you can get your data from DDM Inventory into AssetCenter using
the out-of-the-box DDM Inventory to Asset Management scenario supplied.

"- The scenario is an example only and as such does not necessarily reflect your data needs. For
further information on customizing the scenario, refer to the Connect-It Users Guide.

Assumptions

The following assumptions have been made throughout this chapter:

¢ You are familiar with one or more of the components of this process. That is, DDM
Inventory, AssetCenter and Connect-It.

¢ You have already installed AssetCenter and Connect-It on a machine.
e You will be using a new empty AssetCenter database.

¢ You have a valid account for accessing the AssetCenter database.

Where to Find the Connect-It Scenario

The DDM Inventory to AssetCenter Connect-It scenario is supplied with Connect-It not DDM
Inventory. You can find the scenario files (. scn) in the following default location:

C:\Program Files\Hewlett-Packard\ConnectIt\scenario\ed\ed2ac44
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Prerequisites

We strongly recommend that you follow the procedures in this chapter using test data before

you actually use them on a production AssetCenter database containing live data. This will
ensure that:

*  You have good working knowledge and confidence in carrying out the processes
¢ You will not damage the data that it already in your AssetCenter database

*  You will be able to experiment with the scenario and the data associated with it.

Installation

The Asset Management application client (AssetCenter) must be installed on the same

computer as Connect-It. We also recommend that you do not install Connect-It on the same
machine as the DDM Inventory Server.

Compatibility

Refer to the Compatibility Matrix in the DDM Inventory GUI under Help > Compatibility Matrix
for the correct versions of Connect-It and Asset Center to be running with DDM Inventory
7.60.

For AssetCenter 4.x (where x is less than 4) some of the fields may not exist.

You will need to do the following:

1 Load the scenario and open the connectors.

Error messages will be displayed for any field that does not exist.

2 Unmap those fields.

Prepare AssetCenter

Once you are familiar with the processes, you can export the DDM Inventory data directly
into your normal AssetCenter database.

Refer to your AssetCenter documentation for instructions on how to do this.

Prepare Connect-It

There are three steps to setting up Connect-It for the scenario:
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Task 1:  Open the Scenario
Task 2:  Configure the Source Connector - DDM Inventory

Task 3:  Configure the Destination Connector - AssetCenter

Step 1: Open the Scenario
1 Select Open from the File menu and navigate to the DDM Inventory to Asset Management
out-of-the-box scenario edac.scn file.
By default this file is located in:
C:\Program Files\Hewlett-Packard\ConnectIt\scenario\ed\ed2ac44

A three box scenario diagram is now displayed showing the mapping between DDM
Inventory and Asset Management.

) You may have to use the Zoom bar gy——=—1in the top right of the Connect-It window

to position the boxes so they become visible.

2  Select the Save as option from the File menu and give the scenario another file name so
you will not be overwriting the original DDM Inventory-AssetCenter out-of-the-box
scenario.

Step 2: Configure the Source Connector - DDM Inventory

Click on the title bar of the DDM Inventory connector box to highlight it.

To configure the connector you can either:

¢ Right-click on the DDM Inventory connector title bar and select the Configure
Connector... option.

e Select the Configure option from the Tools menu.
e Press the F2 key on your keyboard.

A wizard for the configuration of the DDM Inventory connector is displayed.

Page 1: Name and describe the connector

The first page of the wizard enables you to name the DDM Inventory connector and provide a
description for it.

1 Name: By default, the value of this field is DDM Inventory.
2 Description: Enter text to describe the connector. This field is not mandatory.

3 Click the Next button to continue. The Select connection type page opens.

Page 2: Select a connection type

This page allows you to specify the connection protocol.

1 For the purpose of DDM Inventory, always select MySQL (native).
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2 Click Next to continue. The Configure the database server connection page opens.

Page 3: Define the database server connection

This page allows you to set up the connection to the DDM Inventory database.
1 Server
Enter the port used for the database server connection.

If the Connect-It installation is on a different computer from the DDM Inventory Server,
enter the DNS name or IP address of the DDM Inventory server before the colon. For
example:

myserver .mycompany .com: 8108
or
127.0.0.1:8108

2 Login

Enter the login required to interact with the Discovery database. In this case, enter
admin.

The profile of this login must allow you to execute the actions performed by your scenario
(reading data). You can enable this in the DDM Inventory Web UI (Click Administration >
MySQL accounts > Add an account).

3 Password

Enter the password associated with the user login.
4 Click the Test button to test the connection to the Discovery database.
5  Click Finish.

Step 3: Configure the Destination Connector - AssetCenter

Click on the title bar of the Asset Management connector to highlight it. To configure the
connector you can either:

¢ Right-click on the connector title bar and select the Configure Connector... option.
e Select the Configure option from the Tools menu.
e Press the F2 key on your keyboard.

A wizard for the configuration of the Asset Management connector is displayed.

Page 1: Name and describe the connector

The first page of the wizard enables you to name the Asset Management connector and
provide a description for it.

1 Name: By default, the value of this field is ‘Asset Management’.
2 Description: Enter text to describe the connector. This field is not mandatory.

3 Click the Next button. The Define the connection parameters page opens.
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Page 2: Define the connection parameters

This page allows you to set up the connection to your AssetCenter database.
1 Server

In the drop-down list, select the AssetCenter connection that you can access from your
computer.

2 Login
Enter the login required to interact with AssetCenter.

The profile of this login must allow you to execute the actions performed by your scenario
(reading and writing data).

3 Password
In this case (demo database) you do not need to enter a password.
4  Now test the connection to the database.

5 Click Finish to finalize the basic configuration of the connector.

Check Mappings

It is advised that you always check your field mappings before publishing the data to the
AssetCenter database.

1 In the scenario diagram, double click on the Mapping box title bar. You will see a Select a
mapping dialog box.

2 Double click on the DevicesSrc-amComputerDst entry. After a short time an Edit mapping
window is displayed. This is where you can view and check your mappings.

) You may be asked whether you want to save the scenario. Click Yes to save.

3 Maximize this window to make it easier to see what is happening. There are three main
panes in this window.

e Source - DDM Inventory - shows the Inventory document that is produced by
Connect-It which contains the DDM Inventory structures, collections and fields as
represented by Connect-It

e Mapping - shows the actual mappings between DDM Inventory and AssetCenter fields

e Destination - Asset Management - shows the AssetCenter documents, tables,
structures, collections and fields that can be updated by the scenario.

4 In the Source pane expand the tree so that you can see the branches of the tree. You will
notice that some of the entries are blue. This indicates that the field has been mapped to a
field in the AssetCenter database.

Black entries have no mapping for them. However, you can choose to include a black field
(i.e. one that doesn’t have a mapping already) by manually creating the mapping yourself.
This is covered in detail in the Connect-It Users Guide.

5 You can check what the mapping for a blue DDM Inventory field is by double clicking on
it.

Now in the central Mapping pane an entry would have turned to green. Initially this may
not be obvious, but scroll down the Mapping pane list to find it.
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6 Double click on this mapping entry and the appropriate mapped AssetCenter field in the
Destination - Asset Management pane will be automatically highlighted.

7 Do not close the mapping window yet.

Check Reconciliation Keys

Reconciliation is the integration of input data coming from DDM Inventory that is considered
more up-to-date than the already existing data in AssetCenter.

This mechanism is based on the following question:
‘Does the information that I would like to reconcile already exist in AssetCenter?

e Ifthe answer is ‘no’, the input data is inserted. A new record is created because the field
that was the reconciliation key was not found in AssetCenter.

e Ifthe answer is “yes”, the existing data is updated with the information contained in the
scan. The record is updated because Connect-It finds a match based on the fields that
were used as the reconciliation keys.

Generally, reconciliation keys should be placed on unique fields in AssetCenter.
To view the fields that have reconciliation keys attached to them:

1 Look down the list of entries in the Mappings pane

2 Any entries that have a key icon next to them have reconciliation keys attached to them.

Mandatory Fields in an Asset Management Database

In an Asset Management application, a given field or link may be mandatory by default or
have been customized this way by the administrator of the Asset Management application.

In the case of reconciliation, each structure published by the Asset Management application
corresponds to a record. If an element in this structure is a mandatory field and is not
populated, the structure is rejected.

Test DDM Inventory-AssetCenter Scenario

Before you actually produce documents and publish the data into the AssetCenter database
you will want to test the scenario. By testing a scenario first you can ascertain that both the
reading and mapping components are configured properly, before attempting to write to
AssetCenter.

To enable this mode, select the Scenario/Test mode menu. You can choose between enabled
(checked) and disabled (unchecked) values.
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Starting the Scenario Test
To start the scenario test, do one of the following:

e Click the [P icon
e Select the Produce Now option from the Tools menu
e Press F5 on your keyboard

You may be asked if you want to save the changes you have made. Click Yes to save the
changes.

Consult the Document log to see if any problems were encountered while processing the
documents produced by the DDM Inventory connector. Refer to the Connect-It Users Guide for
more information about logs.

Getting Data into AssetCenter

Once you have made the initial check of the reading and mapping components, you can start
checking the writing components. To do this, reset your selection in the Scenario/Test mode
menu.

This step is where you actually populate your AssetCenter database with the data from DDM
Inventory.

You can run the scenario in two ways: manually, or through the scheduler. For testing
purposes, it is best to run it manually. To run it manually, press F5 or select Produce Now from
the Tools menu.

Starting the Scheduler

Creating a schedule determines when your scenario's source connectors will process data.

The DDM Inventory connector produces Machine document-types every day from 9 A.M. to 10
P.M. at intervals of five minutes (this is the default schedule). Outside of this period, the DDM
Inventory connector produces documents every hour.

You can add a rule to change these parameters for the days of your choice by using the
Connect-It scheduler which is covered in the Connect-It User’s Guide.

To start the scenario, do one of the following:

e Select Start all Schedulers from the Scenario menu.

e (Click the ki} button

Stopping the Scenario

To stop the scenario, do one of the following:

e Select Stop from the Scenario menu.

e (Click the ™ button.

Getting Data info AssefCenfer 195



Analyze What Happened During the Process

You can see the processes that Connect-It goes through by clicking on the Connect-It log tab in
the Scenario builder.

In the log, each action is represented by an icon. An action's message can be composed of
several sub-messages that detail the action. These sub-messages can, themselves, be
composed of other sub-messages. Each message is dated according to when the action was
launched.

You can unfold or collapse messages by right-clicking and then selecting the appropriate
command from the shortcut menu.

Right click anywhere in this log pane and select Collapse all levels. Now you are left with the
basic actions that were carried out. Expand an action to see what happened in further detail.

See Results in AssetCenter

1 Start AssetCenter
2 Log into the database

3 Click on the Computers toolbar button @

You will see that your data from the DDM Inventory scans has been populated into fields in
the Computers tab in the AssetCenter database.

| £ Mame | + DomaindGroup | + Model [Portfolio item) | &
CH crunooooi EVO D500 UP -
E]_;] CPUOO0O02 Ev0 D500 UP

Iil CPLIO00003 Ev0 D500 UP
E]_;] CPUOO0OO4 Ev0 D500 UP
E]_;] CPUOO000S Ev0 D500 UP

lil CPLIO00006 Ev0 D500 UP
E]_;] CPUOO0OO7 Ev0 D500 UP

=Ll CPLIO0000S Ev0 D500 UP

Fu | E0 D500 LIP
[ CRUD0OOT0 Ev0 D500 UP -
ﬁli] CPUOO0O11 Deskpro EN - DT - PIIl 933 =
LG 28/28
GO Mame|CPUDDOODS Giroup:| a[=[-
Azzet tag:| DETOO01051 Computer type:| j
General l Integration l Hardware l Scanner l Extenzions l Dirives l Metwark l as l Applications | Tracking l Hiztory l F j}_
Model:|EVD D500 UP AE|~
Assignment:|ln use j Supervisor:| =]
User:|Tossi, Michaela AE|~
In-service date:| 3/8/2005 -
Inventary date:| j

Location:| fiane Building/31 ¢t Floor/030 - Offices 4G | 3|

Evs

Comment:

-]

For further information on what you can do with this data, refer to the AssetCenter
documentation.
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Customize Your Scenario

You can configure a connector of your own or you can modify the existing scenarios to better
match your data needs.

Refer to the Connect-It documentation for information about these customization options and
tasks.

Importing and Processing DDM Inventory Utilization Data in
AssetCenter

) This section only applies if you have purchased the DDM Inventory Software Utilization
license.

In Enterprise Discovery 2.1 and later, Utilization data has been expanded to specify “per
computer” data and “per user” data. This means that the data is broken down based on each
user on each device, so you can see who uses specific applications.

Besides regular users, you can also see “All Users” and “System” user data, that collect total
utilization for the device, and also utilization for all system process that can not be associated
with a specific user.
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customizing the Network Map, 64
description, 17

Administration

account contact information, 22
account password, modifying, 22
adding an account, 18
customizing a user profile, 19
deleting an account, 23
deleting connections, 61
device deactivation intervals, 43
event filters, 31

delete, 38

list, 38

modify, 37
listing user accounts, 18
test e-mail address, 25
test pager address, 25

Agent
deployment, 76
automatic, 78
custom, 77
manual, 79
via login scripts, 79
via Win32 RPC, 76
directories, 75
media files, 74
security, 74
uninstalling
agent, 84
upgrade
unix agent, 83
win 32 agent, 83

agentca.pem, 74

AIX Scanner
setting up
file name and output directory, 165

Allow command line override option, 108

Apache
setup for saving to, 152

application library, 184

Asset fields
configuring in SG, 130

Asset number
choosing a source for, 147

Asset tag field, 131
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ATAPI
disabling hardware detection routine, 102

automatically defer all new scans, 179

BIOS
disabling hardware detection routine, 102

Bus Detection
disabling hardware detection routine, 102

C

Calculated fields
in SG, 134

Cascade Database
Using With Microsoft Access, 52

CD-ROM drives
creating a customized drive selection, 109

Changing
directories scanned to locate files, 127

Classic local drive scan, 106

Combination fields
setting up in SG, 141

Combined scan, 106

Command line
offsite scan file name, 147
offsite scan file save location, 149
override option in scanner generator, 108

Compaq Asset Tag
disabling hardware detection routine, 102

Compressed Drives
creating a customized drive selection, 110

Configuring
agent communication, 87

connections
deleting, 61

copying map configurations, 15

CPU identification
disabling hardware detection routine, 102

Creating An Access query, 54, 56

D

data access applications
ODBC, 49

date format, change, 19

DCC data
disabling hardware detection routine, 102

-d command line switch, 174
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deactivate, 43

deactivate device, 46
deactivation intervals, 43
default map configuration, 14

deferred directory
firstscan, 179

deleting connections, 61
deleting data, 59
Delta calculation utility, 174

Delta scanning
command line utility, 174
delta scan files, 174
enabling delta scanning, 149

setting up the scanners to handle them, 174

demo account, description, 16

Derived fields
in SG, 135

Description field, 131

device
activating, 48
adding, 40
changing IP address, 41
changing ports, 42
deactivate, 46
deactivating, 45
hide, 45
purge, 46
purging, 45
remove automatically, 43
removing, 45
replacing, 41

device, disconnecting, 14

Device driven drives
creating a customized drive selection, 110

Device Manager
changing default panel, 19, 20

device priority
changing, 64

device tag
changing, 64

device title
changing, 64

disconnecting
map session, 14

discusg.cxu, 85

Disk space
xml enricher, 171



Drives
creating a customized drives selection, 109
disabling hardware detection routine, 102

DSF file
definition, 92

E

EISA

disabling hardware detection routine, 102
e-mail

change account e-mail address, 22

test your e-mail address, 25

Enhanced CPU ID
disabling hardware detection routine, 102

Enterprise mode, 96
Environment fields

setting up in SG, 137
event filters, 31

definition, 33

delete, 38

examples, 35

list, 38

modify, 37

preparation, 33
Exiting

scanner generator, 94
expiry, 43

Extract field options
setting in SG, 144

F
FAT

creating a customized drive, 109

Field data type
selecting, 134
Field parameters
setting in SG, 135
File associations
including in targeted scan, 112
firstscan directory, 179
Floppy drives
creating a customized drive selection, 109
Forensic scan
selecting as preset scanner configuration, 97

FTP URL
for offsite save path, 151

G

Generating scanners, 164

H

Hardware data
disabling hardware detection routine, 100
selecting as data to be collected by scanner, 99
structure in an xsf file, 185

Hardware detection
disabling, 101

help format
change, 19
hiding devices, 45
HPFS
creating a customized drive selection, 109

HP-UX Scanner
setting up file name and output directory, 165

HTTP URL
for offsite save path, 152
saving on Apache and IIS Web Servers, 152

1/0 ports
disabling hardware detection routine, 102

Icons
files to scan list box in scanner generator, 114

icons
changing, 64
IDE

disabling hardware detection routine, 102

IIS
setup for saving to, 152

Inventory scan
selecting as preset scanner configuration, 97

IP address
append to device labels, 19
changing in a device, 41

IPX/SPX
disabling hardware detection routine, 102

ISA PnP cards
disabling hardware detection routine, 102

IT employee account, description, 16

IT manager account, description, 16

J

Java class files
enabling in SG, 97, 98
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Java Home directory
including in targeted scan, 112

K
Keyboard
disabling hardware detection routine, 102

keyboard shortcuts
scanner generator user entry form, 129

L

License
default directory used in xml enricher, 171
using targeted directory scan for software
license accuracy, 107

Line Manager
default panel
changing, 19

Linking Cascade Tables, 52

Linux Scanner

setting up file name and output directory, 165

LiveAgent, 75
local$ file, 148

Local scan file
saving, 148

login
enabling, 19

Login scripts
agent deployment, 79

Logs
creating in scanner generator, 153
log window in scanner generator, 167
xml enricher, 176

long date format, 20

M

Manual deployment
agent, 79
Manual deployment mode, 96

map configuration
allowing others to copy, 19
copy permissions, 19

MCA
disabling hardware detection routine, 102

media files, 74

Memory
disabling hardware detection routine, 102

Mouse
disabling hardware detection routine, 102
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N
name of account, 19

NetBIOS/NETBEUI
disabling hardware detection routine, 102

Network
saving scan results to, 149

Network drives
creating a customized drive selection, 110

Network information
disabling hardware detection routine, 102

Network Map
change icon, 64

NMID, 78
No Ul Scanner

setting up file name and output directory, 165

NTFS
creating a customized drive selection, 109

(o)

Offsite scan file
saving, 148

OS/scan fields
setting up in SG, 140

Override option, 108

P

pager
change account information, 22

pager address
testing, 25

password
account, modifying, 22

Peripherals
disabling hardware detection routine, 102

Plug’'n’Play
disabling hardware detection routine, 102

Port Manager
changing default panel, 20
default panel
changing, 19

priority
device, 64

purge, 43

R

Rawmedia, 74



Registry extract fields Solaris Scanner
setting up in SG, 139 setting up file name and output directory, 165

removing a device Standard fields, 131
automatically, 43

Starting
manually, 45

scanner generator, 94
replacing a device, 41

status
receive reports by e-mail, 19
S Stored files
Saving setting up in SG, 125
scanner options to text file, 162 SUBSTed drives
scan results creating a customized drive selection, 110
locally, 148
to network, 149 T
Scanner .
components, 92 Targeted directory scan, 106
disabling hardware detection routines, 101 Text fields
enabling scanning of java class files, 98 in SG, 134
saving options to text files, 162 Text file
selecting directories to scan, 110 saving scanner options to, 162
selecting hardware data to collect, 99
selecting type of scanner to create, 97 Text file extract
selecting which to generate, 164 setting up field in SG, 137
setting naming conventions, 165 type of account
setting up descriptions, 162 setting, 19
software scanning modes, 106
time-out options, 155 U
Scanner account, description, 17 UNC path
Scanner generator for offsite save path, 150

enterprise mode, 96

Uninstalling
mam.lal deployment mode, 96 agent, 84
starting, 94 .

Upgrading

SCSI

. . . . unix agent, 83
disabling hardware detection routine, 102

win 32 agent, 83

Security URL
agent . make visible, 19
Certificates

agent, 74 user accounts, listing, 18

selection, 109

Sequence fields
setting up in SG, 135

Settings.txt, 162 vV

Shallow scan
selecting as preset scanner configuration, 97

short date format, 20

SMBIOS
disabling hardware detection routine, 102 w

User prompt
setting up in SG, 131

utilization plug-in, 85

VFAT
creating a customized drive selection, 110

Virtual machines, 156

Software scanning modes, 106 Welcome page, 96

Win 32 RPC
agent deployment, 76

Software utilization plug-in, 85
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Windows 16-bit Scanner
setting up
file name and output directory, 165
Windows 32-bit Scanner
setting up file name and output directory, 165

Windows services
including in targeted scan, 111

WMI extract fields
setting up in SG, 142

X

XML Enricher

application library, 184
XML enricher

directory structure used, 171

disk space requirement, 171

log files, 176

structure of the xml file, 185
XSF

contents of, 185

creating, 173

definition, 92

enriching with xml enricher, 169

XSFDelta.exe, 174
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